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Problem and Rational 
 

Optec Co., Ltd. has been developed the product by manually design swimming 
goggles on drawing papers and presented to the customer.  The current design method 
has a long product development period.  The major draw back of this method is the time 
for modification to satisfy the customer requirement.  Additionally, the product details 
drawing needs to be updated and used for manufacturing molds.  Consequently, 
manually design possibly leads to error and makes the product development cycle 
longer, as well as lower new products annually than competitors.  At the present, the 
company has the production rate at the average of 10 models per year. 

Moreover, the goggles need to pass the standard product quality and safety 
evaluation according to BS5883. The evalution can only be done at the United Kingdom 
with great expenses. Therefore, the need for a mordern engineering design tool, the 
Computer-Aided Technology, will support the design to meet the above requirements. 
The design pratice will assist Optc Co., Ltd to be more competitive in the international 
market. 



Objectives 
 
1. To develop the surface swimming goggle design procedure by using Computer-

Aided Design (CAD).   The objective was to collect the features of the goggles as a 
library for quick, convenient, easy retrieval and modification.  The procedures 
resulted in less development time for over 30% from the present method. 

2. To use the Computer-Aided Engineering (CAE) simulate the goggle-testing standard 
according to the standard BS5883: 1996. 

3. To apply the Computer-Aided Engineering analysis stresses on the face and head 
for wearing comfort evaluation. 

 
Methodology 
1. Use the Computer-Aided Design technology to collect solid models of the goggle 

features.  The application software is Pro/ENGINEER. 
2. Transfer design process and methodology for creating goggle features. 
3. Use the Computer-Aided Engineering to analysis the mechanical product testing 

according to the standard BS5883: 1996, and perform the design testing from the 
existing products for at least two models. 

4. Use the Computer-Aided Design technology to create the human face and head 
model by using surface scanned technology. 

5. Use the Computer-Aided Engineering technology to evaluate goggle wearing 
comfort on face and head by using at least two existing products for test 
comparison. 

 
Expected Outputs 
 
1. Application of CAD in goggle design for ease of use, convenience and quick 

design.  This will lead the goggle design and development done in minimal time and 
capable of having more design.  Additionally, it assists the company to be the leader 
in goggle manufactures in the free trade market. 



2. The availability of the product database in electronic CAD data.  The databases 
provide the ease in searching and taken for the new design and development. 

3. Capable of simulating the international product quality test of the goggles before 
actually built.  The simulation will reduce time and raw materials from any 
modification in order to pass the test, and less expense in testing at the UK. 

4. Gain engineering knowledge in analyzing goggle-wearing comfort at the face and 
the head.  The analysis will provide the company sale marketing that will help the 
company to have its own trade brand for competitive international market. 

5. Provide the technology transfer, which will assist the company to be self-dependent. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



บทคัดยอ 
 

การวายน้าํเปนกีฬา และกิจกรรมยามวางอยางหนึ่งที่ไดรับความนยิมทั่วโลก    อุปกรณที่
จําเปนสาํหรับกิจกรรมเหลานี้คือ แวนตาวายน้าํ    จุดประสงคหลกัของการสวมแวนตาวายน้าํคือ 
ความปลอดภยัและการมองเห็นอยางชัดเจน    มาตรฐานทดสอบคุณภาพของแวนตาวายน้าํที่
สําคัญ คือ BS5883 แวนตาที่ผานการทดสอบนี้ นอกจากจะสามารถขายในทวีปยุโรปแลว ยงั
สามารถขายไดทั่วโลก    นอกจากนี้แวนตาสมัยใหมเปนสิ่งที่เปนแฟชัน่อยางหนึง่ จงึมีรูปทรงที่
สวยงามและซบัซอน    ดังนัน้การออกแบบแวนตาที่เหมาะสมจงึ เปนสิ่งจาํเปน เพือ่ใหเวลาในการ
นําสนิคาออกจําหนายสั้นลง    วัตถุประสงคแรกของงานวิจยันี้คือ การพัฒนากระบวนการ
ออกแบบโดยใชคอมพิวเตอรชวยการออกแบบ (Computer - Aided Design, CAD)  การจัดกลุม
ฟเจอรของแวนตาวายน้ําเปนโซลิตโมเดลไดพิสูจนวา เปนวิธทีี่สะดวกและรวดเร็วในการออกแบบ    
การใช CAD จึงชวยลดชวงเวลาของการออกแบบถึงการนําจาํหนายไดอยางมาก    วตัถุประสงคที่
สอง เปนการใชคอมพิวเตอรชวยงานวิศวกรรม (Computer - Aided Engineering, CAE) จําลอง
การทดสอบคณุภาพ  ชิ้นสวนตัวอยางของแวนตาไดทดสอบภายในประเทศตามมาตรฐานของ 
BS5883 เพื่อใชเปรียบเทยีบกับผลการจาํลองการทดสอบโดยใช Finite Element Analysis (FEA)   
การจําลองระยะยืดของการทดสอบการดงึของชิน้จมูก มีคาเฉลี่ยความคลาดเคลื่อน 11%    ระยะ
ยุบตัวภายใตการทดสอบการอัดของถวยตามีคาเฉลี่ยความคลาดเคลื่อนในชวง –4.21% ถึง 
0.29%    ผล FEA ของการทดสอบการกระแทก แสดงความเคนต่ํากวาคาความเคน Ultimate   ซึ่ง
สอดคลองกับผลทดสอบทางกลที่ไมพบการแตกราวหรอืการบุบยุบถาวรบนผวิเลนส    วธิี FEA ที่
พัฒนาใชสําหรับจําลองการสวมใส ในงานวิจยันี้สามารถระบุตําแหนงที่ทาํใหเกิดความไมสบายใน
การสวมใสได 
 
 
 
 
 
 
 
 



Abstract 
 

Swimming is one of the most popular sport and pastime activities worldwide.  
The most essential device for the actives is a surface swimming goggle.  The main 
purposes for wearing the goggles are safety and vision.  The standard quality testing - 
BS5883, is an essential evaluation for safe goggles.  The verification permits the sale not 
only in Europe but worldwide.  Additionally, the modern swimming goggles become 
fashion items and have complex shapes.  Therefore, the proper goggle design is the 
must for shortening the time to market.  The first aim of this research is to develop the 
goggle design procedure by using Computer-Aided Design (CAD).   Grouped goggle 
features into solid models, has been found convenient and accelerated the design.  The 
use of CAD greatly reduces the design to market period.  The second aim is to use 
Computer-Aided Engineering (CAE) simulate the quality test.  Samples of goggle were 
locally tested, according to the BS Standard, for supporting the simulation of Finite 
Element Analysis (FEA).  The elongation under tensile simulation of nosepieces has an 
average error of 11 %.  The deformation under compressive test of eye cups has the 
average error from –4.21 % to 0.29%.  The impact results by FEA indicated stresses less 
than the ultimate stress, satisfied the test result with no fracture or permanent 
deformation on lens.  Our FEA method of conducting the wearing simulation can 
indicate the discomfort location.    
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ความสาํคัญ/ความเปนมา 

            อุตสาหกรรมการผลิตแวนตาวายน้ําในตลาดการคาโลก มีแหงผลิตที่สําคัญแหลงหนึง่ คือ
ประเทศไทย  โดยมีบริษัท Optech Co., Ltd. เปนบริษทัหนึง่ที่ไดดําเนนิธุรกิจการผลติแวนตาวายน้ํา
ใหแกผูจําหนายที่มีชื่อเสยีงภายใตเครื่องหมายการคาตาง ๆ  เชน  Speedo, TYR และ Arena เปนตน  
โดยบริษัท Optech Co., Ltd. เปนผูออกแบบแวนตาวายน้ํา แลวสัง่ผลิตแมพิมพจากภายนอกโรงงาน  
ภายในโรงงานทาํการผลิตชิ้นสวนแวนตาวายน้าํตาง ๆ  รวมถึงบรรจุภัณฑ และดาํเนนิการประกอบ
เปนผลิตภัณฑแวนตาวายน้ําและบรรจุหบีหอสงใหแกลูกคา 
 ผลิตภัณฑแวนตาวายน้ําไดมีการพฒันาอยางตอเนื่องและรวดเร็ว มีรูปทรงแปรเปลีย่นตามยุค
สมัย  นอกเหนือจากจุดประสงคเพื่อการมองเหน็อยางชัดเจนใตและเหนือผิวน้าํขณะวายน้าํและ
ปองกันนัยนตาจากสารเคมแีละสิ่งสกปรกในน้าํ   แวนตาวายน้าํยงัใชเสมือนเปนเครื่องประดับใบหนา
ของนักวายน้าํ  รูปทรงจึงเปนแฟชัน่ทีท่ันสมัยและมีการพัฒนาอยางตอเนื่องทั้งป  รูปแบบของแวนตา
วายน้ําสวนหนึ่งมาจากการนําเสนอจากผูผลิต แลวผูขายนําไปจัดจาํหนายทั่วโลกภายใตเครื่องหมาย
การคาของตน 
            ณ ปจจุบัน บริษทั Optech Co., Ltd.  ดําเนินการพัฒนาผลติภัณฑ โดยใชวิธกีารออกแบบ บน
แผนกระดาษขึ้นมากอน แลวจึงนําแบบที่ได เสนอตอลูกคา ซึ่งทาํใหเสยีเวลามาก และเกิดการสญูเสีย
เวลาอยางมากเมื่อตองดําเนินการแกไขแบบเพื่อการนําเสนอใหมใหไดตรงตามความพอใจของลกูคา 
นอกจากนี้แบบภาพวาดรายละเอียดเพื่อการผลิต จะตองสรางขึน้ใหมเพื่อเปนขอมลูในการผลิต
แมพิมพ  ทําใหเกิดความ คลาดเคลื่อน และเปนผลใหชวงระยะเวลา การพัฒนาผลติภัณฑ นานกวา
คูแขง และมีจาํนวนการนาํเสนอรูปทรงใหมๆ ตอปตํ่า โดยปจจุบัน บริษัท สามารถผลิตไดเฉลี่ย 10 
แบบตอป 



 
ความสาํคัญ/ความเปนมา (ตอ) 

ปญหาอืน่ๆ  ทีป่ระสบ คือ การพัฒนาแวนตาวายน้าํจากรูปทรงเดิมที่เปนรูปทรงมาตรฐาน ที่
ไมเปนรูปทรงตามแฟชัน่ ซึง่รูปแบบนี้เปนผลิตภัณฑมีตลาดรองรับอยางสม่าํเสมอทกุป  มีปญหาดาน
ขอมูลที่ใชเปนแบบกระดาษภาพวาด ทําใหตองเริ่มตนวาดแบบใหม  รวมถงึปญหาการสูญเสียเวลา
เนื่องจากการเปลี่ยนขนาด เชน จากแบบสาํหรับผูใหญ ใหเปนขนาดเลก็สําหรับเดก็  จนถงึปจจุบัน 
บริษัท Optech Co., Ltd.   มีจํานวนแวนตาวายน้าํที่ไดผลิตมาแลวรวมกันมากกวา 200 แบบ แบบ
เหลานี้ในอนาคตสามารถนาํมาพัฒนาเปนผลิตภัณฑรุนใหมได หรือใชอางองิเพื่อการผลิตทูลหรือ
แมพิมพเพื่อทดแทนของเกาที่เสื่อมอายุ   ปญหาเนื่องจากการออกแบบและการเก็บขอมูลของแบบที่ใช
วิธีการเดิมนี ้ยงัสงผลตอเนื่องตอกระบวนการผลิต คือ คุณภาพและการสูญเสียวัตถดิุบโดยเฉพาะ
ในชวงการทดสอบสายการผลิตและเกิดการสูญเสียพลงังานจากขอบกพรองดังกลาว 

 จากเหตุผลดังกลาว แนวทางการนําเทคโนโลยีคอมพิวเตอรชวย (Computer-Aided 
Technology) อันไดแก คอมพิวเตอรชวยการออกแบบ (Computer-Aided Design หรือ CAD) และ 
คอมพิวเตอรชวยงานวิศวกรรม (Computer-Aided Engineering หรือ CAE) จะสามารถชวยเสริมให
บริษัท Optech Co., Ltd. เพิ่มศักยภาพดานการออกแบบและพัฒนาผลิตภัณฑแวนตาวายน้ําให
สามารถแขงขนัในตลาดโลกได รวมถึงเปนทางนาํไปสูการมีเครื่องหมายการคาที่เปนของประเทศไทย
ได โดยคอมพวิเตอรชวยการออกแบบจะนาํมาประยุกตเพื่อการออกแบบแวนตาวายน้ําจากรูปทรง
เฉพาะแบบ (feature) ตางๆ ของแวนตาวายน้าํที่จะดําเนินการวิจยัโดยการรวบรวมเปน Library  
เพื่อใหการออกแบบสามารถดําเนนิการไดโดยงายดวยการแกไขขนาดตาง ๆ และอาจมีดัดแปลงบาง
เพียงเล็กนอย  สวนคอมพวิเตอรชวยงานวศิวกรรมจะนาํมาใชเพื่อการจําลองการทดสอบใหไดตรงตาม
มาตรฐานสากลของผลิตภัณฑแวนตาวายน้ํา (เชนBS5883:1996) รวมถึงการวิเคราะหเพื่อการ
ออกแบบใหสวมใสที่แนบสนิทกับใบหนาและใหความสบายตอใบหนาและศีรษะ 
 
วัตถุประสงคของโครงการ 
             1.   เพื่อพัฒนากรรมวิธีการออกแบบแวนตาวายน้ําโดยใช ซอฟตแวรคอมพิวเตอรชวยการ
ออกแบบ ในการพัฒนารูปทรงเฉพาะแบบ (Feature) ตางๆ ของแวนตาวายน้าํ ให สะดวก รวดเร็ว 
และงายตอการออกแบบ ทําใหสามารถลดเวลาการพัฒนาการออกแบบแวนตาวายน้ําไดเร็วมากกวา 
30% ของเวลาที่ใชโดยวิธกีารเดิม 
 



วัตถุประสงคของโครงการ 
               2.   เพื่อนาํคอมพวิเตอรชวยงานวิศวกรรม ใชจําลองการทดสอบทางกลตามมาตราฐาน
ผลิตภัณฑแวนตาวายน้ํา BS5883: 1996 
               3.   เพื่อนาํคอมพวิเตอรชวยงานวิศวกรรมวิเคราะหระดับความเคนกดที่ใบหนาและศีรษะ 
เเละประเมนิการสวมใสที่ใหความสบายตอใบหนาและศีรษะ 
 
 

ผลที่ไดรับ บรรลวุัตถุประสงคขอที ่ โดยทําให 
1.   สามารถออกแบบชิ้นสวน
แวนตาวายน้ําโดยใชโปรแกรม 
CAD ชวยการออกแบบ ทาํให
การพัฒนาสรางแบบรุนใหมๆ  
ไดรวดเร็วขึ้น 

1 - ลดเวลาการออกแบบ 
- การนําเสนอแบบตอลูกคาทํา
ไดงายและรวดเร็ว 
- ลดเวลาในการสรางและแกไข
แมพิมพ 
- ลดพลังงานในกระบวนการ
ออกแบบพัฒนาและการผลติ 

2.   สามารถกาํหนดความ
แมนยําในการใชโปรแกรม CAE 
ในการวิเคราะหตามมาตรฐาน
การทดสอบแวนตาวายน้าํ 

2 และ 3 - สามารถประมาณผลของการ
ทดสอบแวนตาวายน้าํที่ตองการ
ผลิตไดลวงหนา 
- ลดเวลาและการสูญเสีย
วัตถุดิบในการทดสอบจริง 
- ลดการแกไขแมพิมพ 

3.   สามารถวเิคราะหดูความ
เคนที่กดบนใบหนา จากแบบ
รูปทรงของแวนตาวายน้ําที่
ออกแบบได 

3 - ออกแบบรูปทรงของแวนตา
วายน้ําใหเหมาะสมกับใบหนาผู
สวมใส 
 

 
 
 



การนาํผลการวิจัยไปใชประโยชน 
          ลําดับและวิธีการในแตละขั้นตอนของการออกแบบแวนตาวายน้ําโดยกรรมวธิีทางวิศวกรรม  ได
สรุปเปนแนวทางดําเนนิการซึ่งสามารถนําไปประยุกตใชไดกับซอฟตแวร CAD และ CAE ทั่วไปได  
โดยคุณสมบัติของซอฟตแวร CAD และ CAE ที่ใช  ใชความสามารถขั้นต่ําทีม่ีในซอฟตแวร CAE ทั่วไป  
ผลการวิจยันี้สามารถนําไปประยุกตใชกับการวิเคราะหชิน้สวนอื่นๆ ของผลิตภัณฑทัว่ไปได ไมวาจะ
เปนผลิตภณัฑที่ข้ึนรูปดวยวิธีใดและวัสดุชนิดใดก็ตาม   รายละเอียดในงานวิจัยนี้บุคคลทั่วไปและนิสิต
นักศึกษาสามารถนาํไปใชประกอบเปนกรณีศึกษา และดําเนนิการในการพัฒนาและการทดสอบ
ผลิตภัณฑในภาคอุตสาหกรรมตางๆ ได 
 
การประชาสมัพันธ 
               1.  จัดบรรยายเรือ่งการใช  CAD/CAE ในการออกแบบและทดสอบผลิตภัณฑเพื่อใหได
มาตรฐานดานคุณภาพและความปลอดภัย 
               2.  การนาํ CAE มาชวยในการออกแบบแวนตาวายน้าํ  ในการทดสอบคณุภาพและประเมิน
ความสบายในการสวมใส 
 
 
 



(1) 

สารบัญ 
 

 หนา 
สารบัญ (1) 
สารบัญตาราง (5) 
สารบัญภาพ (6) 
คําอธิบายสัญลักษณและคํายอ (14) 
คํานํา 1 
การตรวจเอกสาร 3 
      1.   โครงสรางของแวนตาวายน้าํ  4 
      2.   กระบวนการผลิตแวนตาวายน้ํา 5 
                 2.1   การผลิตชิน้สวน 5 
                             2.1.1   สายการผลิตชิ้นสวนพลาสตกิ  5 
                             2.1.2   สายการผลิตชิ้นสวนยาง/ซิลิโคน 6 
                 2.2   การประกอบ (Assembly Line) 7 
                 2.3   การบรรจุหบีหอ (Packaging Line) 7 
      3.   กรรมวิธีการผลิตชิ้นสวนโดยการฉดีพลาสติก 9 
                 3.1   ประเภทของเครื่องฉีดพลาสติก 9 
                 3.2   สวนประกอบของเครื่องฉีดพลาสติกแนวนอน 10 
                 3.3   ชุดฉีด  (Injection Unit) 10 
                 3.4   ชุดเปด-ปดแมพิมพ (Clamping Unit) 11 
                 3.5   ข้ันตอนการทํางานของเครื่องฉีดพลาสติก 13 
      4.   วัสดุทีใ่ชในการผลิตแวนตาวายน้ํา 14 
                 4.1   โพลีคารบอเนต 14 
                 4.2   PVC (Polyvinyl Chloride) 15 
                 4.3   ABS (Acrylonitrile Butadiene Styrene) 15 
                 4.4   ซิลิโคน (Silicone) 15 
                 4.5   ยางธรรมชาติ 16 
      5.   การทดสอบคุณสมบัติทางกลของพลาสติก 16 
 
 



(2) 

 
สารบัญ (ตอ) 

 
      6.   มาตรฐานการทดสอบแวนตาวายน้ํา 19 
                 6.1   การทดสอบการดึง (Tensile Test)   19 
                 6.2   การทดสอบการอัด (Compressive Test)   19 
                 6.3   การทดสอบการกระแทก (Impact Test)  20 
      7.   คอมพิวเตอรชวยการออกแบบและคอมพิวเตอรชวยงานวิศวกรรม 20 
                 7.1   การวิเคราะหเพื่อชวยการออกแบบ  20 
                 7.2   การวิเคราะหเพื่อชวยกระบวนการผลติ   21 
อุปกรณ 22 
      1.   อุปกรณและชิ้นงานสําหรับพฒันากรรมวิธีการออกแบบแวนตาวายน้าํ 22 
      2.   ชิ้นงานสําหรับการทดสอบทางกลตามมาตรฐานการทดสอบแวนตาวายน้ํา 22 
      3.   ชิ้นงานสําหรับทดสอบคุณสมบัติของวัสดุ 22 
      4.   อุปกรณทดสอบตามมาตรฐานการทดสอบแวนตาวายน้าํ 23 
      5.   อุปกรณสําหรับการวิเคราะหโดยใช CAD/CAE 27 
วิธีการ 28 
      1.   วิธีการพัฒนากรรมวิธีการออกแบบ 28 
      2.   วิธีการทดสอบทางกลของแวนตาวายน้ํา 29 
                 2.1   วิธีการทดสอบการดึงของชิ้นจมูก 29 
                 2.2   วิธีการทดสอบการอัดของถวยตา 30 
                 2.3   วิธีการทดสอบการกระแทกของเลนสถวยตา 31 
      3.   วิธีการทดสอบคุณสมบัติของวัสดุ 32 
      4.   วิธีการวิเคราะหโดยใช CAE 33 
ผลการวิจยัและทดลอง 36 
      1.   ผลการพัฒนากรรมวิธีการออกแบบแวนตาวายน้ํา 36 
                 1.1   ผลการวิเคราะหสวนประกอบของถวยตาแวนตาวายน้ํา 36 
                 1.2   ผลการออกแบบฟเจอร 38 
 
 
 



(3) 

สารบัญ (ตอ) 
 

                1.3   ผลออกแบบถวยตาแวนตาวายน้ํา 50 
                             1.3.1   ผลการประกอบถวยตา 50 
                             1.3.2   ตัวอยางของการออกแบบถวยตารุนใหม 52 
      2.   ผลการทดสอบทางกลตามมาตรฐานการทดสอบแวนตาวายน้ํา 54 
                 2.1   ผลการทดสอบทางกลของการดึงชิ้นจมูก 54 
                 2.2   ผลการทดสอบทางกลของการอัดถวยตา 55 
                 2.3   ผลการทดสอบทางกลของการกระแทกเลนสถวยตา 57 
      3.   ผลการทดสอบคุณสมบัติของวัสดุ 57 
      4.   ผลการวิเคราะห FEA ของการทดสอบการดึงชิน้จมูก 59 
                 4.1   ผลการสรางแบบจําลอง FEM ของชิน้จมูก 59 
                 4.2   ผล FEA ของการยืดตัวของชิ้นจมูก 59 
                 4.3   ผล FEA ของความเคนของชิ้นจมูก 65 
      5.   ผลการวิเคราะหการทดสอบการอดัถวยตาโดยใช FEA 66 
                 5.1   ผลการสรางแบบจําลอง FEM ของถวยตา 66 

5.1.1 การกําหนดเงือ่นไขการจําลอง FEM สําหรับการทดสอบ 
                                         การอัดแบบ ก 

 
67 

5.1.2 การกําหนดเงือ่นไขการจําลอง FEM สําหรับการทดสอบ
การอัดแบบ ข 

 
70 

5.1.3 การกําหนดเงือ่นไขการจําลอง FEM สําหรับการทดสอบ
การอัดแบบ ค 

 
70 

                 5.2   ผลการวิเคราะหการยุบตัวของถวยตาโดยใช FEA 71 
                            5.2.1     ผล FEA ของการจําลองการทดสอบการอดัแบบ ก 71 
                            5.2.2     ผล FEA ของการจําลองการทดสอบการอดัแบบ ข 75 
                            5.2.3     ผล FEA ของการจําลองการทดสอบการอดัแบบ ค 76 

5.2.4 การเปรียบเทยีบผล FEA ของแบบจําลองการทดสอบ 
                                         การอัด 

 
77 

 
 
 



(4) 

สารบัญ (ตอ) 
 
                 5.3   ผลการวิเคราะหความเคนของถวยตาภายใตแรงอัดโดยใช FEA 83 
                            5.3.1     ความเคนจากผล FEA ของการทดสอบการอัดแบบ ก 83 
                            5.3.2     ความเคนจากผล FEA ของการทดสอบการอัดแบบ ข 85 
                            5.3.3     ความเคนจากผล FEA ของการทดสอบการอัดแบบ ค 87 
      6.   ผลการวิเคราะหการทดสอบการกระแทกเลนสถวยตาโดยใช FEA 89 
                 6.1   ผลการสรางแบบจําลอง FEM สําหรับวเิคราะหการกระแทก 89 
                 6.2   การวิเคราะหแรงกระแทก 90 
                 6.3   การวิเคราะหความเคนของการทดสอบการกระแทกโดยใช FEA 91 
                 6.4   การวิเคราะหความเครียดของการทดสอบการกระแทกโดยใช FEA 93 
      7.    ผลการทดสอบความสบายในการสวมใสโดยใช FEA 93 
                 7.1   ผลการสรางแบบจําลอง FEM 93 
                 7.2   ผลการวิเคราะหระยะยุบบนใบหนาโดยใช FEA 97 
                 7.3   ผลการวิเคราะหความเคนบนใบหนาโดยใช FEA 97 
สรุป 102 
เอกสารอางอิง 106 
ภาคผนวก 107 
      ภาคผนวก 1   คุณลักษณะเฉพาะของชุดทดสอบการดึงและการอดั  108 
      ภาคผนวก 2   การสรางโซลิตโมเดลของชิ้นสวนของแวนตาวายน้ํา 110 
      ภาคผนวก 3   ภาพวาดรายละเอียดของชิ้นสวนของแวนตาวายน้ํา 115 
      ภาคผนวก 4   ข้ันตอนการวิเคราะห CAE ของการดึงของชิ้นจมกู 121 
      ภาคผนวก 5   ข้ันตอนการวิเคราะห CAE ของการกดของเลนส  132 
      ภาคผนวก 6   ข้ันตอนการวิเคราะห CAE ของการกระแทกของเลนส  144 

 
 
 
 
 
 
 



(5) 

สารบัญตาราง 
 
ตารางที ่  หนา 

1 แสดงขนาดตาง ๆ ของชิน้ทดสอบ ตามมาตรฐาน ASTM D638 18 
2 แสดงสวนประกอบตางๆ ของถวยตาแวนตาวายน้าํของแตละรุน 37 
3 ผลการสรางและรวบรวมสวนประกอบของสวนฐาน 41 
4 ผลการสรางและรวบรวมสวนประกอบของกรอบลําตัว 43 
5 ผลการสรางและรวบรวมสวนประกอบของเลนส 45 
6 ผลการสรางและรวบรวมสวนประกอบของชิ้นห ู 46 
7 ผลการสรางและรวบรวมสวนประกอบของชิ้นจมูก 47 
8 ผลการสรางและรวบรวมสวนประกอบของตัวกึง่กลาง (Middle) 49 
9 ความสัมพันธของกรอบลําตวักับสวนประกอบอื่น 51 
10 ความสัมพันธของ σ - ε จากการทดสอบคุณสมบัติทางกลของ PVC 

และ PC 
 

59 
11 คาความคลาดเคลื่อนของผล FEA เทยีบกับผลทดสอบทางกลของ

การยืดตัวของชิ้นจมกู ในการทดสอบการดึง 
 

64 
12 แสดงคาความคลาดเคลื่อนของผล FEA เทยีบกับผลทดสอบทางกล     

ของระยะยุบตัว (∆) จากการทดสอบการอดัของถวยตา  รุน JR-1006 
 

80 
13 แสดงคาความคลาดเคลื่อนของผล FEA เทยีบกับผลทดสอบทางกล     

ของระยะยุบตัว (∆) จากการทดสอบการอดัของถวยตา  รุน 2006 
 

81 
14 แสดงคาความคลาดเคลื่อนของผล FEA เทยีบกับผลทดสอบทางกล     

ของระยะยุบตัว (∆) จากการทดสอบการอดัของถวยตา รุน 981 
 

82 
15 สรุปฟเจอรตางๆ ของถวยตาจํานวน 31 รุน 103 

 
 
 
 
 
 
 
 



(6) 

สารบัญภาพ 
 
ภาพที ่  หนา 

1 ชิ้นสวนของแวนตาวายน้ํา 4 
2 ข้ันตอนการทาํยางแผนเพื่อนําไปทาํสายยาง 6 
3 การขึ้นรูปสายยางดวยเครื่องกดอัดดวยความรอน 7 
4 แผนภูมิแสดงกระบวนการผลิตแวนตาวายน้ํา 8 
5 เครื่องฉีดพลาสติกแบบตางๆ 9 
6 สวนประกอบของเครื่องฉีดพลาสติกแนวนอน 10 
7 สวนประกอบของชุดฉีด 11 
8 เกลียวหนอนแบบธรรมดา (ก) และ แบบมีชวงไลอากาศ (ข) 11 
9 วิธีการทํางานของระบบ เปด-ปด แมพิมพแบบใชแรง 12 
10 การ เปด-ปด แมพิมพโดยใชระบบกลไกลอ็ค 13 
11 ข้ันตอนการทาํงานของเครื่องฉีดพลาสตกิ 14 
12 ภาพวาดชิ้นทดสอบแสดงขนาดตางๆ ของช้ินทดสอบแบบ 1, 2, 3 และ 5 17 
13 ภาพวาดชิ้นทดสอบแสดงขนาดตางๆ ของแบบที ่4 18 
14 เวอรเนียชนิดแสดงตัวเลข 22 
15 ชิ้นจมกูของแวนตาวายน้ํา รุน J-1 (ก) และ รุน J-10 (ข) 22 
16 ถวยตาของแวนตาวายน้ํา รุน JR-1006 (ก), 2006 (ข) และรุน 981 (ค) 23 
17 เครื่องทดสอบการดึงและการกด (Tensile and Compress Tester) 23 
18 อุปกรณสําหรบัจับยึด (Fixture) ชิ้นจมูก 24 
19 เครื่องชั่งน้าํหนัก และ เวอรเนียวัดขนาด 24 
20 แผนโลหะทดสอบการอัด 25 
21 ฐานรองถวยตา (Steel support) สําหรับทดสอบการอดัของถวยตา  

 รุน JR-1006 (ก) รุน 2006 (ข) และรุน 981 (ค) 
 

25 
22 ชุดทดสอบการกระแทก (ก)  และ ลูกบอลโลหะ (ข) 26 
23 (ก) รูปปนศีรษะจําลองสาํหรบัทดสอบการกระแทก  (ข) เบารองศีรษะจาํลอง 26 
24 เครื่อง Optical 3-D Scanner 27 
25 แผนภูมิแสดงขั้นตอนการพฒันากรรมวิธกีารออกแบบแวนตาวายน้ํา 28 

 
 



(7) 

สารบัญภาพ (ตอ) 
 

ภาพที ่  หนา 
26 ก) การติดตั้งอปุกรณเขากับอุปกรณจับยึด และ ข) การติดตั้งอุกรณ 

    จับยึดบนเครื่องทดสอบ 
 

30 
27 การติดตั้งถวยตาลงบนฐานรองถวยตา 30 
28 ชิ้นงานและอปุกรณ ในการทดสอบการกด 31 
29 การสวมแวนตาวายน้าํเขากบัศีรษะจําลองเพื่อทดสอบการกระแทก 31 
30 การวางเบารองศีรษะจําลองเขากับชุดทดสอบการกระแทก 32 
31 ข้ันตอนการปฏิบัติงานการวเิคราะหโดยใช CAE 34 
32 แผนผังขั้นตอนการใช  FEA  ในโปรแกรม  MSC/NASTRAN for Windows 35 
33 แสดงสวนประกอบตางๆ ของถวยตาแวนตาวายน้าํ 36 
34 การแบงแบบของรูปทรงของถวยตาไดเปนสามแบบ 38 
35 ลําดับการสรางโซลิตโมเดลของรูปทรงเฉพาะแบบของถวยตา 38 
36 แสดงการกําหนดขนาดตางๆ ของ Arc 39 
37 แสดงการสรางวงรีดวย Conic 39 
38 แสดงการสรางเสน Spline 40 
39 การสราง Surface ดวยการ Extrude (ภาพ ก)  และโดยการให Boundary 

(ภาพ ข) 
 

40 
40 การสราง Surface ดวยการ Trim (ภาพ ก)  และโดยการ Merge (ภาพ ข) 41 
41 ผลการใช ฟเจอร มาชวยในการออกแบบถวยตาวายน้าํรุน 982 50 
42 ผลการออกแบบถวยตารุนใหม รุน New Model 01 52 
43 ผลการออกแบบถวยตารุนใหม รุน New Model 02 53 
44 ผลการออกแบบถวยตารุนใหม รุน New Model 03 53 
45 ผลการออกแบบถวยตารุนใหม รุน New Model 04 53 
46 ระยะยืดจากการทดสอบทางกลของการดึงของชิ้นจมกูรุน J-1 54 
47 ระยะยืดจากการทดสอบทางกลของการดึงของชิ้นจมกูรุน J-10 55 
48 ระยะยุบตัวของถวยตารุน JR-1006 จากการทดสอบทางกลของการอัด 56 
49 ระยะยุบตัวของถวยตารุน 2006 จากการทดสอบทางกลของการอัด 56 
50 ระยะยุบตัวของถวยตารุน 981 จากการทดสอบทางกลของการอัด 57 

 



(8) 

สารบัญภาพ (ตอ) 
 
ภาพที ่  หนา 

51 ไดอะแกรมความสัมพันธ ระหวาง σ - ε ของ PVC 58 
52 ไดอะแกรมความสัมพันธ ระหวาง σ - ε ของ PC 58 
53 ชิ้นงานจริง (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของชิ้นจมูกรุน J-1 60 
54 ชิ้นงานจริง (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของชิ้นจมูกรุน J-10 60 
55 ลักษณะการแบงชิ้นประกอบของแบบจําลองชิ้นจมูก รุน J-1 และ รุน J-10 60 
56 การกําหนดเงือ่นไขขอบเขตและทิศทางแรงดึงของชิน้จมกูรุน J-1 61 
57 การกําหนดเงือ่นไขขอบเขตและทิศทางแรงดึงของชิน้จมกูรุน J-10 61 
58 ผล FEA ของการยืดตัวของชิ้นจมกู รุน J-1 ภายใตแรงดึง 10 N 62 
59 ผล FEA ของการยืดตัวของชิ้นจมกูรุน J-10 ภายใตแรงดึง 10 N 62 
60 กราฟเปรียบเทียบระยะยืด (Displacement) จากผล FEA กับผลการ

ทดสอบทางกล  ของชิน้จมกูรุน J-1 ภายใตแรงดึง 5 N ถึง 60 N 
 

63 
61 กราฟเปรียบเทียบระยะยืด (Displacement) จากผล FEA กับผลการ

ทดสอบทางกล  ของชิน้จมกูรุน J-10 ภายใตแรงดึง 5 N ถึง 60 N 
 

63 
62 ความเคนจากผล FEA ที่บริเวณตางๆ ภายใตแรงดึง 10 N ของชิ้นจมูกรุน  

J-1 
 

65 
63 ความเคนจากผล FEA ที่บริเวณตางๆ ภายใตแรงดึง 10 N ของชิ้นจมูกรุน  

J-10 
 

65 
64 กราฟของความเคนสูงสุดจากผล FEA ของการทดสอบการดึงของชิน้จมูก

ภายใตแรงดึง 5 N ถึง 60 N 
 

66 
65 ชิ้นงานจริง (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของเลนสรุน JR-1006 67 
66 ชิ้นงานจริง (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของเลนสรุน 2006 67 
67 ชิ้นงานจริง (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของเลนสรุน 981 67 
68 แบบจําลอง FEM ของถวยตารุน JR-1006, 2006 และ 981 68 
69 แบบจําลอง FEM แบบไมมีเลนสของถวยตารุน JR-1006, 2006 และ 981 68 
70 การกําหนดเงือ่นไขขอบเขตและทิศทางแรงอัดสําหรับการทดสอบการอดั

แบบ ก ของถวยตารุน JR-1006 
 

68 
 

 



(9) 

สารบัญภาพ (ตอ) 
 
ภาพที ่  หนา 

71 การกําหนดเงือ่นไขขอบเขตและทิศทางแรงอัดสําหรับการทดสอบการอดั
แบบ ก ของถวยตารุน 2006 

 
69 

72 การกําหนดเงือ่นไขขอบเขตและทิศทางแรงอัดสําหรับการทดสอบการอดั
แบบ ก ของถวยตารุน 981 

 
69 

73 เงื่อนไขขอบเขตและทิศทางแรงอัดสําหรับการทดสอบการอัดแบบ ข 70 
74 เงื่อนไขขอบเขตและทิศทางแรงอัดสําหรับการทดสอบการอัดแบบ ค 71 
75 ผล FEA แบบ ก ของระยะยบุตัวของถวยตารุน JR-1006 ที่แรงอัด 600 N 72 
76 ผล FEA แบบ ก ของระยะยบุตัวของถวยตารุน 2006 ทีแ่รงอัด 600 N 72 
77 ผล FEA แบบ ก ของระยะยบุตัวของถวยตารุน 981 ที่แรงอัด 600 N 73 
78 กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ

ทดสอบทางกล ของการทดสอบการอัดแบบ ก ในชวง 200 N ถึง 1000 N
ของถวยตารุน JR-1006 

 
 

73 
79 กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ

ทดสอบทางกล ของการทดสอบการอัดแบบ ก ในชวง 200 N ถึง 1000 N
ของถวยตารุน 2006 

 
 

74 
80 กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ

ทดสอบทางกล ของการทดสอบการอัดแบบ ก ในชวง 200 N ถึง 1000 N
ของถวยตารุน 981 

 
 

74 
81 ผล FEA แบบ ข ของระยะยบุตัวของถวยตารุน JR-1006 ที่แรงอัด 600 N 75 
82 ผล FEA แบบ ข ของระยะยบุตัวของถวยตารุน 2006 ทีแ่รงอัด 600 N 75 
83 ผล FEA แบบ ข ของระยะยบุตัวของถวยตารุน 981 ที่แรงอัด 600 N 76 
84 ผล FEA แบบ ค ของระยะยบุตัวของถวยตารุน JR-1006 ที่แรงอัด 600 N 76 
85 ผล FEA แบบ ค ของระยะยบุตัวของถวยตารุน 2006 ทีแ่รงอัด 600 N 77 
86 ผล FEA แบบ ค ของระยะยบุตัวของถวยตารุน 981 ที่แรงอัด 600 N 77 
87 กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ

ทดสอบทางกล ของการทดสอบการอัดในชวง 200 N ถงึ 1000 N ของถวย
ตารุน JR-1006 

 
 

78 
 



(10) 

สารบัญภาพ (ตอ) 
 

ภาพที ่  หนา 
88 กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ

ทดสอบทางกล ของการทดสอบการอัดในชวง 200 N ถงึ 1000 N ของถวย
ตารุน 2006 

 
 

79 
89 กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ

ทดสอบทางกล ของการทดสอบการอัดในชวง 200 N ถงึ 1000 N ของถวย
ตารุน 981 

 
 

79 
90 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ก ที่แรงอัด 600 N ของ

ถวยตารุน JR-1006  
 

83 
91 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ก ที่แรงอัด 600 N ของ

ถวยตารุน 2006  
 

83 
92 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ก ที่แรงอัด 600 N ของ

ถวยตารุน 981  
 

84 
93 กราฟของความเคนสูงสุดจากผล FEA ของการทดสอบการอัดแบบ ก ในชวง 

200 N ถึง 1000 N ของถวยตาทั้ง 3 รุน 
 

84 
94 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ข ที่แรงอัด 600 N ของ

ถวยตารุน JR-1006 
 

85 
95 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ข ที่แรงอัด 600 N ของ

ถวยตารุน 2006 
 

85 
96 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ข ที่แรงอัด 600 N ของ

ถวยตารุน 981 
 

86 
97 กราฟของความเคนสูงสุดจากผล FEA ของการทดสอบการอัดแบบ ข ในชวง 

200 N ถึง 1000 N ของถวยตาทั้ง 3 รุน 
 

86 
98 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ค ที่แรงอัด 600 N ของ

ถวยตารุน JR-1006 
 

87 
99 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ค ที่แรงอัด 600 N ของ

ถวยตารุน 2006 
 

87 
 
 



(11) 

สารบัญภาพ (ตอ) 
 
ภาพที ่  หนา 

100 ความเคนจากผล FEA ของการทดสอบการอัดแบบ ค ที่แรงอัด 600 N ของ
ถวยตารุน 981 

 
88 

101 กราฟของความเคนสูงสุดจากผล FEA ของการทดสอบการอัดแบบ ค ในชวง 
200 N ถึง 1000 N ของถวยตาทั้ง 3 รุน 

 
88 

102 การกําหนดเงือ่นไขขอบเขต ทิศทางและตําแหนงของแรงกระแทกของเลนส
ถวยตารุน JR-1006 (ก) 2006 (ข) และ 981 (ค) 

 
89 

103 กราฟของอมิพัลส ที่เกิดจากลูกบอลโลหะตกกระแทกผิวหนาเลนสถวยตา 
จากที่สูง 1.3 เมตร 

 
90 

104 ความเคนจากผล FEA ของการกระแทกบนเลนสถวยตารุน JR-1006  
(ความสูง 1.3 เมตร) 

 
91 

105 ความเคนจากผล FEA ของการกระแทกบนเลนสถวยตารุน 2006  
(ความสูง 1.3 เมตร) 

 
92 

106 ความเคนจากผล FEA ของการกระแทกบนเลนสถวยตารุน 981  
(ความสูง 1.3 เมตร) 

 
92 

107 กราฟของความเคนสูงสุดจากผล FEA ของการกระแทกในชวงความสงู  
0.7 ม. ถึง 1.6 ม. ของเลนสถวยตา รุน JR-1006, 2006 และ 981 

 
93 

108 ความเครียดจากผล FEA ของการกระแทกบนเลนสถวยตารุน JR-1006 
(ความสูง 1.3 เมตร) 

 
94 

109 ความเครียดจากผล FEA ของการกระแทกบนเลนสถวยตารุน 2006 
(ความสูง 1.3 เมตร) 

 
94 

110 ความเครียดจากผล FEA ของการกระแทกบนเลนสถวยตารุน 981 
(ความสูง 1.3 เมตร) 

 
95 

111 กราฟของความเครียดสูงสุดจากผล FEA ของการกระแทกในชวงความสูง  
0.7 ม. ถึง 1.6 ม. ของเลนสถวยตา รุน JR-1006, 2006 และ 981 

 
95 

112 แบบจําลอง CAD และ FEM ของใบหนา 96 
113 การกําหนดเงือ่นไขขอบเขตและทิศทางของแรงสําหรับวิเคราะหความสบาย

ในการสวมใส 
 

97 
 



(12) 

สารบัญภาพ (ตอ) 
 
ภาพที ่  หนา 

114 ผล FEA ของระยะที่ผิวหนงับนใบหนายุบเมื่อมีแรงเทากบั 5 N ของถวยตา
รุน 2006 

 
98 

115 ผล FEA ของระยะที่ผิวหนงับนใบหนายุบเมื่อมีแรงเทากบั 5 N ของถวยตา
รุน 1006 

 
98 

116 กราฟของระยะยุบ 4 บริเวณบนผิวหนงัจากผล FEA ของแรงในชวง 3 N ถึง 
9 N ของการสวมใสถวยตารุน 2006 

 
99 

117 กราฟของระยะยุบ 4 บริเวณบนผิวหนงัจากผล FEA ของแรงในชวง 3 N ถึง 
9 N ของการสวมใสถวยตารุน 1006 

 
99 

118 ความเคนบนใบหนาจากผล FEA ที่แรงเทากับ 5 N ของถวยตารุน 2006 100 
119 ความเคนบนใบหนาจากผล FEA ที่แรงเทากับ 5 N ของถวยตารุน 1006 100 
120 กราฟของความเคน 4 บริเวณบนใบหนาจากผล FEA ของแรงในชวง 3 N ถึง 

9 N ของการสวมใสถวยตารุน 2006 
 

101 
121 กราฟของความเคน 4 บริเวณบนใบหนาจากผล FEA ของแรงในชวง 3 N ถึง 

9 N ของการสวมใสถวยตารุน 1006 
 

101 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



(13) 

สารบัญภาพผนวก 
 
ภาพผนวกที ่  หนา 

1 คุณลักษณะของชุดทดสอบการดึงและการอัด 109 
2 ภาพวาดรายละเอียดของขนาดของชิ้นจมกูรุน J-1 116 
3 ภาพวาดรายละเอียดของขนาดของชิ้นจมกูรุน J-10 117 
4 ภาพวาดรายละเอียดของขนาดของถวยตารุน JR-1006 118 
5 ภาพวาดรายละเอียดของขนาดของถวยตารุน 2006 119 
6 ภาพวาดรายละเอียดของขนาดของถวยตารุน 981 120 

 



(14) 

คําอธบิายสัญลักษณและคํายอ 
 
 ABS  = Acrylonitrile Butadiene Styrene  
 ASTM  = American Standard  
 BSI  = British Standard Institute 
 CAD  = Computer-Aided Design 
 CAM  = Computer-Aided Manufacturing 
 CAE  = Computer-Aided Engineering   
 e  = Error 
 eAVG  = Average Error 
 eP  = Percent Error 
 |e|AVG  = Average of Absolute Error 
 E  = Young’s Modulus, Modulus of Elasticity 
 F  = Force หรือ Load 
 FEA  = Finite Element Analysis 
 FEM  = Finite Element Model 
 h  = Drop height 
 ISO  =  International Standards Organization 
 mm  = Millimeter 
 N  = Newton 
 PC  = Polycabonate 
 PVC  = Polyvinyl chloride 
 ∆  = Displacement หรือ Deflection 
 σ  = Stress 
 ε  = Strain 
 ∆EXP  = Displacement from Experiment 
 ∆FEA  = Displacement from Finite Element Analysis 
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คํานาํ 
 
 อุตสาหกรรมการผลิตแวนตาวายน้ําในตลาดการคาโลก มีแหงผลิตที่สําคัญแหลงหนึง่ คือ
ประเทศไทย  โดยมีบริษัท Optech Co., Ltd. เปนบริษัทหนึง่ที่ไดดําเนนิธุรกิจการผลิตแวนตาวาย
น้ําใหแกผูจําหนายที่มีชื่อเสียงภายใตเครื่องหมายการคาตาง ๆ  เชน  Speedo, TYR และ Arena 
เปนตน  โดยบริษัท Optech Co., Ltd. เปนผูออกแบบแวนตาวายน้ํา แลวสัง่ผลิตแมพิมพจาก
ภายนอกโรงงาน  ภายในโรงงานทําการผลิตชิ้นสวนแวนตาวายน้ําตาง ๆ  รวมถึงบรรจุภัณฑ และ
ดําเนนิการประกอบเปนผลติภัณฑแวนตาวายน้าํและบรรจุหีบหอสงใหแกลูกคา 
 ผลิตภัณฑแวนตาวายน้ําไดมีการพฒันาอยางตอเนื่องและรวดเร็ว มีรูปทรงแปรเปลี่ยน
ตามยุคสมัย  นอกเหนือจากจุดประสงคเพื่อการมองเห็นอยางชัดเจนใตและเหนือผิวน้าํขณะวาย
น้ําและปองกนันยันตาจากสารเคมีและสิ่งสกปรกในน้าํ   แวนตาวายน้าํยงัใชเสมือนเปน
เครื่องประดับใบหนาของนกัวายน้าํ  รูปทรงจงึเปนแฟชั่นทีท่ันสมยัและมีการพฒันาอยางตอเนือ่ง
ทั้งป  รูปแบบของแวนตาวายน้าํสวนหนึง่มาจากการนําเสนอจากผูผลิต แลวผูขายนาํไปจัด
จําหนายทัว่โลกภายใตเครื่องหมายการคาของตน 

ณ ปจจุบัน บริษัท Optech Co., Ltd.  ดําเนนิการพัฒนาผลิตภัณฑ โดยใชวธิีการ
ออกแบบ บนแผนกระดาษขึ้นมากอน แลวจึงนําแบบที่ได เสนอตอลูกคา ซึ่งทาํใหเสียเวลามาก 
และเกิดการสญูเสียเวลาอยางมากเมื่อตองดําเนินการแกไขแบบเพื่อการนําเสนอใหมใหไดตรงตาม
ความพอใจของลูกคา นอกจากนี้แบบภาพวาดรายละเอียดเพื่อการผลิต จะตองสรางขึ้นใหมเพือ่
เปนขอมูลในการผลิตแมพิมพ  ทําใหเกิดความ คลาดเคลื่อน และเปนผลใหชวงระยะเวลา การ
พัฒนาผลิตภัณฑ นานกวาคูแขง และมีจํานวนการนําเสนอรูปทรงใหมๆ ตอปตํ่า โดยปจจบัุน 
บริษัท สามารถผลิตไดเฉลี่ย 10 แบบตอป 

ปญหาอืน่ๆ  ที่ประสบ คือ การพัฒนาแวนตาวายน้ําจากรูปทรงเดิมทีเ่ปนรูปทรงมาตรฐาน 
ที่ไมเปนรูปทรงตามแฟชั่น ซึง่รูปแบบนี้เปนผลิตภัณฑมีตลาดรองรับอยางสม่าํเสมอทกุป  มีปญหา
ดานขอมูลที่ใชเปนแบบกระดาษภาพวาด ทาํใหตองเริ่มตนวาดแบบใหม  รวมถงึปญหาการ
สูญเสียเวลาเนื่องจากการเปลี่ยนขนาด เชน จากแบบสําหรับผูใหญ ใหเปนขนาดเล็กสําหรับเด็ก  
จนถงึปจจุบัน บริษทั Optech Co., Ltd. มีจํานวนแวนตาวายน้ําที่ไดผลิตมาแลวรวมกันมากกวา 
200 แบบ แบบเหลานี้ในอนาคตสามารถนํามาพัฒนาเปนผลิตภัณฑรุนใหมได หรือใชอางองิเพื่อ
การผลิตทูลหรือแมพิมพเพือ่ทดแทนของเกาทีเ่สื่อมอาย ุ   ปญหาเนื่องจากการออกแบบและการ
เก็บขอมูลของแบบที่ใชวิธกีารเดิมนี้ ยงัสงผลตอเนื่องตอกระบวนการผลิต คือ คุณภาพและการ
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สูญเสียวัตถุดิบโดยเฉพาะในชวงการทดสอบสายการผลิตและเกิดการสูญเสียพลังงานจาก
ขอบกพรองดังกลาว 
 จากเหตุผลดังกลาว แนวทางการนําเทคโนโลยีคอมพิวเตอรชวย (Computer-Aided 
Technology) อันไดแก คอมพิวเตอรชวยการออกแบบ (Computer-Aided Design หรือ CAD) 
และ คอมพวิเตอรชวยงานวศิวกรรม (Computer-Aided Engineering หรือ CAE) จะสามารถชวย
เสริมใหบริษัท Optech Co., Ltd.  เพิ่มศักยภาพดานการออกแบบและพัฒนาผลิตภัณฑแวนตา
วายน้ําใหสามารถแขงขันในตลาดโลกได รวมถงึเปนทางนําไปสูการมีเครื่องหมายการคาที่เปนของ
ประเทศไทยได โดยคอมพวิเตอรชวยการออกแบบจะนาํมาประยุกตเพื่อการออกแบบแวนตาวาย
น้ําจากรูปทรงเฉพาะแบบ (feature) ตางๆ ของแวนตาวายน้าํที่จะดําเนินการวิจยัโดยการรวบรวม
เปน Library  เพื่อใหการออกแบบสามารถดําเนนิการไดโดยงายดวยการแกไขขนาดตาง ๆ และ
อาจมีดัดแปลงบางเพยีงเลก็นอย  สวนคอมพิวเตอรชวยงานวิศวกรรม จะนํามาใชเพือ่การจําลอง
การทดสอบใหไดตรงตามมาตรฐานสากลของผลิตภัณฑแวนตาวายน้ํา (เชน BS5883:1996) 
รวมถึงการวเิคราะหเพื่อการออกแบบใหสวมใสที่แนบสนิทกับใบหนาและใหความสบายตอใบหนา
และศีรษะ 
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การตรวจเอกสาร 
 

 การวายน้าํเปนกิจกรรมการออกกําลงักายที่นยิมอยางแพรหลายทัว่โลก  และเปน
หลักสูตรการศกึษาและกิจกรรมเสริมในสถานศกึษา ต้ังแตระดับอนุบาลถึงระดับอุดมศึกษา  กีฬา
ทางน้าํนอกจากกีฬาวายน้ําแลว ไดแกกีฬากระโดดน้าํ และโปโลน้าํ โดยกีฬาเหลานีม้ีอุปกรณ ที่ใช
ที่สําคัญคือ แวนตาวายน้าํ  การใชแวนตาวายน้ํามีจุดประสงคเพื่อ การมองเหน็อยางชัดเจนทัง้ใต
และเหนือผิวน้าํ  การปองกันนัยนตาจากสิง่สกปรกและสารเคมีในน้ํา  และปกปองลกูตาจากวัตถุ
ของแข็งเขาตา  แวนตาวายน้าํที่ดําเนนิการในงานวิจัยนี้ เปนแวนตาวายน้ําที่ใชที่ระดับผิวน้าํ 
(Surface Swimming Goggle) ซึ่งไมจัดเปนประเภทเดยีวกนักับแวนตาสําหรับการดําน้ํา ฯลฯ 
 
 คุณสมบัติที่สําคัญของแวนตาวายน้าํที่ดี ไดแก 

1. น้ําไมร่ัวซมึเขาภายในแวนตา 
2. มีความใสปราศจากรอยตําหนิตาง ๆ  เชน ฟองอากาศ และรอยตําหนทิี่เกิดจากการ

ผลิตโดยกรรมวิธีการฉีดพลาสติก 
3. โปรงใส ภาพไมบิดเบี้ยว  อาจมีสีเขมไดเพือ่กันแสงแดดเมื่อใชกลางแจง 
4. ใหมุมมองของสายตาที่กวาง 
5. ไมมีโลหะและแกวเปนชิ้นสวนของแวนตา 
6. แผนหนาหรือเลนสมีความคงทน  โดยวัสดุที่เปนเลนสตองไมเกิดการแตกกระจายเมือ่

หักหรือเกิดการกระแทก 
7. ไมเกิดหมอกไอน้ําหรือฝา จบัผิวภายในแวนตา 
8. สามารถปองกนัแสง UV ได 
9. มีน้ําหนักเบา 
10. ไมมีขอบหรือมุมที่คม  ที่จะทําใหเกิดบาดแผลบนใบหนา 
11. ไมหลุดหรือล่ืนไถล ออกจากตาหรือใบหนา 
12. สวมใสสบายไมรัดศีรษะและใบหนามากจนเจ็บหรือปวด 
13. สามารถทําการสวมใสไดสดวกและงาย 
14. ทนทานตอการเกิดรอยขีดขวนโดยเฉพาะบริเวณแผนเลนส 
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1.   โครงสรางของแวนตาวายน้าํ  
แวนตาวายน้ําพลาสติกประกอบดวยชิน้สวนตางๆ ที่สําคัญ คือ 
1. ถวยตา (Eye Cup) ประกอบดวยสองสวนหลกั คือ ลําตัวหรือกรอบหรือตัวกระบอก 

(Body หรือ Frame หรือ Cup) และแผนหนาหรือเลนส (Lens)   ตัวถวยตา อาจแยก
เปนสองชิน้สวน คือ ตัวกรอบและแผนเลนสหรือฉีดพลาสติกรวมกนัเปนชิ้นเดยีว  วัสดุ
ที่นยิมใชเปนพลาสติก Polycarbonate (PC)   

2. แผนปะเกน็กนัน้าํ (Water Seal หรือ Lipseal หรือ Gaskets หรือ Cushion)  วัสดุที่
นิยมใชเปนวัสดุที่มีความออนนุม ไดแก silicone, TPE และ polyvinyl เปนตน 

3. ชิ้นจมกู (Joint หรือ Nose Pieces  หรือ Bridge Strap) เปนชิ้นสวนที่ใชเชื่อมตอ
ระหวางถวยตาทัง้สองขาง  แวนตาบางรุนจะไมมีชิ้นจมกู เนื่องจากถวยตาทัง้สองขาง
เชื่อมตอเปนชิน้เดียวกัน 

4. สายยางรัดศีรษะ (Head Strap หรือ Belt) 
5. หัวรัดสายยาง (Buckle) ใชสําหรับรัดสายยางรัดศีรษะและปรับความยาวของสายยาง

รัดศีรษะ 
 
 

 
ภาพที ่1   ชิ้นสวนของแวนตาวายน้าํ 

 
2.   กระบวนการผลิตแวนตาวายน้ํา 

5. หัวรัดสายยาง 
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 การผลิตแวนตาวายน้าํแยกออกเปนสองสายการผลิต คือ สายการผลติชิ้นสวนพลาสติก
และสายการผลิตชิ้นสวนยาง/ซิลิโคน ทั้งสองสายการผลติ สามารถแยกเปน 4 กระบวนการหลกัคือ 

1. การผลิตชิ้นสวน 
2. การพิมพเครื่องหมายและลวดลาย 
3. การประกอบ 
4. การบรรจุ 

 
2.1   การผลติชิ้นสวน 
2.1.1   สายการผลิตชิ้นสวนพลาสติก  

การผลิตชิ้นสวนที่เปนพลาสติกใชกระบวนการฉีด  ซึ่งมีชิน้สวนทีท่ําการผลิต คือ ถวยตา
หัวรัดสายยาง ชิ้นจมูก แผนปะเก็นกันน้ํา  ชิ้นสวนทีเ่ปนเทอรโมพลาสตกิ (Thermoplastic) เหลานี้ 
มีกระบวนการผลิตตามแสดงในภาพที ่2  โดยมีข้ันตอนดังตอไปนี้ 

1. Plastic Compound เปนกระบวนการเตรียมเม็ดพลาสติก คือ การนําเอาเม็ด
พลาสติกไปทาํการอบความรอนเพื่อไลความชื้นที่อุณหภูมิที่เหมาะสมตามคุณสมบัติ
ของพลาสตกินั้น  

2. Mixing เปนขั้นตอนการผสมสีเพื่อใหเปนสีตามตองการ 
3. Injection เปนกระบวนการฉดีพลาสติกขึ้นเปนรูปทรง   โดยเริ่มจากการนําเม็ด

พลาสติกที่ผสมสีแลวใสในกรวยเติมพลาสติก (hopper) ของเครื่องฉีดพลาสติก   
เครื่องฉีดที่ใชมีขนาด 50 ถึง 100 ตัน ตามขนาดเล็กใหญของแมพิมพ   ชิน้งาน
พลาสติกที่ไดออกมาจากแมพิมพ  มีสวนที่ไมใชชิ้นสวนของชิ้นงานที่ตองการ เชน 
Sprue และ Runner   ชิ้นสวนเหลานี้สามารถ recycle มาใชใหมได ตามสัดสวนที่
เหมาะสมของเม็ดพลาสติกใหมและพลาสติก recycle  

4. ถวยตาหรือเลนส จะผานการเคลือบสารกันฝา (Anti-Fog) โดยมีกระบวนการดังตอไนี ้
ก. ทําความสะอาดตัวเลนสโดยการพนลมแรง  เพื่อใหฝุนที่เกาะอยูหลุดออกจากตวั 

เลนส และทําใหตัวเลนสมีความเปนกลางทางไฟฟา  ข้ันตอนนีท้ําใหฝุนไม
กลับมาเกาะบนเลนสอีก 

ข. ทําการหยดสาร Polyurethan Aqucous Dispersion (OK300) เพื่อเคลือบผิว
ภายในเลนส   สารที่ใชนี้เปนสารเคลือบกันฝาไอน้ํา 

ค. ทําการดูดสารเคลือบกันฝา (Polyurethan Aqucous Dispersion) ที่เกินและ
ตกคางออกจากเลนส 
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ง. นําเลนสเขาเครื่องอบความรอน เพื่อใหสารแหง แลวนาํเขาเครื่องดูดความชื้น 
2. ชิ้นสวนพลาสติกที่ได จะนําไปทําการพิมพเครื่องหมายการคา หรือตบแตงลวดลาย   

โดยถวยตาพมิพโดยวิธี Pad Printing และ ชิ้นจมูก (Joint) พิมพโดยวธิี Hot -
Stamping. 

2.1.2   สายการผลิตชิ้นสวนยาง/ซิลิโคน  
ชิ้นสวนทีเ่ปนยางทําการผลติโดยใชวิธีการกดอัดดวยความรอน ชิน้สวนที่ผลิต ไดแก แผน

ปะเก็นกันน้ํา และ สายยางรัดศีรษะ กระบวนการผลิตมลํีาดับตามแสดงในภาพที ่4  โดยมีข้ันตอน
ดังตอไปนี้ 

1. Mixing หรือ การตียาง เปนกระบวนการผสมยางกับสารเคมีพิเศษ เพื่อทําใหยางออน
ตัว   แลวนําไปรีด เพื่อใหไดยางเปนแผนออกมา (ภาพที่ 2) 

2. Compress เปนกระบวนอดัและอบความรอนใหยางสขุ เปนการทาํใหยางแข็งตัวและ
คงรูปทรงตามแบบแมพิมพที่ใชในกระบวนการอัดนี้ (ภาพที่ 3) 

3. Trimming เปนการลอกยางหรือตัดแตงตามขอบของชิ้นงาน ใหไดขนาดตามตองการ 
4. สําหรับสายยางรัดศรีษะ (Belt) จะนําไปทําการพิมพเครื่องหมายการคาหรือตบแตง

ลวดลาย ดวยวิธีการพิมพแบบ  Silk Screen Printing.  
 

  
 

    
                         

ภาพที ่2   ข้ันตอนการทํายางแผนเพื่อนาํไปทําสายยาง  ก) ยางดิบ  ข) เครื่องรีดยางดิบ  
   และ ค) ยางดิบที่ผานการรดีแลว 

ก) 

ข) ค) 
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ภาพที ่3  การขึ้นรูปสายยางดวยเครื่องกดอัดดวยความรอน 
 
 

2.2   การประกอบ (Assembly Line)        
เมื่อไดชิ้นสวนแวนตาวายน้ําครบทุกชิ้นแลว จงึนาํชิ้นสวนมาประกอบเขาดวยกนัโดยเริ่ม

จากนํา ถวยตา มาทาํการติดกับ แผนประเก็นกนัน้ํา ทัง้ดานซายและขวา แลวนาํไปติดกับยาง 
Neoprene เพือ่กันการกดทบับริเวณขอบตา  โดยใชอุปกรณจับยึดชิ้นสวนของยาง Neoprene 
แลวทากาวทบัลงไป   แลวจึงกดตัว Lens เพื่อใหชิน้สวนทั้งสองยึดติดกัน   หลังจากนัน้นํา Lens 
ทั้งสองขางมาประกอบติดกันดวย ชิ้นจมูก แลวใสสายรดัและหัวรัดสายยาง ตามลําดับ 
 
2.3   การบรรจุหีบหอ (Packaging Line) 
 การบรรจุหีบหอแวนตาวายน้าํ เปนสายการผลิตตอเนื่องจากสายการประกอบ  โดยนํา
แวนตาวายน้ํามาประกอบตดิกับแกนกระดาษแข็ง  โดยใชสายยางรัดศรีษะมาพนักบัแกนกระดาษ
เพื่อกนัการเคลื่อนตัวในขณะการขนสง  บรรจุเอกสารแนะนําวิธีการใชและขอมูลของแวนตาวาย
น้ํา ใสกลอง   ติดรูปลอก (Sticker) ของบริษัทที่ส่ังผลิต    ผลิตภัณฑที่เสร็จสมบูรณแลวนาํไปบรรจุ
ลงลังเพื่อการจัดสงใหแกผูส่ังผลิตตอไป 
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ภาพที ่4  แผนภูมิแสดงกระบวนการผลิตแวนตาวายน้ํา 

สายการผลิต 
ชิ้นสวนพลาสติก 

สายการผลิต 
ชิ้นสวนยาง/ซิลิโคน 

Plastic compound Rubber/Silicone 

Mixing Mixing 

Injection Compress 

Buckle Joint Lipseal Lens Lipseal Belt 

Anti-Fog Coating Cut/Trim 

Pad Printing Silk screen Hot stamp 

A/F Lens with logo 

Assembly Line 

Packaging 

Customer 
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3.   กรรมวธิกีารผลิตชิน้สวนโดยการฉีดพลาสติก 
การฉีดพลาสติกเปนการผลติผลิตภัณฑที่มีรูปทรงซับซอนและตองการผลิตจํานวนมาก  

ระบบการผลิตเปนแบบอัตโนมัติจึงทาํงานไดรวดเร็วและใหอัตราการผลติที่สูง   การผลิตชิ้นสวน
โดยการฉีดพลาสติกจึงมีความสําคัญตออุตสาหกรรมตางๆ ในปจจุบันอยางมาก 

เครื่องฉีดพลาสติก (Injection Molding Machine) สามารถทาํงานไดกับพลาสตกิทีม่ี
ลักษณะเปนเม็ดหรือเปนผง   นิยมใชกับพลาสติกประเภท เทอรโมพลาสติก (Thermoplastic)   ทั้ง
เครื่องจักรและแมพิมพตางมีความสาํคัญตอกระบวนการผลิตชิ้นสวนพลาสติก   

 
3.1   ประเภทของเครื่องฉีดพลาสติก 

เครื่องฉีดพลาสติกสามารถแบงตามลกัษณะของทิศทางการฉีดได  4  แบบ [1, 2] คือ 
1. แบบแนวตั้งพลาสติกไหลเขาแนวนอน (ภาพที่ 5ก)  พลาสติกเหลวฉีดออกจาก

กระบอกฉีด (Barrel) ในแนวดิ่งแลวเปลีย่นทิศทางการไหล 90O เขาแมพิมพซึ่งอยูใน
แนวตั้ง 

2. แบบฉีดแนวดิ่ง (ภาพที ่5ข) พลาสติกเหลวฉีดลงในแนวดิ่งตั้งฉากกับแมพิมพ ที่ติดตั้ง
ในแนวนอน 

3. แบบฉีดตั้ง (ภาพที่ 5ค) พลาสติกเหลวฉีดในแนวนอนเขาดานขางของแมพิมพที่ติดตั้ง
ในแนวนอน 

4. แบบแนวนอน (ภาพที่ 5ง) พลาสติกเหลวฉดีในแนวนอนเขาเปนเสนตรงตั้งฉากกับ
ระนาบของแมพิมพ ที่ติดตั้งในแนวตัง้   เครือ่งฉีดพลาสตกิแบบแนวนอนนี ้เปนเครื่อง
ฉีดพลาสติกทีน่ิยมใชมากทีสุ่ดในปจจุบัน 

 

    
  (ก)        (ข)     (ค)   (ง) 
 

ภาพที ่5   เครื่องฉีดพลาสตกิแบบตางๆ 
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3.2  สวนประกอบของเครื่องฉีดพลาสติกแนวนอน 
เครื่องฉีดพลาสติกแบบแนวนอน มีสวนประกอบหลกัที่สําคัญ  3  สวน  ตามแสดงในภาพ

ที่ 6 ดังตอไปนี ้
1. ชุดฉีด หรือ Injection  Unit 
2. ชุดเปด-ปดแมพิมพ หรือ Clamping  Unit 
3. ฐานเครื่อง  หรือ Base 

 

 
 

ภาพที ่6  สวนประกอบของเครื่องฉีดพลาสติกแนวนอน 
 
3.3   ชุดฉีด  (Injection Unit) 

ชุดฉีดพลาสตกิ  จะอยูทางดานขวาของเครื่อง  มีสวนประกอบตางๆ ดังแสดงในภาพที่ 7 
ดังตอไปนี้ 

1. หัวฉีด (Nozzle)  เปนปลายหัวมนเพื่อเชื่อมตอใหพลาสติกไหลเขาแมพิมพ 
2. เกลียวหนอน (Screw) และชุดขับเคลื่อน ทําหนาที่ในการหมุนเกลียวเพือ่ลําเลียง

พลาสติกไปยงัปลายเกลียว ในจงัหวะฉีดจะทําหนาที่เปนลูกสูบอัดพลาสติกไปใน
แนวแกน   เกลียวหนอนสามารถแบงไดเปน 2 แบบ ดังแสดงในภาพที่ 8 
ก. แบบธรรมดา  เม็ดพลาสติกในชวงบริเวณเขาจะถูกหลอมเหลวและสงเขาชวง

บริเวณอัดตอไปยังปลายเกลยีวหนอนเพื่อฉีดออก  เกลียวหนอนสวนใหญจะ
กลายเปนเกลยีวซาย  มีความยาว  18D (18 เทาของเสนผานศูนยกลาง) ถึง 22D  
อัตราสวน  ความลึกของรองเกลียว  2 : 1  ถึง  2.5 : 1 

ข. แบบมีชวงไลอากาศ  ตามมาตรฐานใชเกลียวหนอนยาว ที่มีความยาวมากกวา 
20D  
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ภาพที ่7  สวนประกอบของชดุฉีด 

 

 
   (ก) แบบธรรมดา   (ข) แบบมีชวงไลอากาศ 

ภาพที ่8  เกลยีวหนอนแบบธรรมดา (ก) และ แบบมีชวงไลอากาศ (ข) 
 

3. กระบอกฉีด (Barrel) ทําหนาที่ในการประคองเกลียวหนอนและบรรจุและลําเลียง
พลาสติกเหลวเพื่อฉีดออกไปยังหวัฉีด   

4. แผนใหความรอน (Heater) เปนอุปกรณ ใหความรอนลอมรอบนอกกระบอกฉีด  เพือ่
ควบคุมความรอนของพลาสติกในกระบอกฉีด 

5. กรวย (Hopper) สําหรับใชเติมเม็ดพลาสติกเพื่อปอนพลาสติกเขาสูกระบอกฉีด 
6. ชุดไฮดรอลิกส  ประกอบดวยกระบอกสูบและลูกสูบไฮดรอลกิส  มีหนาที่สงกําลงั

ขับเคลื่อนในแนวนอนใหแกชุดขับเคลื่อนของเกลียวหนอน 
 
3.4   ชุดเปด-ปดแมพิมพ  (Clamping Unit) 
 ชุดเปด-ปด แมพิมพ  ทําหนาที ่ควบคุมจังหวะการเปดและปดแมพิมพ  อุปกรณที่ใชใน
การเปด-ปด ม ี2 ประเภท คือ ไฮดรอลิกสและมอเตอรไฟฟา  ชุดเปด-ปด แมพิมพ มโีครงสราง 2 
แบบ คือ 

1. แบบใชแรง  (Actuated by Force) โดยใชแรงจากลูกสูบไฮดรอลิกสหรือจากมอเตอร 
ในการ เปด-ปด และลอ็ค ใหแมพิมพกดกนัแนน  โดยแรงกดอัดตองมากกวาแรงดนั
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ของพลาสติกที่อยูในแมพิมพขณะฉีดพลาสติกเขาแมพมิพ  วธิีการทํางานมี 3 วิธี  
ตามแสดงในภาพที ่9 

2. ระบบกลไกล็อค (Interlocking) ใชการเคลื่อนที่ของลกูสูบไฮดรอลิกส หรือมอเตอร ใน
การขับเคลื่อนกลไกขอตอ (Linkages) ใหอยูในตําแหนงปดล็อคแมพิมพ แลวหยุด
การทาํงาน   แรงที่เกิดขึน้ในขณะฉีดพลาสติกจะสมดุลผานขอตอที่ล็อคตายตัว
ตัวอยางระบบกลไกล็อค ไดแสดงในภาพที่ 10  โดยระบบไฮดรอลิกสในภาพสามารถ
ใชมอเตอรไฟฟาเปนอุปกรณขับเคลื่อนแทนได 

 

 
 

                  
                      

                     
                      

ภาพที ่9   วิธกีารทาํงานของระบบ เปด-ปด แมพิมพแบบใชแรง โดย (ก) ใชไฮดรอลิกสสง
กําลังอัดปดแมพิมพ   (ข) ใชมอเตอรขับเขาออกและใชไฮดรอลิกสปดแมพิมพ และ (ค) ใชไฮดรอ
ลิกสดันเขาและใชไฮดรอลิกสปดแมพิมพ  

(ก) 

(ข) 

(ค) 
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ภาพที ่10   การ เปด-ปด แมพิมพโดยใชระบบกลไกล็อค โดยแบบ (ก) ระบบคานลอ็ค 

อยางงาย ใชไฮดรอลิกสหรือมอเตอรไฟฟาขับเคลื่อนกลไก  แบบ (ข)  ระบบกระเดื่องล็อค  ใช   
ไฮดรอลิกสขับเคลื่อนกลไก และแบบ (ค) ระบบกระเดื่องล็อคคู  ใชไฮดรอลิกสขับเคลื่อนกลไก  

 
3.5   ขั้นตอนการทาํงานของเครื่องฉีดพลาสติก 

ลําดับการทํางานของเครื่องฉีดพลาสติกมทีั้งหมด 6 ข้ันตอน ตามลาํดบัตอไปนี้ 
1. แมพิมพเลื่อนเขาในตําแหนงปด (ภาพที่ 11 ก) 
2. หลังจากปดลอ็คแมพิมพแนนแลว  หวัฉีดจะเคลื่อนที่ไปชนแมพมิพ  โดยมีพลาสตกิ

หลอมพรอมทีจ่ะฉีดอยูในกระบอกฉีด (ภาพที ่11 ข) 
3. ทําการฉีดและอัดแรงดันฉีด  เกลียวหนอนทําหนาทีเ่ปนลูกสูบดันพลาสติกเหลวให

ไหลเขาไปในแมพิมพ แลวอัดแรงดันคางไวชวงระยะเวลาหนึ่ง เพื่อใหเนื้อพลาสติกใน
แมพิมพมีความหนาแนนเพยีงพอ (ภาพที่ 11 ค) 

(ก) 

(ข) 

(ค) 
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4. ที่ชุดฉีด  ทําการหลอมเหลวและลําเลียงพลาสติกไปหนาปลายเกลียวหนอนโดยการ
หมุนของเกลยีวหนอน (ภาพที่ 11 ง) 

5. หัวฉีดหรือชุดฉีดถอยออก แตแมพิมพยังปดอยู (ภาพที่ 11 จ) 
6. แมพิมพเปดแลวทาํการกระทุงเพื่อปลดชิน้งานออก (ภาพที่ 11 ฉ) 

 

  
   (ก)     (ข) 

  
   (ค)     (ง) 

  
   (จ)     (ฉ) 

ภาพที ่11  ข้ันตอนการทํางานของเครื่องฉดีพลาสติก 
 
4.   วัสดุที่ใชในการผลิตแวนตาวายน้ํา 
 วัสดุที่ใชในการผลิตชิ้นสวนตาง ๆ ของแวนตาวายน้ํา เปนโพลเีมอรหลายชนิดที่มี
คุณสมบัติแตกตางกนัตามลักษณะหนาที่และการใชงานของชิน้สวนนัน้ ๆ  วัสดุสําคัญที่ใชในการ
ผลิตแวนตาวายน้ํามีดังตอไปนี ้
 
4.1   โพลีคารบอเนต 

โพลีคารบอเนต (Polycarbonate) หรือ PC ใชผลิตถวยแกวหรือเลนสของแวนตาวายน้ํา    
ลักษณะกอนฉีด เปนเม็ด โปรงใส ไมมีสี สามารถยอมสีได   นิยมใชทําฝาครอบโคมไฟยานยนต  
เลนส ขวดนมเด็ก ภาชนะบรรจุน้ําดื่ม หมวกนิรภัย ชิน้สวนไฟฟาและอิเล็กทรอนกิส  ตูสวิทซบอรด 
แผนปดเครื่องมือวัด กลองถายรูป เครื่องกฬีา และอุปกรณเกี่ยวกับความปลอดภัย [3] 

PC มีความแข็งแรง ทนตอแรงกระแทก และมีความทนทานดีมาก  ไมเสื่อมคุณภาพงาย  
ดูดซึมน้ํานอย ทนความรอนไดดี   อุณหภูมสูิงที่สามารถใชงานเปนระยะเวลานาน ๆ อยูในชวง 
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110°C ถึง 135°C   ที่อุณหภูมิสูงยังคงความแข็งแรง เหนียวและคงขนาด    ทนตอกรดออน 
แอลกอฮอล น้าํมันเครื่องและไขมัน ติดไฟยาก มีควนั ไฟดับไดเอง   มีอุณหภูมิหลอมเหลว 280oC 
ถึง 320oC   คาการหดตัวในทุกทิศทาง 0.7% ถึง 0.8%   ความหนาแนน 1.2 g/cm3 [4] 

 
4.2   PVC (Polyvinyl Chloride) 
 PVC แยกตามเปน 2 ประเภท คือ แบบแขง็ (PVC-hard หรือ PVCh) และแบบออน (PVC-
soft และ PVCs)   PVC ทีน่ํามาใชผลิต ชิน้จมูก แผนปะเก็นกนัน้ํา และสายยางรัดศรษะ ของ
ชิ้นสวนแวนตาวายน้าํเปน PVC แบบออน 

PVC ออนที่ใชทําชิน้สวนแวนตาวายน้ําเปนเม็ดสีใสขุน ยอมสีได เหมาะสําหรับการฉีด
ชิ้นงานที่ใส  สามารถฉีดชิน้งานที่มีรูปรางโคงหรือพับงอได มีความคงทนตอแรงกระแทกไดสูง และ
คงสภาพอยูไดนานภายใต สภาพอากาศและแสง เม็ดโปรงแสงสามารถยอมสีทึบไดทุกสี ติดไฟ
ยาก  เมื่อติดไฟ มีควัน ไฟดบัไดเอง ทนตอกรดและดาง แอลกอฮอล เบนซิน น้ํามนัเครื่องและไขมัน  
[2]อุณหภูมิที่ใชงานไดเปนระยะเวลานานไดสูงถึง 60 oC ถึง 70oC  มีอุณหภูมิหลอมเหลว 170oC 
ถึง 200oC  คาการหดตัวเฉลี่ย 0.4% ถึง 0.5%  
 
4.3   ABS (Acrylonitrile Butadiene Styrene) 
 ABS ใชผลิตหัวรัดสายยางของแวนตาวายน้ํา  ลักษณะกอนฉีด เปนเมด็ ทึบแสง มีสี
เหลืองนวลออกน้ําตาลออน   นิยมใชผลิตชิ้นสวนรถยนต เฟอรนิเจอร ภาชนะในครวัเรือน ชิ้นสวน
โคมไฟยานยนต   สามารถเคลือบผิวดวยวธิีทางไฟฟาไดโดยไมตองเตรียมผิว 

ABS มีความเหนยีว ทนตอการกระแทก และความรอนไดดี  มีความแข็งแรงสูง ทนตอ
สภาพดินฟาอากาศ ไมเสื่อมสภาพ ไมมีสารเปนพิษตกคาง   ทนตอดาง กรดออน  ไขมัน  และ ทน
ตอสารไฮโดรคารบอน (เชน เบนซนิ น้าํมนัเครื่อง)   มีอุณหภูมิหลอมเหลว 200oC ถึง 280oC   คา
การหดตัว 0.4% ถึง 0.6 %   ความหนาแนน 1.05 g/cm3 
 
4.4   ซิลิโคน (Silicone) 

 ซิลิโคน (มีอักษรยอ SI) ใชผลิตแผนปะเกน็กนัน้าํของแวนตาวายน้าํ  เปนพลาสติกที่ตาง
จากพลาสติกชนิดประเภทอืน่  โดยมีสวนประกอบหลัก คือ ซิลิคอน ทีไ่ดจากการรีดักชั่นดวยทราย
และออกซิเจนในเตาไฟฟา (พลาสติกประเภทอื่น มีคารบอนเปนธาตหุลักตามแตสวนประกอบทาง
เคมี) แลวกลายเปนน้ํามันซลิิโคน (Silicone Oil)  ซิลิโคนเรซิน (Silicone Resin)  หรือยางซิลิโคน  
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ซิลิโคนทกุชนดิมีคุณสมบัติ คือ น้ําไมจับผิว ไมติดกาวได มีสถานะเปนกลางทางเคม ีเปน
ฉนวนไฟฟาและทนความรอนได 

 น้ํามนัซิลิโคนเปนของเหลวใสเหมือนน้าํ ไมมีกลิ่น มีอุณหภูมิต้ังแต – 60o C ถึง 250o C คา
ความหนืดจะไมเปลี่ยนแปลง  น้าํมันซิลิโคนใชฉีดเปนผวิชั้นบางเคลือบในการอัด (Compression 
Mold) สําหรับชิ้นงานพลาสติกหรือชิ้นสวนยางเพื่อทาํใหชิ้นงานที่อัดอยูในแบบหลดุออกไดงาย 
 
4.5   ยางธรรมชาต ิ

ยางใชผลิตสายรัดศรีษะของแวนตาวายน้ําโดยกรรมวิธกีารอัดรอน   ยางธรรมชาติเปน
วัสดุประเภทไฮโพลีเมอร (High Polymer)  เกิดจากกระบวนการเปลี่ยนแปลงของวัสดุธรรมชาติ 
วัสดุนี้เปนน้าํยาง (สีเหมือนน้ํานม) ไดจากตนยางพารา นาํมารมควันหรือเติมกรดอะซิติก (Acetic 
Acid) กลายเปนยางดิบที่เปนชั้นหนา ยางดิบเมื่อถูกความรอนจะเหนยีวเหมือนกาวจึงตองทํา
การวัลเคไนเซชั่นใหปฏิกิริยานีห้ายไป กอนการวัลเคไนเซชั่นจะมีการยอยยางดิบใหเล็กลงแลว
นําไปผสมกบักํามะถัน เติมสารสีลงไป แลวจึงนําไปอัดขึ้นรูป สารทีเ่ติมใหเปนสีดําคอืคารบอนใน
รูปกาซ ทําใหมีความเคน ความแข็ง ความยืดหยุน ความฝด สูงขึ้น สําหรับยางผสมสีขาวจะกระทาํ
โดยใชกรดซิซลิิก (SiO) หรืออะลูมิเนยีมซลิิเกตเขาทาํปฏิกิริยาแลวใสสีขาวผสมเขาไป  การวัลเคไน
เซชั่น (Vulcanization) คือ การทําใหยางแข็งดวยการใชกํามะถันดิบยดึติดกันแนนโดยกระทาํที่
อุณหภูมิ 142oC ดวยความดนั 5 บรรยากาศ ใหเปนรูปชิน้สวนซึ่งสามารถใชโลหะผสมเพื่อใหยึด
เหนีย่วกันแข็งแรงขึ้น เชน ยางรถยนต สายยางน้าํ 

ยางธรรมชาติเมื่อถูกน้าํมนัแร เชน เบนซิน เบนโซล น้าํมนั จะเกิดการบวมและทาํให
คุณสมบัติทางกลสูญหายในที่สุด ยางธรรมชาติทาํปฏิกริิยากับออกซิเจนในอากาศใหยางแข็ง 
ชิ้นสวนยางทีสํ่าคัญควรเกบ็รักษาดวยการทาแปงพอกผิวกันเอาไว ความรอน แสงแดด หรือความ
เย็นจัด เปนตวัเรงใหยางแข็ง เปราะ หรือออนเหลว ทําใหความยืดหยุนหายไปในทีสุ่ด 
 
5.   การทดสอบคุณสมบติัทางกลของพลาสติก 
 เนื่องดวยการออกแบบผลิตภัณฑใหไดขนาด น้ําหนัก และความแข็งแรง ใหตรงตามความ
ตองการ  คุณสมบัติทางกลของพลาสติกที่ถูกตอง จึงชวยทาํใหผลการวิเคราะหมีความถูกตองและ
แมนยํามากขึ้น   คุณสมบัติทางกลของพลาสติกสามารถทําการทดสอบได โดยการทดสอบการดงึ
ของพลาสติก (Tensile Testing of Plastic)  ตามมาตรฐานการทดสอบวัสดุ ASTM D638 [5] การ
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ทดสอบนี้สามารถหาคา Tensile strength, Tensile modulus, Tensile elongation และ 
Poisson’s ratio   ชิ้นพลาสติกที่ใชทดสอบมีลักษณะเปนแบบ Sheet หรือ Plate และจากการฉีด
ข้ึนรูปใหมีขนาดตามมาตรฐาน (Molded Plastics)   ขนาดของชิน้งานทดสอบแยกออกเปน 2 
กลุม ตามความแข็งของพลาสติกไดดังนี้  

ก. Rigid and semirigid plastics   ขนาดชิ้นทดสอบสําหรับพลาสติกที่แข็งและคอนขาง
แข็งมี  4 แบบ  แยกตามความหนาของแผนวัสดุโดย 

แบบที่ 1 (Type 1) สําหรับชิน้ทดสอบที่มีความหนา 7 มม. หรือ นอยกวา  
แบบที่ 2 (Type 2) สําหรับวสัดุที่รอยขาดไมอยูบริเวณชวงแคบของชิน้งาน  
แบบที่ 3 (Type 3) สําหรับวสัดุ ที่มีความหนามากกวา 7 มม. แตไมเกิน 14 มม.  
แบบที่ 5 (Type 5) สําหรับชิน้ทดสอบที่มีความหนา 4 มม. หรือ นอยกวา  
สําหรับรายละเอียดของขนาดตางๆ ของชิน้ทดสอบทั้ง 4 แบบนี้ไดแสดงไวในภาพ

ที่ 12 และ ตารางที ่1 
ข. Nonrigid plastics   ขนาดชิ้นทดสอบสาํหรับพลาสตกิที่มีความออนตัว มี 2 แบบ 

แยกตามความหนาของแผนพลาสติก คือ แบบที่ 3 (Type 3) และแบบที่ 4 (Type 4) 
โดยแบบที่ 3 ใชไดทั้งพลาสตกิที่แข็งและออน   

แบบที่ 4 จะใชกับชิ้นทดสอบที่มีความหนา 4 มม. หรือ นอยกวา ภาพวาดของ 
         ขนาดของแบบที่ 4 ไดแสดงในภาพที่ 13 และขนาดในตารางที่ 1 

 
 

 
 

ภาพที ่12  ภาพวาดชิน้ทดสอบแสดงขนาดตางๆ ของชิน้ทดสอบแบบ 1, 2, 3 และ 5 
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ภาพที ่13  ภาพวาดชิน้ทดสอบแสดงขนาดตางๆ ของแบบที่ 4 

 
ตารางที่ 1 แสดงขนาดตาง ๆ ของชิ้นทดสอบ ตามมาตรฐาน ASTM D638  

 
Under 7 mm. 

thick 
7 to 14 

mm. thick 
under 4 mm. 

thick  Dimension 
(mm) 

Type 1 Type 2 Type 3 Type 4 Type 5 

Tolerance
s 

(mm) 
W Width of narrow section 13  6  19  6  3.18  ± 0.5  
L Length of narrow 

section 
57  57  57  33  9.53  ± 0.5 

WO Width overall, min 19 19 29 19 … +6.4 
WO Width overall, min … … … … 9.53 +3.18 
LO Length of overall, min 165 183 246 115  63.5 No max 
G Gage length 50 50 50  7.62 ± 0.25 
G Gage length … … … 25 … ± 0.13 
D Distance between 

grips 
115 135 115 65 25.4 ± 0.5 

R Radius of fillet 76 76 76 14 12.7 ± 1 
RO Outer radius (Type 5) … … … 25 … ± 1 
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ข้ันตอนการทดสอบ  เร่ิมจากการนาํชิน้ทดสอบประกอบเขากับหวัจับของเครื่องทดสอบ
โดยปรับใหระยะจับไดตามมาตรฐาน ASTM D638 เร่ิมทดสอบโดยการดึงใหชิน้ทดสอบยืดออกจน
ขาด   สําหรับความเร็วในการดึงนัน้จะขึน้อยูกับลักษณะเฉพาะของชิน้ทดสอบ   ตามมาตรฐาน 
ASTM D882 และมาตรฐาน ISO 527 ไดแนะนาํใหใชความเร็ว 5 ถึง 50 มิลลิเมตรตอนาที สําหรับ
การวัดคา ความเคน (Stress, σ) และ การยืดตัว (Elongation, ∆)   และ 1 มิลลิเมตรตอนาที 
สําหรับการทดสอบเพื่อหาคา Modulus of Elasticity (E) 

 
6.   มาตรฐานการทดสอบแวนตาวายน้ํา 

กอนทีจ่ะนําแวนตาวายน้าํออกจําหนายตอผูบริโภค   แวนตาวายน้าํทุกรุนจะตองผาน
มาตรฐานทดสอบความแขง็แรง  เพื่อความปลอดภัยของผูใช   มาตรฐานทดสอบที่ใช  คือ มาตร-
ฐานของ สหราชอาณาจักร (British Standard หรือ BS)  BS5883: 1996   โดยเปนมาตรฐานดาน
ความปลอดภยัของผูสวมใส   ในมาตรฐานนีน้อกเหนือจากการทดสอบการรั่วซึมของน้าํเขาภายใน 
แวนตาวายน้ําแลว ชิ้นสวนตางๆ ของแวนตาวายน้าํตองไมเปนโลหะ  และยังตองผานการทดสอบ
ทางกล 3 การทดสอบ คือ 
 
6.1   การทดสอบการดึง (Tensile Test)   
 การทดสอบการดึงใชทดสอบเฉพาะชิ้นจมูก   ชิ้นงานของชิ้นจมูกตองปรับใหตําแหนงใช
งานทีย่าวที่สุด   ทําการดึงตามแนวความยาวดวยแรง 10 นิวตนั ± 0.5 นิวตนั แลวบันทึกความ
เสียหายที่เกิดขึ้น   วิธีการนี ้ตามมาตรฐาน BS5883:1996 สามารถทดสอบความตานทานการลื่น
ไถลของชิ้นจมกู ควบคูไปไดดวยกนัโดยการทําใหชิน้จมกูและหวงยึดชิน้จมูกและถวยตาเปยกดวย
น้ํากอนทําการทดสอบ 
 
6.2   การทดสอบการอัด (Compressive Test)   
 การทดสอบการอัด ใชทดสอบความแข็งแรงเฉพาะถวยตา   ชิ้นถวยตาทีท่ดสอบตองวาง
บนฐานรองที่เหมาะสม แลวกดบนถวยตาดวยแรงขนาด 588 นิวตัน ± 2 นิวตัน ผานแผนโลหะ
เปนเวลา 1 นาท ี± 5 วินาท ี  ดําเนนิการซ้าํที่ขอบของถวยตา   การทดสอบนี้ตองดําเนินการกับ
ถวยตาทัง้สองขาง   รายงานผลทดสอบ  ประกอบดวย การเกิดการแตกแยก และรอยราว 
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6.3   การทดสอบการกระแทก (Impact Test)  
 การทดสอบการกระแทก   เปนการทดสอบความทนทานตอการเกิดการกระแทกบนเลนส 
ของถวยตา   การทดสอบกระทําโดยการสวมแวนตาวายน้ําบนศีรษะจําลอง  โดยตําแหนงของ
แวนตาตองปรบัใหอยูตามลกัษณะการสวมใชงาน   ปรับศีรษะจําลองใหระนาบของผิวเลนสอยูใน
แนวนอน   ใชลูกบอลโลหะขนาดเสนผานศูนยกลาง 22 มิลลิเมตร หนกั 44 กรัม ปลอยลงทอราง
ใหตกกระแทกที่จุดกึ่งกลางของเลนสจากความสงู 1.3 เมตร (หรือควบคุมภายในชวงความสงู 127 
เซนติเมตร ถงึ 130 เซนติเมตร)    ตรวจสอบสภาพหลงัการทดสอบตองไมมีรอยราวและแตก 
 
7.   คอมพิวเตอรชวยการออกแบบและคอมพิวเตอรชวยงานวิศวกรรม 
 CAD (Computer-Aided Design) คือ ซอฟตแวรคอมพวิเตอรชวยการออกแบบ 
ซอฟตแวรนี ้ชวยใหผูใชเกิดความสะดวกและรวดเร็วในการพัฒนาผลติภัณฑ 3 มิติ ที่เปนลกัษณะ
รูปโครงลวด (wire frame model) รูปแผนผิว (surface model) และรูปวัตถุแข็ง (solid model)   
โดยเทคโนโลยลีาสุดของซอฟตแวร CAD เปนการออกแบบวัตถุแข็ง [6] หรือเรียกทบัศัพทตาม
ภาษาอังกฤษวา “โซลิดโมเดล”     โซลิดโมเดลเทคโนโลยี เปนเทคโนโลยี ที่สรางเปนรูปทรง 3 มิติ 
ข้ึนมากอนแลวจึงนําไปกาํหนดเปนภาพวาดแบบ 2 มิติพรอมขนาด    ผลิตภัณฑทีพ่ัฒนาโดยใช โซ
ลิดโมเดล จะมีขอไดเปรียบในการใชไฟลขอมูล (CAD file) ของแบบผลิตภัณฑนั้น ๆ ไปใชงานตอ
ในซอฟตแวร CAM (Computer - Aided Manufacturing) และ CAE (Computer-Aided 
Engineering)   ไดโดยไมตองสรางแบบขึน้มาใหม 
  CAE คือ ซอฟตแวรคอมพิวเตอรชวยงานวศิวกรรม หรือ ชวยคํานวณทางวิศวกรรม   เพื่อ
นําผลที่ไดมาวเิคราะหการทาํงาน หรือจาํลอง (Simulation) การใชงานในสภาวะตางๆ ที่ตองการ
ได   โดยทั่วไปแลว ศาสตรทีใ่ชในการคํานวณ คือ ศาสตรทาง ไฟไนตเอลิเมนต (Finite Element 
Analysis) หรือ FEA    ซอฟตแวร CAE สามารถแยกตามสายงานหรือกลุมงานได 2 กลุม [7] คือ 

1. การวิเคราะหเพื่อชวยการออกแบบ 
2. การวิเคราะหเพื่อชวยกระบวนการผลิต 

 
7.1   การวิเคราะหเพื่อชวยการออกแบบ  

ซอฟตแวร CAE  ประเภทนี ้ สามารถใชชวยในการกาํหนดขนาดของชิน้งาน เชน ความ 
หนาของผนัง ใหเหมาะสมตอสภาพหรือเงือ่นไขการนาํไปใชงาน   โดยมีจุดประสงคหลักเพื่อลด
น้ําหนกั และขนาดของชิน้งาน ซึง่เปนการลดตนทุนวัตถุดิบที่ใชในการผลิต  ตัวอยางของการ
วิเคราะห ไดแก การวิเคราะหคาความเคนในวัสดุ และการยืดหรือยุบตัวของวัสดุ 
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7.2   การวิเคราะหเพื่อชวยกระบวนการผลิต   
ซอฟตแวร CAE  ประเภทนี ้ใชในการจาํลองผลกระทบที่เกิดขึ้นในระหวางกระบวนการ

ผลิตที่จะทาํใหชิ้นงานเสียหาย หรือ ชิน้งานไมไดคุณภาพ หรือ ประสิทธิภาพของผลผลิตต่ํา   การ
วิเคราะหประเถทนี้จะรวมถึงการศึกษาการเคลื่อนที่ของเครื่องจักรและคนในสายการประกอบ
สินคา   ซอฟตแวรเหลานี้จึงเนนการปรับปรุงเพื่อเพิ่มผลผลิตในกระบวนการผลิตตาง ๆ    แตไม
ครอบคลุมซอฟตแวรอ่ืน ๆ ที่เกี่ยวของโดยตรงกับกระบวนการผลิตที่ใชเครื่องจักรกล CNC 
(Computer Numerical Control)  เนื่องจากไดจัดอยูในกลุมของซอฟตแวร CAM ซึง่ไมไดใช
หลักการวิเคราะหทางวิศวกรรมและทางไฟไนตเอลิเมนต 

การนาํ CAD/CAE มาใชในการพัฒนาผลติภัณฑ ไดมีการดําเนนิการมาอยางกวางขวาง
และแพรหลายในอุตสาหกรรมตางๆ เชน อุตสาหรรมการบินและอวกาศยาน อุตสาหกรรมยาน
ยนต อุตสาหกรรมเครื่องมือแพทย ฯลฯ   ผลงานวิจยัตาง ๆ ที่ไดทําการวิจัยเกีย่วกับการพัฒนาการ
ออกแบบแวนตาวายน้าํ โดยใชเทคโนโลยคีอมพิวเตอรชวย   จากการตรวจสอบเอกสารพบวามี
จํานวนนอยมาก    ยิง่เปนผลงานวิจยัภายในประเทศไทยดวยแลวไมมกีารทาํการวิจยั    งานวิจยัที่
จะทําการศึกษาและวิเคราะหตอไปนี้จงึมีประโยชนในการเพิม่ศักยภาพในการออกแบบและ
ทดสอบแวนตาวายน้าํภายในประเทศ โดยใชเทคโนโลยี CAD และ CAE สําหรับการวิเคราะหและ
ออกแบบ    ซึ่งจะทําใหประหยัดเวลาและพลังงานในการออกแบบและทดสอบแวนตาวายน้าํกอน
การผลิตจริง 
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อุปกรณ 
 
1.   อุปกรณและชิ้นงานสาํหรับพัฒนากรรมวิธีการออกแบบแวนตาวายน้ํา 

1. แวนตาวายน้ํารุนตางๆ จํานวน 31 รุน ซึง่ผลิตที่ บริษทั Optech Co.,Ltd. ที่อยู 134  
หมู  7  ถนนสวนหลวงรมใจ  ตําบลสวนหลวง  อําเภอกระทุมแบน  จงัหวัดสมทุรสาคร  
74110  เพื่อรวบรวมเปนขอมูลสําหรับวิเคราะห  เพื่อแบงกลุมตามลักษณะรูปทรง
ตางๆ  

2. เวอรเนียวัดขนาดชนิดแสดงตัวเลข (ภาพที่ 14)    ความละเอียด ±0.05 มิลลิเมตร 
3. คอมพิวเตอร Workstation ผลิตโดยบริษัท Silicon Graphics รุน O2   หนวย

ประมวลผลแบบ RISC มีหนวยความจํา 128 MB 
2.   ชิ้นงานสาํหรับการทดสอบทางกลตามมาตรฐานการทดสอบแวนตาวายน้ํา 

1. ชิ้นจมกูของแวนตาวายน้ํา รุน J-1 (ภาพที่ 15 ก) จํานวน 5 ชิ้น 
2. ชิ้นจมกูของแวนตาวายน้ํา รุน J-10 (ภาพที่ 15 ข) จํานวน 5 ชิน้ 
3. ถวยตาของแวนตาวายน้ํา รุน JR-1006 (ภาพที ่16 ก) จํานวน 20 ชิน้ 
4. ถวยตาของแวนตาวายน้ํา รุน 2006 (ภาพที่ 16 ข) จํานวน 20 ชิน้ 
5. ถวยตาของแวนตาวายน้ํา รุน 981 (ภาพที ่16 ค) จํานวน 20 ชิน้ 

3.   ชิ้นงานสาํหรับทดสอบคุณสมบัติของวสัดุ 
 ชิ้นงานวัสดุ PC และ PVC สําหรับทดสอบหาคุณสมบัติทางกลของวัสดุ เพื่อใชสําหรบัการ
วิเคราะห FEA โดยมีขนาดดงัไดกลาวมาแลวในภาพที ่12 และ 13 
 

 
ภาพที ่14  เวอรเนียชนิดแสดงตัวเลข 

 

  
  (ก) ชิ้นจมูก รุน J-1   (ข) ชิ้นจมูก รุน J-10 

ภาพที ่15  ชิ้นจมูกของแวนตาวายน้าํ รุน J-1 (ก) และ รุน J-10 (ข) 
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(ก) ถวยตา รุน JR-1006 
 (ข) ถวยตา รุน 2006  (ค) ถวยตา รุน 981 
ภาพที ่16  ถวยตาของแวนตาวายน้าํ รุน JR-1006 (ก), 2006 (ข) และรุน 981 (ค) 

 
4.   อุปกรณทดสอบตามมาตรฐานการทดสอบแวนตาวายน้ํา 

1. ชุดทดสอบการดึงและการอดั ยี่หอ HOUNSFIELD รุน  H50KS (ภาพที่ 17) ทาํงาน
ดวยระบบ Ball screw พรอมคอมพิวเตอรสําหรับจัดเก็บและประมวลผล และ
เครื่องพิมพเลเซอร สําหรับพมิพผลทดสอบ   คุณลักษณะเฉพาะของเครื่องไดแสดงใน
ภาคผนวกที่ 1 

2. อุปกรณสําหรบัจับยึด (Fixture) ชิ้นจมูก (ภาพที ่18) สําหรับใชกับเครือ่งทดสอบการ
ดึงและการอัด 
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ภาพที ่17  เครื่องทดสอบการดึงและการกด (Tensile and Compress Tester)     
 

 
 

ภาพที ่18  อุปกรณสําหรับจบัยึด (Fixture) ชิ้นจมูก 
 

3. เวอรเนียวัดขนาดชิน้งานทดสอบ ความละเอียด ± 0.05 มิลลิเมตร (ภาพที ่19 ก) 
4. เครื่องชั่งน้าํหนัก ความละเอียด ±0.01 กรัม (ภาพที่ 19 ข) 
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  (ก) เวอรเนียวดัขนาด    (ข) เครื่องชั่งน้าํหนัก 

 
ภาพที ่19  เครื่องชั่งน้ําหนกั และ เวอรเนียวัดขนาด 

 
5. แผนโลหะ (Steel plate) ขนาดเสนผานศนูยกลาง 50 มม. หนา 15 มม. ทาํจากเหลก็  

(ภาพที ่20)  สําหรับทดสอบการอัด 
6. ฐานรองถวยตา (Support) สําหรับทดสอบการอัดของถวยตาของแวนตาวายน้าํ      

รุน JR-1006 (ภาพที ่21 ก) ทําจากอลูมิเนยีม 
7. ฐานรองถวยตา  สําหรับทดสอบการอัดของถวยตาของแวนตาวายน้ํา     รุน 2006 

(ภาพที ่21 ข) ทําจากอลูมิเนยีม 
8. ฐานรองถวยตา  สําหรับทดสอบการอัดของถวยตาของแวนตาวายน้ํา     รุน 981 

(ภาพที ่21 ค) ทําจากอลูมิเนยีม 
 

 
 

ภาพที ่20  แผนโลหะทดสอบการอัด 
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(ก) ฐานรองถวยตา รุน JR-1006    (ข) ฐานรองถวยตา รุน 2006      (ค) ฐานรองถวยตา รุน 981 

ภาพที ่21  ฐานรองถวยตา (Support) สําหรับทดสอบการอัดของถวยตา  
            รุน JR-1006 (ก) รุน 2006 (ข) และรุน 981 (ค) 

 
9. ชุดทดสอบการกระแทก (ภาพที ่22 ก) ประกอบดวยโครงอลูมิเนียม และ ทอราง หรือ 

guide เปน พลาสติกใส ขนาดเสนผานศนูยกลาง 30 เซนติเมตร ความยาวทอ 125 
เซนติเมตร สามารถปรับระดับความสงูการปลอยตกของลูกบอลโลหะได 

10. ลูกบอลโลหะ ขนาดเสนผานศูนยกลาง 22 มม. น้าํหนัก 44 กรัม (ภาพที ่22 ข) 
11. ศีรษะจําลองสาํหรับการทดสอบการกระแทก (ภาพที่ 23 ก) เปนรูปปนจากปนูขาว 

และ เบารองศรีษะจําลองสาํหรับปรับระดับศีรษะ (ภาพที่ 23 ข) 
  

การทดสอบทางกลของชิ้นจมูกและเลนส ไดดําเนินการโดยใชอุปกรณทดสอบ  ติดตัง้อยูที ่
แผนกชางยนต   สถาบนัเทคโนโลยีราชมงคล   วทิยาเขตพระนครเหนอื และ  ภาควชิา
วิศวกรรมเครือ่งกล มหาวทิยาลยัเกษตรศาสตร วทิยาเขตบางเขน 
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  (ก) ชุดทดสอบการกระแทก   (ข) ลูกบอลโลหะ 
ภาพที ่22  ชุดทดสอบการกระแทก (ก)  และ ลูกบอลโลหะ (ข) 

 

(ก)       (ข)  
   

ภาพที ่23  (ก) รูปปนศีรษะจาํลองสําหรับทดสอบการกระแทก  (ข) เบารองศีรษะจําลอง 
5.   อุปกรณสําหรบัการวเิคราะหโดยใช CAD/CAE 

ทอรางพลาสตกิ 

โครงอลูมิเนยีม 
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1. เครื่องคอมพิวเตอรสวนบุคคลหนวยประมวลผลกลาง Pentium IV 2.0 GHz  
หนวยความจาํ DRAM PC 266 ขนาด 128 MB การดแสดงผลหนวยความจาํวีดีโอ 
64 MB, จอสีขนาด 17 นิ้ว 

2. เครื่อง Optical 3-D Scanner ยี่หอ gom รุน ATOS II ของบริษัท GOM ไดรับความ
อนุเคราะหจาก บริษทั เมนเทล จาํกัด  ต้ังอยู  เลขที่ 448  อาคาร พ.ี กะรัต   ชั้น 11  
ถ. รัชดาภิเษก หวยขวาง  กทม. 10320. 

3. เครื่องพิมพชนดิ Inkjet  
4. ซอฟตแวร CAD ชื่อ Pro/ENGINEER ของ บริษัท Parametric Technology 

Corporation (PTC), USA. 
5. ซอฟตแวร CAE ชื่อ MSC.NASTRAN for Windows ของ บริษทั MSC Software 

Corporation, USA. 
6. ซอฟตแวร MATLAB ของบริษัท Mathworks สําหรับประมวลผลทางสติถิและพล็อต 

กราฟเสน 
 
การดําเนินการการวิเคราะหนี้ใชสถานที่และอุปกรณของ   หนวยปฏิบัติการวิจัยการ

ออกแบบทางกลและผลิตภัณฑ (MPDRL)   อาคาร 6   หอง 6309    ภาควิชาวิศวกรรมเครื่องกล  
มหาวิทยาลยัเกษตรศาสตร     วทิยาเขตบางเขน    กรุงเทพฯ 
 

 
ภาพที ่24 เครื่อง Optical 3-D Scanner  
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วิธีการ 
1.   วธิีการพฒันากรรมวธิีการออกแบบ 
 การพัฒนากรรมวิธีการออกแบบแวนตาวายน้าํโดยใชซอฟตแวรคอมพิวเตอรชวยการ
ออกแบบ (CAD) ในการพัฒนารูปทรงเฉพาะแบบ หรือ ฟเจอร (feature) ตางๆ ของชิ้นสวนของ
แวนตาน้ํา  เพือ่ใหสะดวก รวดเร็วและงายตอการออกแบบ   การวิจัยนี้ ดําเนนิการออกแบบแวนตา
วายน้ําเปนโซลิตโมเดล โดยใชซอฟตแวร Pro/ENGINEER ในการออกแบบ  ข้ันตอนการพัฒนา
กรรมวิธีการออกแบบแวนตาวาย สามารถสรุปเปนแผนภูมิ ไดดังแสดงในภาพที ่25 
โดยมีรายละเอียดดังนี ้

ก.  การเกบ็ขอมูล  การเก็บขอมูลเปนการรวบรวมชิน้สวนของแวนตาวายน้าํรุนตางๆ ที่
ทางบริษัท Optec ไดเคยผลิตและที่กําลงัผลิตอยู 
ข.  การวิเคราะหชิน้สวน  การวิเคราะหชิน้สวนตางๆ ของแวนตาวายน้ํา  เปนการจดักลุม
แบงลักษณะรปูทรงของสวนตางๆ ของชิน้สวนของแวนตาวายน้าํ  แลวจําแนกเปนกลุม
ของรูปทรงเฉพาะแบบ 
ค.  การสรางฟเจอร  รูปทรงเฉพาะแบบหรือฟเจอร ของแตละกลุมตามที่ไดวิเคราะห  ได
นํามาใชสรางเปนโซลิตโมเดลของรูปทรงนัน้ๆ ที่สามารถแกไขขนาดได  รูปทรงเฉพาะแบบ
ที่รวบรวมและสรางมานี ้จัดรวมเปนหองสมุด (Library) เพื่อนาํมาใชกบัแวนตารุนตางๆ  
ไดภายหลัง  การสรางฟเจอรดําเนนิการโดยใช CAD 

 
 
 
 
 
 
 
 
 
 
 

ภาพที ่25   แผนภูมิแสดงขั้นตอนการพัฒนากรรมวิธีการออกแบบแวนตาวายน้ํา 

การวิเคราะหชิ้นสวน 

การเก็บขอมูล 

การสรางฟเจอร  (Feature) 

การประกอบ หรือ Assembly 

การดัดแปลง หรือ Modify 

Swimming Goggles 

CAD 

NEW DESIGN 
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ง.  การประกอบ  การประกอบเปนการนาํฟเจอรที่เปนเปนโซลิตโมเดล ที่ไดรวบรวมอยูใน 
Library มาประกอบรวมเปนเปนโซลิตโมเดลของแวนตาวายน้าํ  การประกอบฟเจอร
ดําเนนิการโดยใช CAD 
จ.  การดัดแปลง  การดัดแปลงเปนการแกไขขนาดซึ่งสามารถทาํไดโดยแกไขที่ ตัวฟเจอร 
แลวมาประกอบกัน หรือทาํการประกอบรวมกันแลว และทําการแกไขเพื่อใหไดเปนรูปทรง
ของแวนตาวายน้ําตามตองการ 

 
 ในรายงานวิจยันี้ ไดนําเสนอการพัฒนากรรมวิธีการออกแบบ เฉพาะชิ้นสวนของแวนตา
วายน้ําที่มีรูปทรงทีซ่ับซอน คือ ถวยตา  เนื่องจากถวยตาที ่นอกจากมรูีปทรงที่ซบัซอนแลว ยังมี
จาํนวนรูปแบบที่หลากหลาย 
 
2.   วิธีการทดสอบทางกลของแวนตาวายน้ํา 

การทดสอบทางกลของแวนตาวายน้าํ ประกอบดวย   การทดสอบแรงดึงของชิ้นจมกู  การ
ทดสอบการอดัของถวยตาของตัวถวยตา และ การทดสอบการกระแทกบนเลนสของถวยตา เพื่อ
ความปลอดภยั   ความแข็งแรงใหไดคุณภาพตรงตามความตองการของผูใช  ในงานวิจัยนี้ใช
วิธีการทดสอบของสถาบนั มาตรฐานสหราชอณาจักร (British Standard Institute หรือ BSI) 
มาตร-ฐาน BS5883:1996   ซึง่เปนมาตรฐานที่บริษทั Optech Co,Ltd.  ใชอางองิเปนมาตรฐาน
การผลิตแวนตาวายน้าํ   ชิ้นสวนของแวนตาวายน้ํา ซึง่ไดแก ชิ้นจมกูและเลนส จาํนวนไมนอยกวา 
2 รุน  ไดนํามาใชทดสอบทางกลตางๆ เพือ่นําผลทดสอบมาใชอางอิงและเปรียบเทยีบความคลาด
เคลื่อนที่ไดจากการวเิคราะหโดยใชซอฟตแวร  CAE  โดยวิธีการและเงือ่นไขการทดสอบทางกลมี
รายละเอียดดงัตอไปนี ้
 
2.1   วิธีการทดสอบการดึงของชิ้นจมูก 

การทดสอบนี้เปนการทดสอบความทนทานของชิ้นจมูกตอแรงดึง   ในงานวิจัยนี้ใชเครื่อง
ทดสอบการดึงและการกด (ภาพที่ 17)  โดยการนํา Fixture มายึดปลายของชิ้นจมูก   แลวนําไป
ติดตั้งที่หัวจับของเครื่องทดสอบแรงดึง ดังแสดงในภาพที่ 26   กําหนดเงื่อนไขการดึงและทําการดึง
ชิ้นจมูกของแวนตาวายน้ําโดยเริ่มแรงดึง จาก 0 นิวตัน แลวเพิ่มแรงขึ้นดวยการควบคุมระยะยืดดวย
อัตรา 5 มิลลิเมตรตอนาที จนชิ้นจมูกขาดหรือสูงสุดที่แรงดึง 60 N (หรือ 6 เทาของคามาตรฐาน 
BS5883:1996)   ขอมูลที่คอมพิวเตอรของเครื่องทดสอบบันทึก ไดแก คาความเคน ความเครียด 
และคาแรงดึงเทียบกับระยะยืดตัวของชิ้นจมูก 
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       (ก)                                                                 (ข)      
 

ภาพที ่26  ก) การติดตั้งอุปกรณเขากับอุปกรณจับยึด และ ข) การตดิตั้งอุปกรณ 
    จับยึดบนเครื่องทดสอบ 

 
2.2   วิธีการทดสอบการอัดของถวยตา 

การทดสอบแรงอัด เปนการทดสอบความคงทนของถวยตา ตอแรงอัดในแนวนอนและ 
แนวตั้ง   โดยมีลําดับการทดสอบดังตอไปนี้ 

1. นําถวยตาวางบนฐานรองถวยตาในแนวที่กําหนด ดังแสดงในภาพที่ 27 
2. นําถวยตาและฐานรองวางระหวางหัวกด ของเครื่องทดสอบการดึงและการกด (ภาพที่ 

28)   โดยใช แผนโลหะ (Steel plate) วางบนถวยตา   ปรับใหไดระดับ   แลวเลื่อนหัว
กดลงมาใหสัมผัสกับแผนโลหะ 

 

 
 

ภาพที ่27  การติดตั้งถวยตาลงบนฐานรองถวยตา 
 

Fixture 

หัวจับ 

ชิ้นจมกู 

ฐานรองถวยตา 
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ภาพที่ 28  ชิ้นงานและอุปกรณ ในการทดสอบการกด 
3. ปรับโหลดของเครื่องทดสอบ โดยเพิม่คาแรงอัดดวยการควบคุมระยะการเคลื่อนที่ดวย

อัตรา 5 มิลลิเมตรตอนาท ีไปจนถงึ 1000 N (หรือ 1.7 เทาของคาแรงอัดตาม
มาตรฐานทดสอบ BS5883:1996)  บันทกึคาแรงอัดและระยะยุบตัวของแผนโลหะ 
ทุกๆ 100 N 

4. ดําเนนิลําดับการทดสอบตาม 1 ถึง 3 ซ้ํา   โดยนาํถวยตาชิ้นใหมวางบนฐานรอง ดัง
แสดงในภาพที่ 28 

 
2.3   วิธีการทดสอบการกระแทกของเลนสถวยตา 

การทดสอบการกระแทกบนผิวเลนสของถวยตา  เปนการทดสอบความทนทานของสวนที่
เปนเลนสของชิ้นสวนถวยตา   อุปกรณที่ใชใหเกิดการกระแทกเปนลูกบอลโลหะ เสนผาศนูยกลาง 
22 มม. หนัก 44 กรัม   ลําดบัข้ันตอนการทดลอง มีดังตอไปนี้ 

1. สวมแวนตาวายน้ําเขากับศีรษะจําลอง   แลวนําศีรษะจําลองวางลงในเบารองรับ   
(ภาพที่ 29) 

 

 
 

ภาพที่ 29  การสวมแวนตาวายน้ําเขากับศีรษะจําลองเพื่อทดสอบการกระแทก 

หัวกด แผนโลหะ 
(Steel plate) 

เบารองศีรษะจําลอง 
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2. วางศีรษะจําลองลงบนเบารองศีรษะ   ปรับศีรษะจําลองใหผิวเลนสอยูในแนวนอน โดย 
ใหจุดกึ่งกลางของเลนสอยูใตแนวดิ่งของทอ guide ของชุดทดสอบการกระแทก (ภาพที่ 30) 

3. ปรับระดับความสูงของทอ   โดยใหปลายดานลางของทออยูสูงจากผิวเลนสของแวนตา 
วายน้ํา 5 เซนติเมตร (ตามมาตรฐาน BS5883:1996 กําหนดใหอยูในชวง 5 ซม. ±1 ซม.) 

4. ปลอยลูกบอลโลหะลงมาตามทอใหกระแทกกับผิวหนาของเลนสของแวนตาวายน้ําที ่
ความสูง 1.3 เมตร 
 

   
 

ภาพที่ 30   การวางเบารองศีรษะจําลองเขากับชุดทดสอบการกระแทก 
 

3.   วิธีการทดสอบคุณสมบัติของวัสดุ 
 การทดสอบเพือ่หาคุณสมบติั ทางกลของวัสดุ ที่ใชทําชิน้จมูก และถวยตา มีรายละเอียด
ดังตอไปนี้ 
 1.   นาํเม็ดพลาสติก PVC ไปอัดใหเปนแผนหนา 3 มม. ดวยความรอน 180  OC  

2. นําแผนพลาสติกตามขอ 1 ไปตัดใหไดขนาดตามมาตรฐาน ASTM D638 (ภาพที่ 12) 
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3. นําชิน้ทดสอบที่ไดไปดึงดวยเครื่องทดสอบการดึง (ภาพที่ 17) โดยกาํหนดความเร็วใน
การดึง 1 มิลลิเมตรตอนาท ี  เร่ิมตนจากแรงดึงเทากบัศูนยนิวตนั ไปจนชิ้นทดสอบ
ขาด   บันทึกผลที่ไดจากการทดสอบ เปนความสมัพนัธระหวางแรงดงึกับระยะยืดตวั 
และ ความเคนกับความเครยีด 

4. ทําตามขั้นตอนที ่3 จนครบจํานวน 5 ชิน้ทดสอบ 
5. นําผลการทดสอบที่ได ตามขอ 3 และ 4   มาคํานวณคาเฉลี่ยของกราฟ ความเคน - 

ความเครียด 
6. คํานวณคาโมดูลัสของความยืดหยุน (E) จากคาเฉลีย่ในขอ 5 

 
4.   วิธีการวิเคราะหโดยใช CAE   

งานวิจยันี้ใชโปรแกรม Pro/ENGINEER ในการสรางแบบโซลิตโมเดล เพื่อใชในการจําลอง
ทางคอมพวิเตอรของชิ้นจมูกของแวนตาวายน้ํา  โดยไดสรางแบบจําลองชิ้นจมูก  จาํนวน 2 รุน คือ 
รุน J-1 และ J-10  และ สรางแบบจําลองถวยตา  จาํนวน 3 รุน  คือ รุน  JR-1006, รุน 2006 และ
รุน 981  ตามขนาดของผลติภัณฑจริง  จากนัน้ทําการ Export model เปน ไฟลขอมูลชนิด STEP 
เพื่อนาํไปใชวิเคราะห ในโปรแกรม Nastran ตอไป 

การวิเคราะห CAE ใชซอฟตแวร ชื่อ MSC/NASTRAN for Windows เปนโปรแกรม
คอมพิวเตอรทางดาน FEA   สามารถนํามาใชในการวิเคราะหความแข็งแรงของชิ้นจมกูและถวยตา
ของแวนตาวายน้ํา   ภายใตสภาวะของแรงที่มากระทํา   ที่สอดคลองตามกระบวนการทดสอบจริง  
การวิเคราะหโดยวิธี  FEA  สามารถแบงเปน 3 กระบวนการใหญๆ ประกอบดวย Pre-Processing,  
Processing  และ Post Processing  โดยมีรายละเอยีดของขั้นตอนการปฏิบัติการดังภาพที่ 31[8]    
โดยเริ่มตนจาก 

ชวงการเตรียมการ (Pre-Processing) หรือชวงการใหขอมูลเพื่อการประมวลผล   เปนการ
สรางแบบจําลอง FEM (Finite Element Model)    โดยนําขอมูล CAD ของชิ้นจมกูหรือถวยตาของ
แวนตาวายน้ําที่สรางจากโปรแกรม Pro/ENGINEER มาสรางเปนโหนด (Node) เพือ่ใชสรางชิ้น
ประกอบ (Element) ที่เหมาะสม   แลวกําหนดลักษณะของชิ้นประกอบ พรอมกับการกําหนด
คุณสมบัติของวัสดุโดยวัสดุทีใ่ชคือ PVC และ PC  หลังจากนัน้กาํหนดเงื่อนไขขอบเขต (Boundary 
Condition)  และแรง (Load) ที่กระทํา ตอแบบจําลอง FEM  ใหตรงตามสภาวะการทดสอบจริงคือ 
Tensile Test, Compressive Test และ Impact Test  
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ชวงการประมวลผล (Processing) ใชคําสั่งการวิเคราะห FEA จากโปรแกรม 
MSC/NASTRAN for Windows เพื่อประมวลผลจากแบบจําลอง FEM โดยโปรแกรมจะสราง 
Stiffness Matrix ของแตละชิ้นประกอบ  รวบรวมจนกลายเปน Stiffness Matrix ของทั้ง
แบบจําลอง  แลวทําการคํานวณผลลพัธที่ได 

ชวงหลังการประมวลผล (Post processing) เปนการนําผลที่ไดแสดงเปนภาพกราฟฟก
ของการเปลี่ยนรูปทรง (Deformation)    คาระยะการเปลี่ยนตําแหนง (Transformation) และ
ความเคน (Stress) ที่เกิดขึ้นในแบบจําลอง  เปนระดับชั้นสี (Contour)   โดยรายละเอยีดของการ
ดําเนนิการวิเคราะหไดแสดงเปนแผนภูม ิในภาพที่ 32 [9] 

 
 

 
ภาพที ่31  ข้ันตอนการปฏิบัติงานการวเิคราะหโดยใช CAE 
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        ภาพที ่32   แผนผังขั้นตอนการใช  FEA  ในโปรแกรม  MSC/NASTRAN for Windows 

PREPROCESSING 

INPUT  DATA 
Control Data, Materials, Node and Element 

Definition, Boundary, Condition, Loads 

FORM ELEMENT [K] 
Read Element Data, Calculate Element 

Stiffness Metric [K] 

FORM STEM [K] 
Assemble Element [K]s to From the 

System Stiffness [K] 

Element File, Load File 

Element File 

APPLY DISPLACEMENT BOUNDARY CONDITIONS 

COMPUTE DISPLACEMENTS 
Solve the System Equations  

[K]{D}={F} 
For the Displacements 

{D}= [K]-1{F} 

Load File 

COMPUTE STRESSES 
Calculate Stresses and Output 
Files for Postprocessor Plotting  

 

POST PROCESSOR 

Displacement 
Stress File 
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ผลการวิจัยและทดลอง 

 
1.   ผลการพฒันากรรมวธีิการออกแบบแวนตาวายน้ํา 

ถวยตาของแวนตาวายน้ํา เปนชิ้นสวนทีมี่ความซับซอนในการออกแบบ  สําหรับแผน
ปะเก็นกันน้ํา ชิ้นจมูก ยางรัดศีรษะ และตวัหัวรัดสายยาง เปนชิ้นสวนที่มีรูปทรงไมยุงยากซับ-
ซอน  ผลการวิจัยน้ีจึงไดเนนกรรมวิธีการออกแบบถวยตา เพ่ือใหงายและสดวกตอการออกแบบ   
ผลการวิจัยการพัฒนากรรมวิธีการออกแบบ มีรายละเอียดดังตอไปน้ี 

 
1.1   ผลการวิเคราะหสวนประกอบของถวยตาแวนตาวายน้ํา 

สวนประกอบพื้นฐานของถวยตาแวนตาวายน้ําทุกรุน สามารถแยกไดเปน 6 สวน ดัง
แสดงในภาพที่ 33  แตละสวนประกอบเหลานี้ จัดเปนรูปทรงเฉพาะแบบ หรือ ฟเจอร ไดเปน 

1. สวนฐาน หรือ Base - เปนสวนฐานของถวยตา มีหนาที่เชื่อมใหแผนปะเก็น
กันนํ้ายึดติดกับตวัถวยตา 

2. กรอบลําตวั หรือ Frame - เปนลําตวัของถวยตา 
3. สวนเลนส (Lens) - เปนแผนเลนสเพ่ือการมอง เปนฟเจอรที่ไมซับซอน 
4. ตัวหู (Ear) - เปนสวนปลายของถวยตา สาํหรับเชื่อมตอกับยางรัดศรษีะ 

แวนตาวายน้าํบางรุนอาจเชื่อมตัวจมูกตดิกับถวยตา และบางรุนอาจแยก
ตางหากได 

5. ตัวจมูก (Nose) - เปนสวนปลายอีกดานของถวยตา สาํหรับใชตอชิน้จมูก
แวนตาวายน้าํบางรุนอาจเชื่อมตัวจมูกตดิกับกระบอกตา และบางรุนอาจ
ตางหากก็ได 

6. อ่ืน ๆ (ไดแก ตัวกึ่งกลาง หรือ Middle) 
 

ถวยตาแวนตาวายน้ําแตละรุน มีสวนประกอบรวมกันไดตั้งแต 2 ถึง 5 สวน  ตารางที่  
2 สรุปสวนประกอบตางๆ ของแวนตาแตละรุน  ตารางที่ 2 น้ี ยังไดแบงแบบของถวยตา ไดเปน 
3 แบบ ตามลกัษณะของรูปทรงของถวยตา (ภาพที่ 34)  รายละเอียดของแตละแบบมีดังน้ี 
 
 
 
 
 
 
 

ภาพที่ 33  แสดงสวนประกอบตางๆ ของถวยตาแวนตาวายน้ํา 

ตัวจมูก (Nose) 

กรอบลําตัว (Frame) 

สวนเลนส (Lens) 

ตัวหู (Ear) สวนฐาน (Base) 
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ตารางที่ 2  แสดงสวนประกอบตางๆ ของถวยตาแวนตาวายน้ําของแตละรุน 
 

แบบที ่ รุน Base Frame Lens Ear Nose อ่ืนๆ 

1 

89 BL 
89 DL 
89 mini 

903 
905 

981, 982 
1009 

ABB-1, ABB-2 
F-1 

LJ-002, LJ-003 
LJ-005 

- 
y 
- 
y 
y 
y 
y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
y 
y 
y 
y 
y 

- 
- 
- 
- 
y 
- 
- 
y 
- 
- 
- 

- 
y 
- 
y 
y 
y 
y 
y 
- 
y 
y 

- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 

2 

931, 933 
2006 

3017, 3018, 3020 
F-3G 

YA-4700 

y 
y 
y 
y 
y 

y 
y 
y 
y 
y 

y 
y 
y 
y 
y 

- 
- 
- 
- 
- 

- 
y 
y 
y 
y 

Middle 
Middle 
Middle 
Middle 
Middle 

3 

951 
2005 
2008 
3016 
3019 

JR-1005, JR-1006 
JR-1009 
NS-405 

y 
y 
y 
y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
y 
y 

- 
y 
y 
y 
y 
y 
y 
y 

- 
- 
- 
- 
- 
y 
- 
- 

y 
y 
y 
y 
y 
y 
y 
- 

Middle 
Middle, Subbase 

Middle 
- 

ที่คลอง-Joint 
- 
- 

Middle 
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ภาพที่ 34  การแบงแบบของรูปทรงของถวยตาไดเปนสามแบบ 
  

แบบที่ 1  ถวยตาชั้นเดียว (หรือ ถวยตาธรรมดา)  มีสวนประกอบ ประกอบดวยกรอบ
ลําตวัและแผนเลนส  โดยมีลําตวัเปนกรอบเปนเนื้อเดียวกัน มีผนังเรียบและหนา
สมํ่าเสมอ  เปนถวยตาที่มีรูปทรงแบบงาย ไมยุงยากซับซอน 
แบบที่ 2  ถวยตา 2 ชั้น  เปนถวยตาที่มีรูปทรงซับซอนมากกวาแบบที่ 1 โดยมีลําตัว
เปนกรอบหนาไมสมํ่าเสมอ เสมือนมีกรอบ 2 ชั้น  มีรองไวสําหรับใสแผนปะเก็นกนัน้ํา 
แบบที่ 3  ถวยตารูปทรงซับซอน  เปนถวยตาที่มีรูปทรงซับซอนสูง โดยเฉพาะที่กรอบ
ลําตวั ความหนาของลําตวัไมคงที่  อาจมีสวนประกอบอื่นเพ่ิม เชน มีครีบเสริมทีก่รอบ
ลําตวั เปนตน 

 
1.2   ผลการออกแบบฟเจอร 

รูปทรงเฉพาะแบบ หรือ ฟเจอร ตางๆ ตามสรุปในหัวขอ 1.1 (ผลการวิเคราะหสวน 
ประกอบของถวยตา) ไดนํามาสรางเปน โซลิตโมเดล  โดยมีรายละเอียดของลําดับการสราง 
(ภาพที่ 35) ดังตอไปน้ี 
 Datum Curve เปน entity ของเสนโคงตาง ๆ เชน Arc, Conic และ Spline โดย 

Arc คือ สวนโคงของวงกลม ใชสราง สวนฐาน กรอบลําตัว และเลนส ภาพที่ 36 
แสดงการกําหนดขนาดตางๆ ของ Arc.  
 
 
 
 
 
 
 
 
 
 

ภาพที่ 35   ลําดับการสรางโซลิตโมเดลของรูปทรงเฉพาะแบบของถวยตา 

  แบบที่ 1  ถวยตาชั้นเดียว               แบบที่ 2  ถวยตา 2 ชั้น            แบบที่ 3  ถวยตารูปทรงซับซอน 

Surface 

Extrude  

Boundary 

Trim 

Merge 

Datum Curve 

Arc 

Conic 

Spline 

Solid 

Extrude  

Use Quilt 

Blend 

Round 
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ภาพที่ 36  แสดงการกําหนดขนาดตางๆ ของ Arc 
 

Conic คือ เสนโคงรูป Cone สามารถนํามาใชสรางเปนรูปวงรี ไดโดยใชเสน 
โคง Conic น้ี 4 เสน มาเชื่อตอกันดังแสดงในภาพที่ 37  โดยมีขนาดตางๆ ที่
ตองกําหนดตามแสดง  ใชสราง สวนฐาน กรอบลําตวั เลนส และ ตวัหู 
Spline คือ เสนงอโคงอิสระ กําหนดโดยจุดหลายจุดที่เสน Spline ลากผาน และ
มุม หรือ Tangency ที่ปลายทั้ง 2 ของเสน ดังแสดงในภาพที่ 38  ใชสราง สวน
ฐาน กรอบลําตัว และ ตัวหู 

Surface เปนรูปทรงเฉพาะแบบ แบบพ้ืนผิวไมมีความหนา ใชสําหรับการกําหนดเปน
ผิวของโซลติโมเดล  สรางไดจาก datum curve  วธิีการสราง Surface ประกอบดวย 
การ Extrude, Boundary, Trim และ Merge โดย  

Extrude คือ การอัดรีดในแนวเสนตรงความยาวคงที่ ในแนวตั้งฉากกับระนาบที่
ใชวาด datum curve ใหเปนแผนพ้ืนผิว ดังแสดงเปนตวัอยางในภาพที่ 39ก 
Boundary คือ การสรางพื้นผิวโดยใช datum curve เปนตัวกําหนดขอบเขต
ของพื้นผิว  พ้ืนผิวที่ไดอยูภายใน หรืออยูระหวาง datum curve  ภาพที่ 39ข 
แสดงตัวอยางพื้นผิวที่สรางโดย การใช Boundary 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 37  แสดงการสรางวงรีดวย Conic  
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Trim คือ การตัด surface ใหมีขอบเขตตามตองการ  โดยใช datum curve หรือ 
surface เปนตัวกําหนด  ภาพที่ 40ก แสดงการ trim พ้ืนผิวของภาพที่ 40ก 
โดย ใช datum curve ที่วาดเปนสวนฐานของถวยตา 
Merge คือ การรวมหลาย surface ใหเปนผิวเดียวกัน  (ภาพที่ 40ข) 

Solid เปนรูปทรงเฉพาะแบบ แบบวตัถตุนั หรือ โซลิตโมเดล  สามารถสรางไดโดยใช
การ Extrude, Use Quilt, Blend  และ Round. โดย 

Extrude คือ การอัดรีดพื้นที่ปด ในแนวเสนตรงความยาวคงที่ ในแนวตั้งฉาก
กับระนาบที่ใชวาดพื้นที่ปด ไดเปนวตัถุ 3 มิติ  
Use Quilt คือ การสรางวัตถุ 3 มิติ จาก พ้ืนผิว 
Blend คือ การดันรีดผานพื้นที่ปด 2 หรือมากกวาพื้นทีป่ด ไดเปนวตัถุ 3 มิต ิ
Round คือ การลบขอบและมุม ใหเปนโคงมล  

 
 

ภาพที่ 39  การสราง Surface ดวยการ Extrude (ภาพ ก)  และโดยการให Boundary (ภาพ ข) 

ก)        ข)   

ภาพที่ 38  แสดงการสรางเสน Spline 
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จากลําดับการสรางโซลิตโมเดลของรูปทรงเฉพาะแบบของถวยตา สามารถสรางและ
รวบรวมสวนประกอบของถวยตา  โดยตารางที่ 3 แสดงผลการสรางและรวบรวมสวนประกอบ
ของสวนฐานของถวยตาแวนตาวายน้ําทกุรูปแบบ  ตารางที่ 4 ของกรอบลําตวั  ตารางที่ 5 
ของเลนส  ตารางที่ 6 ของชิ้นหู ตารางที่ 7 ของชิ้นจมูก  และ ตารางที่ 8 ของรูปทรงตวั
กึ่งกลาง 
 

      ตารางที่ 3  ผลการสรางและรวบรวมสวนประกอบของสวนฐาน 
 

กลุม รุน รูปทรงเฉพาะแบบของสวนฐาน 

B1 
89 DL  
LJ-005 

 
 
 

 

B2 

903, 931, 933 
1009 
F-3G 

JR-1009 
LJ-003 
NS-405 
YA-4700 

 

 

ภาพที่ 40  การสราง Surface ดวยการ Trim (ภาพ ก)  และโดยการ Merge (ภาพ ข) 

ก)        ข)   
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     ตารางที่ 3  ผลการสรางและรวบรวมสวนประกอบของสวนฐาน (ตอ) 

 
กลุม รุน รูปทรงเฉพาะแบบของสวนฐาน 

B3 

905 
2005, 2006, 2008 

3016, 3018 
3019, 3020 

JR-1005, JR-1006 

 
 
 
 

 

B4 
ABB-1 
ABB-2 

 
 
 

 

B5 
951 
F-1 

 
 
 
 

B6 
 

981 
 

 
 
 
 

B7 982 

 
 
 

 

B8 3017 

 
 
 

 

B9 LJ-002 

 
 
 

 

B10 89 BL 
89 mini 

ไมมี สวนฐาน 
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ตารางที่ 4  ผลการสรางและรวบรวมสวนประกอบของกรอบลําตวั 

 
กลุม รุน รูปทรงเฉพาะแบบของกรอบลําตวั 

F1 
ABB-1 
ABB-2 

 
 
 

 

F2 

2006 
3017 
3018 
3020 

 
 
 

 

F3 

905 
981, 982 

JR-1005, JR-1006 
LJ-002 

 
 
 
 

 

F4 
3016 
3019 

 
 
 

 

F5 
1009 

JR-1009 

 
 
 

 

F6 

89 BL 
89 mini 

931 
933 

YA-4700 

 
 
 
 

 

F7 903 
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ตารางที่ 4  ผลการสรางและรวบรวมสวนประกอบของกรอบลําตวั (ตอ) 

 
กลุม รุน รูปทรงเฉพาะแบบของกรอบลําตวั 

F8 F-1 

 
 
 

 

F9 2005 
เปนรูปทรงเฉพาะแบบมลีักษณะซับซอนคือ สวน 
ลําตวัเปนลักษณะกึ่งสองชัน้เชื่อมติดกับ ชิ้นหู ซ่ึง
เรียงออกมาหลายชั้นหลายระดับ 

F10 NS-405 

เปนรูปทรงเฉพาะแบบ มีลกัษณะวงรีโคงเรียวยาว
แหลมดานหนึ่ง ตอนปลายมลีักษณะเปนสอง ชั้น 
และมีชิ้นสวนเชื่อมระหวางชัน้ทั้งสอง อีกปลายมี 
ชิ้นจมูก โคงประสานเปนสวนเดียวกัน 

F11 LJ-003 

 
 
 

 

F12 LJ-005 

 
 
 

 

F13 951 
สวนลําตวัเชื่อมกับเลนสและช้ินหูโดยเลนส เปน
รูปหยดน้ํา ชิ้นหูเปนสี่เหลีย่มคางหมูอีกชั้นยื่น
ออกจากสวนลําตวั 

F14 89 DL 

 
 
 

 

F15 2008 
เปนรูปทรงเฉพาะแบบมลีักษณะเชื่อมสวน ลําตวั 
และชิ้นหู เขาไวดวยกนั โดยสวนชิน้หูจะยื่นเรียว
ออกมาเปนลักษณะสองชั้น 

F16 F-3G เปนรูปทรงของลําตวัแบบธรรมดาและมีเน้ือ
บางสวนตัดหายไปเพื่อทําเปนชิ้นหู 
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ตารางที่ 5  ผลการสรางและรวบรวมสวนประกอบของเลนส 
 

กลุม รุน ลักษณะรูปทรง ภาพแสดง 

L1 903 
LJ-002 

วงกลม 
 
 
 

L2 
F-1 

2005 
NS-405 

วงรีนูน 
 

L3 

89 mini, 89 BL  
905, 931, 933 
981, 982, 1009 

2006, 2008 
3016, 3017, 3018 

3019, 3020 
F-3G 

JR-1005, JR-1006 
JR-1009 
YA-4700 

วงรีแบน 

 

L4 
ABB-1 
ABB-2 
LJ-003 

วงรีแบน 
ปลายดานหนึง่ตัด 

 

L5 LJ-005 
ดานหนึ่งวงกลม ดาน
หน่ึงสี่เหลี่ยมคางหมู 

 
 
 

L6 89 DL วงรีแบน 
ปลายตัดทั้งสองขาง 

 
 
 

L7 951 ไมมี Lens - 
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ตารางที่ 6  ผลการสรางและรวบรวมสวนประกอบของชิ้นหู  
 

กลุม รุน รูปทรงเฉพาะแบบของชิน้หู  

N1 
ABB-1 
ABB-2 

 
 

 
 

N2 JR-1005 
JR-1006 

 
 
 
 
 

N3 905 

 
 
 

 

N4 

89 BL, 89 DL, 89 mini 
903, 981, 982 
931, 933, 951 

1009 
2006, 2005, 2008 
3016, 3017, 3018 

3019, 3020 
F-1 

F-3G 
JR-1009 

LJ-002, LJ-003, LJ-005 
NS-405 
YA-4700 

ไมมี 

 
 
 



47 
 

ตารางที่ 7  ผลการสรางและรวบรวมสวนประกอบของชิ้นจมูก  
 

กลุม รุน รูปทรงเฉพาะแบบของชิน้จมูก 

E1 
LJ-002 
LJ-005 

 
 
 

 

E2 

981, 982 
1009 
3016 

JR-1005, JR-1006 
JR-1009 

 
 
 
 

 

E3 
2006, 2008 
3017, 3018 

3020 

 
 
 

 

E4 2005 
F-3G 

ลักษณะเรียวรับกับลําตวั เอียงเปนมุม 45 องศา  
ปลายมีขนาดเล็กลงและหักเปนมุมฉาก  ดานบน

บริเวณชิ้นหูเปนรู 

E5 
ABB-1 
ABB-2 

 
 
 
 

 
 

E6 903 
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      ตารางที่ 7  ผลการสรางและรวบรวมสวนประกอบของชิ้นจมูก (ตอ) 

 
กลุม รุน รูปทรงเฉพาะแบบของชิน้จมูก 

E7 905 

 
 
 
 

 

E8 951 

 
 
 
 

 

E9 3019 

 
 
 
 

 

E10 89 DL 

 
 
 

 
 

E11 LJ-003 

 
 
 
 

 

E12 

89 BL, 89 mini 
931, 933 
YA-4700 

F-1 
NS-405 

ไมมี  
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ตารางที่ 8  ผลการสรางและรวบรวมสวนประกอบของตัวกึ่งกลาง (Middle) 

 
กลุม รุน รูปทรงรูปทรงเฉพาะแบบของ 

M1 
931, 933 
YA-4700 
NS-405 

 
 
 
 
 

 

M2 
2005, 2006, 2008 
3017, 3018, 3020 

F-3G 

 
 
 
 
 
 

M3 951 

 
 
 
 
 
 

M4 

89BL, 89DL, 89mini 
903, 905, 981, 982 

1009 
ABB-1, ABB-2 

F-1 
LJ-002, LJ-003 

LJ-005 
3016, 3019 
JR-1005 

JR-1006, JR-1009 

ไมมี 
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1.3   ผลการออกแบบถวยตาแวนตาวายน้ํา 

สวนประกอบของถวยตา ไดออกแบบเปนโซลิตโมเดล เก็บอยูในรูปของ ไฟลชิ้นสวน 
(Part File) ไฟลชิ้นสวนเหลานี ้สามารถนํามาประกอบรวมกันเปนถวยตาแวนตาวายน้ํา ของรุน
ที่มีอยูในปจจุบันได  การประกอบสวยตาง ๆ รวมกันเปนถวยตาไดทําใน โหมดการประกอบ 
(Assembly) ของซอฟทแวรโซลิตโมเดลที่ใช  เน่ืองจากไฟลชิ้นสวนเหลานี ้เปนพาราเมตริก 
(Parametric) จึงทําใหสามารถดัดแปลงแกไขใหเหมาะสมกับการออกแบบแวนตาวายน้ํารุนใหม 
ๆ ใหไดขนาดและสัดสวนตามตองการได  ตารางที่ 9 แสดงความสมัพันธของกรอบลําตวักับ
สวนประกอบอื่น (สวนฐาน กรอบลําตวั เลนส ฯลฯ) ของถวยตารุนตาง ๆ ที่มีรูปทรงใกลเคียง
กันที่สามารถนํามาประยุกตใชดวยกันได  เน่ืองจากสวนประกอบของถวยตา สรางขึ้นโดยอาศัย
ขนาดการวัดขนาดจากชิ้นงานจริงดวย Vernier (ภาพที่ 14) และเครื่องมือวัดพื้นฐาน  ดังน้ัน 
ขนาดตาง ๆ ของชิ้นสวนทีมี่ความซับซอนจึงมีความคลาดเคลื่อนจากการวัดและการประมาณ
ดวยสายตา  นอกจากนี้ ขนาดของชิ้นสวนตาง ๆ ของแวนตาวายน้าํมีขนาดเล็ก (นอยกวา 10 
มม ของชิ้นจมูก และไมเกนิ 60 มม ของความยาวของถวยตา)  ดังน้ัน ความคลาดเคลื่อนของ
ขนาดของ ไฟลชิ้นสวนของสวนประกอบของถวยตาตามสรุปในตารางที่ 9 อยูในชวง 1% ถึง 
10% 
 
1.3.1   ผลการประกอบเปนถวยตา 
 สวนประกอบของถวยตา (หรือ ฟเจอรของถวยตา) ที่เปน ไฟลชิ้นสวน ตางๆ จาก     
ตารางที่ 9 ไดนํามาประกอบเปนถวยตารุนตางๆ ได   ภาพที่ 41 เปนตัวอยางของผลการใช 
ฟเจอรมาชวยในการออกแบบถวยตาวายน้ํารุน 982   ในการประกอบถวยตารุน 982 น้ี เริ่มจาก
กรอบลําตวัเปนฟเจอรเริ่มตน แลวนําฟเจอรที่เหลือ ซ่ึงไดแก สวนฐาน เลนส และชิ้นจมูก มา
ประกอบเขากับกรอบลําตวั ลําดับการประกอบของทั้ง 3 ฟเจอรเหลานี้ สามารถใชฟเจอรใด
กอนหลังได  ลําดับการประกอบสุดทายไดแกการนํา ชิ้นหูไปประกอบติดกับสวนฐาน (หรือ 
EDGE) 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 41  ผลการใช ฟเจอร มาชวยในการออกแบบถวยตาวายน้าํรุน 982 
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ตารางที่ 9  ความสัมพันธของกรอบลําตวักับสวนประกอบอ่ืน 
 

กลุมกรอบลําตัว (Frame) 
 F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12 F13 F14 F15 F16 

กลุม 
ฐาน 
Base 

B1 
B2 
B3 
B4 
B5 
B6 
B7 
B8 
B9 
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- 
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y 
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- 
- 
y 
y 
- 
y 

- 
y 
- 
y 
y 
- 
- 
- 
- 

- 
y 
- 
y 
y 
- 
- 
- 
- 

- 
y 
- 
y 
y 
- 
- 
- 
- 

- 
y 
- 
y 
y 
- 
- 
- 
- 

- 
- 
y 
- 
- 
y 
y 
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y 

- 
y 
- 
y 
y 
- 
- 
- 
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- 
y 
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y 
y 
- 
- 
- 
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- 
- 
y 
- 
- 
y 
y 
- 
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- 
- 
- 
- 
y 
- 
- 
- 
- 

y 
y 
- 
y 
y 
- 
- 
- 
- 

y 
- 
y 
- 
- 
y 
y 
- 
y 

y 
- 
y 
- 
- 
y 
y 
- 
y  

กลุม 
เลนส 
Lens 

L1 
L2 
L3 
L4 
L5 
L6 

- 
- 
- 
y 
- 
- 

- 
y 
y 
- 
- 
- 

y 
y 
y 
- 
- 
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- 
- 

y 
y 
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y 
- 
- 
- 

- 
- 
- 
y 
y 
- 

- 
- 
- 
- 
- 
- 

- 
- 
- 
- 
- 
y 

- 
y 
y 
- 
- 
- 

- 
y 
y 
- 
- 
- 

กลุม 
ตัว
จมูก 

 Nose 

N1 
N2 
N3 
N4 
N5 
N6 
N7 
N8 
N9 
N10 
N11 
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y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
- 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
y 
y 
y 
y 
y 

- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 

y 
y 
y 
y 
y 
y 
- 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
- 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
- 
y 
y 
y 
y 

- 
- 
- 
- 
- 
- 
- 
- 
- 
- 
- 

y 
y 
y 
y 
y 
y 
y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
- 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
y 
y 
y 
y 
y 

y 
y 
y 
y 
y 
y 
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y 
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กลุม 
Ear 

E1 
E2 
E3 

y 
- 
- 

- 
y 
- 

- 
y 
y 

- 
- 
- 

- 
- 
- 

- 
- 
- 

- 
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y 
- 
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- 
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สําหรับการอางอิงการประกอบรวมกันเปนถวยตาที่สมบูรณ สามารถใช datum plane 

ตางๆ ที่ไดกําหนดไวใหแลวในแตละไฟลชิ้นสวนของสวนประกอบของถวย  ซ่ึงจะชวยใหการ
ประกอบทําไดงาย สะดวกและรวดเร็วยิง่ขึ้น   คําสั่งที่ใชในการประกอบ ไดแก คําสั่ง mate, 
align, mate offset และ align offset. 

 
1.3.2   ตัวอยางของการออกแบบถวยตารุนใหม 

การประยุกตใชชิ้นสวนตางๆ ของแวนตาวายน้ําตางรุนกัน มาประกอบเขาดวยกัน แลว
ทําการปรับแตงใหไดขนาดที่เหมาะสมพอดีกัน  หลักการสรางโมเดลใหม เริ่มจากการประกอบ
ชิ้นสวนของกรอบลําตวัและสวนฐานกอน  ทําการปรับความโคงและรปูทรงใหเขากันไดพอดีกัน  
แลวนําชิ้นสวนที่เหลือมาประกอบเขาดวยกัน โดยใชตารางที่ 9 (ความสัมพันธของกรอบลําตวั
กับสวนประกอบอ่ืน) เปนตารางชวยในการเลือกชิ้นสวนที่จะมาประกอบเขาดวยกันได   ชิ้นสวน
ทุกชิ้นสามารถปรับขนาดความโคงและรปูทรงใหมใหเขากับชิ้นสวนตางๆ กันได    

ตัวอยางผลการออกแบบถวยแวนตารุนใหม ไดแสดงในภาพที่ 42 ของถวยแวนตารุน 
New Model 01 ซ่ึงออกแบบโดยใชชิ้นสวนของแวนตารุนตางๆ  โดยมี กรอบลําตวั เลนส และ
ชิ้นหูจากรุน 3019  สวนฐานจากรุน 89 DL และชิ้นจมูกจากรุน LJ-002 

ภาพที่ 43 แสดงผลการออกแบบถวยแวนตารุน New Model 02 ซ่ึงออกแบบโดยใช
ชิ้นสวนของกรอบลําตวัและเลนสจากรุน 3019  สวนฐานจากรุน LJ-002 และชิน้จมูกจากรุน 
ABB-1 

ภาพที่ 44 แสดงผลการออกแบบถวยแวนตารุน New Model 03 ทื่ออกแบบโดยใช
ชิ้นสวนฐานของรุนและเลนสจากรุน 2006  ใชตวักึ่งกลาง (Middle) ของรุน YA-4700 เปนกรอบ
ลําตวั และชิ้นจมูกจากรุน ABB-1 

ภาพที่ 45 แสดงผลการออกแบบถวยแวนตารุน New Model 04 ซ่ึงออกแบบโดยใช
ชิ้นสวนของกรอบลําตวั ฐาน ตัวกึ่งกลาง และชิ้นหูจากรุน JR-1006  เลนสจากรุน F-1 และชิ้น
จมูกจากรุน JR-1005 

 
 
 

 
 
 
 
 
 
 

Nose LJ-002 

Len 3019 

Base 89 DL 

Ear 3019 Body 3019 

ภาพที่ 42  ผลการออกแบบถวยตารุนใหม รุน New Model 01 
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Len 2006 Nose ABB-1 

Base 2006 
Middle YA-4700 

ภาพที่ 44  ผลการออกแบบถวยตารุนใหม รุน New Model 03 

ภาพที่ 45  ผลการออกแบบถวยตารุนใหม รุน New Model 04 

Nose JR-1005 

Body JR-1006 

Ear JR-1006 

Middle JR-1006 
Base JR-1006 

Len F-1 

ภาพที่ 43  ผลการออกแบบถวยตารุนใหม รุน New Model 02 

Base LJ-002 

Len 3019 

Body 3019 

Nose ABB-1 
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2. ผลการทดสอบทางกลตามมาตรฐานการทดสอบแวนตาวายน้ํา 
2.1  ผลการทดสอบทางกลของการดึงชิ้นจมกู 
 เนื่องดวยการทดสอบการดงึของชิน้จมูกตามมาตรฐาน BS5883:1996 กําหนดใหใช
แรงทดสอบทีค่าเทากับ 10 N±0.5 N เทานั้น   จึงไมเหมาะสมในการนําผลทดสอบจากการดึงที่ได 
มาเปรียบเทียบความแมนยาํของ FEA   ในการวิจัยนี้ จงึไดทดสอบทีแ่รงดึงตั้งแต 5 N ถึง 60 N 
แลวบันทึกคาแรงดึงและระยะยืดของชิน้จมูกทกุๆ 5 N  รูปแบบของชิน้จมูกที่ไดทดสอบมี 2 รุน คือ 
รุน J-1 และ J-10 จํานวนการทดสอบรุนละ 5 ชิน้ 
 ภาพที ่46 และ 47 แสดงเสนกราฟของคาเฉลี่ย  คาความเบี่ยงเบนมาตรฐาน (Standard 
Deviation หรือ SD เปนตัวเลขระบุใตเสนกราฟ) คาสูงสดุและคาต่ําสุดจากการทดสอบ จํานวน 5 
คร้ัง (1 ชิ้นตอ 1 การทดสอบ) ของระยะยืด หรือ Displacement (แสดงคาในแกนตัง้) และแรงดึง 
หรือ Force (แสดงคาตามแกนนอน) ของชิ้นจมกูรุน J-1 (ภาพที ่46) และ J-10 (ภาพที ่47)   คา 
Offset ที่แรงดงึต่ําเปนผลจากความเสียดทานของกลไกและอุปกรณวัดระยะของชุดทดสอบ 
 ผลการทดสอบจากภาพที ่46 และ 47 แสดงความสมัพนัธของระยะยดืและแรงดึงเปน
ความสัมพันธแบบเชิงเสนในชวงแรงดึงทดสอบจาก 5 N ถึง 60 N  โดยมีคาความเบี่ยงเบนนอย
ของระยะยืดทีแ่รงดึงต่ํา และเพิ่มข้ึนเมื่อแรงดึงเพิ่ม  ที่แรงดึงทดสอบสงูสุด (60 N) ไมพบการฉีก
ขาดของชิ้นจมูกทัง้ 10 ชิ้น   ชิ้นจมูกรุน J1 จะเริ่มขาดทีแ่รงดึงเฉลี่ย 75 N และ รุน J10 ที่ 72 N 

 
ภาพที ่46   ระยะยืดจากการทดสอบทางกลของการดึงของชิ้นจมูกรุน J-1 
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ภาพที ่47   ระยะยืดจากการทดสอบทางกลของการดึงของชิ้นจมูกรุน J-10 
 

 2.2   ผลการทดสอบทางกลของการอัดถวยตา 
ในการทดสอบการอัดของถวยตาเพื่อตรวจสอบความเสยีหายตามมาตรฐาน BS5883: -

1996 กําหนดใหใชแรงอัดทดสอบที่คาเทากับ 588 N ± 2 N  เพียงคาเดียว  จึงไมเหมาะสมในการ
นําผลมาเปรียบเทียบกับผลของ FEA ได   การทดสอบนีจ้ึงใชแรงอัดตั้งแต 0 N ถึง 1000 N แลว
บันทกึคาระยะยุบตัว (Displacement) และแรงอัด (Compressive Force) โดยเริ่มบันทกึที ่200 N 
และเพิ่มข้ึนทกุๆ 100 N 
 ภาพที ่48 ถึง 50 แสดงกราฟของระยะยุบตัวและแรงอัด  ของถวยตาของแวนตาวายน้ํารุน 
JR-1006, 2006 และ 981 ตามลําดับ   จาํนวนถวยตาที่ใชทดสอบของแตละรุน คือ 5 ชิ้นทดสอบ  
จากผลการทดลองพบวาถวยตาทัง้ 15 ชิ้น ไมเกิดการแตกหักที่แรงอัดทดสอบสูงสุดที่ 1000 N  
โดยความสมัพันธของระยะยุบตัวและแรงอัดจากผลการทดสอบนี ้ ไดผลเปนแบบเชงิเสนในชวง
แรงอัดทดสอบจาก 200 N ถึง 1000 N ของแวนตาทัง้ 3 รุน   ในการทดสอบนี้ไดทาํการ Pre-load 
โดยใหถวยตาแนบสนทิกับฐานรองถวยตากอนบนัทกึคาของระยะยุบตัวจึงเปนผลใหคา Offset 
ของผลการทดสอบต่ํา 
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ภาพที ่48   ระยะยุบตัวของถวยตารุน JR-1006 จากการทดสอบทางกลของการอัด 
 

 
ภาพที ่49   ระยะยุบตัวของถวยตารุน 2006 จากการทดสอบทางกลของการอัด 

588 N 

588 N 
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ภาพที ่50   ระยะยุบตัวของถวยตารุน 981 จากการทดสอบทางกลของการอัด 

 
2.3   ผลการทดสอบทางกลของการกระแทกเลนสถวยตา 

การทดสอบทางกลของการกระแทกบนผวิเลนสถวยตา  ไดทาํตามมาตรฐาน BS5883: -
1996  โดยทําการทดสอบจาก  ถวยตาของแวนตาวายน้าํ รุน JR-1006, รุน 2006 และ รุน 981 
จํานวนรุนละ 5 ชิ้น   ผลการทดสอบนี ้ไมปรากฏความเสียหาย (แตกหรือรอยราว) หรือเกิดการบบุ
ยุบบนผวิเลนส ที่ความสงูของการปลอยลกูบอลโลหะตกที่  0.7, 1, 1.3  และ 1.6 เมตร (มาตรฐาน 
BS5883:1996 กําหนดความสูงที ่1.3 เมตร) 
 
3.   ผลการทดสอบคุณสมบัติของวสัดุ 

การทดสอบเพือ่หาคุณสมบติัของวัสดุ  ใชการทดสอบแบบการดึง (Tensile Test) เพือ่หา
ความสัมพันธของ ความเคนและความเครียด (Stress – Strain diagram หรือ σ - ε diagram) 
ผลการทดสอบนี้ไดแสดงในภาพที ่51 และ 52   โดยภาพที ่51 เปนผลการทดสอบของ PVC  ซึ่ง
เปนวัสดุที่ใชทาํชิ้นจมูก รุน J-1 และ J-10   และภาพที่ 52 เปนผลการทดสอบของ PC ซึ่งเปนวัสดุ
ที่ใชทาํ ถวยตา รุน JR-1006, รุน 2006 และรุน 981 
 ตารางที่ 10 สรุปสมการของความสัมพันธของความเคน (σ) และความเครียด (ε) ของ
กราฟของคาเฉลี่ยในภาพที ่51 และ 52 ทีช่วงคาความเครียด 0 ถึง 0.2, 0 ถงึ 0.5 และ 0 ถงึ 1 

588 N 
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สําหรับ PVC และชวง 0 ถงึ 0.02, 0 ถึง 0.05 และ 0 ถึง 0.1 สําหรับ PC  สมการในตารางที่ 10 ทัง้
สมการเสนตรง (Linear) และสมการ Quadratic คํานวณโดยใชวิธี Least-Square 
 

 
ภาพที ่51   ไดอะแกรมความสัมพันธ ระหวาง σ - ε ของ PVC 

 
ภาพที ่52   ไดอะแกรมความสัมพันธ ระหวาง σ - ε ของ PC 

8.3 

1.07 

53 

0.103 
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ตารางที่ 10  ความสัมพันธของ σ - ε จากการทดสอบคุณสมบัติทางกลของ PVC และ PC 

 
PVC PC 

ε Linear Quadratic ε Linear Quadratic 
0 –0.2 σ=15.256ε σ= -5.709ε2+16.398ε 0-0.02 σ=1019.4ε σ=-24124ε2+1501.9ε 
0 – 0.5 σ=12.205ε σ= -10.002ε2+17.21ε 0-0.05 σ=744.26ε σ=-7503.6ε2+1119.4ε 
0 - 1 σ=8.0422ε σ=-7.95ε2+15.992ε 0-0.1 σ=494.56ε σ=-4692.2ε2+963.78ε 

 
4.   ผลการวเิคราะห FEA ของการทดสอบแรงดึงชิน้จมูก 
4.1   ผลการสรางแบบจําลอง FEM ของชิ้นจมูก 

ผลการสรางแบบจําลองโซลติโมเดล โดยใช Pro/ENGINEER ของชิ้นจมูกของแวนตาวาย
น้ํารุน J-1 และ J-10 ไดแสดงเปรียบเทยีบกับชิ้นงานจริงในภาพที ่53 และ 54 ตามลําดับ   โซลิต
โมเดลที่ไดเหลานี้ไดนาํไปใชสรางเปนแบบจําลองทางไฟไนตเอลิเมนต หรือ Finite Element 
Model (FEM)  เพื่อใชในการวิเคราะห FEA ตอไป  ภาพวาดรายละเอยีดของขนาดของชิ้นจมูกทั้ง
สองไดแสดงในภาพผนวกที ่2 และ 3 
 เนื่องดวยรูปทรงของตัวชิน้จมูกมีความซับซอนมาก  ไมสามารถใชชิน้ประกอบ หรือ        
เอลิเมนต (Element) แบบผนังบาง ได   เอลิเมนตที่ใชจงึกําหนดเปนรูปทรงโซลิต 3 มิติ แบบ 
Tetrahedral  ซึ่งกําหนดไดในโปรแกรม MSC/NASTRAN for Windows   ดังแสดงในภาพที่ 55ก 
และ 55ข  ตามลําดับ   โดย รุน J-1 ประกอบดวย 13,915 โหนด (Node) และ 7,630 ชิ้นประกอบ 
และ รุน J-10 ประกอบดวย 7,045 โหนด และ 3,851 ชิ้นประกอบ ภาพที ่56 และ 57 แสดง การ
กําหนดเงื่อนไขขอบเขต และทิศทางของแรงดึง หรือโหลด ของชิ้นจมูก รุน J-1 และ J-10 
ตามลําดับ   คุณสมบัติของวสัดุใชคุณสมบัติของ PVC ตามผลทดสอบในตารางที ่10 โดยใชคา E 
ที่ไดโดยการเฉลี่ยคา E จากสมการเสนตรงของชวง ε ระหวาง 0 ถึง 0.2 และ 0 และ 0.5 โดยใหคา
เทากับ 13.7 N/mm2  ข้ันตอนการวิเคราะห CAE ของชิ้นจมกูไดสรุปไวในภาคผนวกที ่4 
 
4.2   ผล FEA ของการยดืตัวของชิ้นจมูก 
 ตัวอยางผลการวิเคราะห FEA ของการยืดตัวของชิ้นจมกู ภายใตการทดสอบการดงึ ที่แรง
ดึง 10 N ไดแสดงในภาพที ่58 และ 59   โดยในภาพที่ 58 แสดงลักษณะการยืดตัวของชิ้นจมกูเปน
ระดับชั้นสีของระยะยืด ของชิ้นจมกูรุน J-1 และภาพที ่59 ของชิน้จมกูรุน J-10  
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  (ก) ชิ้นงานจรงิ    (ข) โซลิตโมเดล 

ภาพที ่53   ชิ้นงานจรงิ (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของชิ้นจมกูรุน J-1 
 

 
(ก) ชิ้นงานจรงิ    (ข) โซลิตโมเดล 

ภาพที ่54   ชิ้นงานจรงิ (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของชิ้นจมกูรุน J-10 
 

 
  (ก) รุน J-1    (ข) รุน J-10 
 ภาพที ่55  ลักษณะการแบงชิ้นประกอบของแบบจําลองชิ้นจมกู รุน J-1 และ รุน J-10 
 
 ผลการวิเคราะห FEA ของระยะยืดทกุๆ 5 N  เร่ิมจากแรงดึงเทากบั 5 N  ถึง 60 N ของ รุน 
J-1 และ J-10  เปรียบเทียบกับผลการทดสอบทางกล (ภาพที ่46 และ 47)  ไดแสดงเปนกราฟใน
ภาพที ่60 และ 61 ของชิ้นจมูก รุน J-1 และ J-10  ตามลาํดับ  และตารางที่ 11 สรุปความคลาด
เคลื่อนของผลจาก FEA เปรียบเทียบกับการทดสอบทางกลทีทุ่กแรงดึงทดสอบของชิน้จมูกทัง้ 2 รุน 
โดยคาความคลาดเคลื่อนคํานวณจาก 

e  =  ∆EXP - ∆FEA     (1) 
 โดย ∆EXP  คือ คาระยะยืดจากผลการทดสอบทางกล 
  ∆FEA  คือ คาระยะยืดจากผลการวเิคราะห FEA 
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 เปอรเซ็นตความคลาดเคลื่อน  (eP) คํานวณจาก  

eP  =  %100⋅
∆

∆−∆

EXP

FEAEXP                           (2) 

 คาเฉลี่ยความคลาดเคลื่อน eAVG คํานวณจากสมการ 

eAVG  =  ∑
n
e

n 1

1                (3) 

 โดยคา n คือจํานวนขอมูล 
 คาสัมบูรณ (Absolute value) ของคาเฉลีย่  |e|AVG  คํานวณจากสมการ 

|e|AVG  =  ∑
n
e

n 1

1              (4) 

 

 
ภาพที ่56   การกําหนดเงื่อนไขขอบเขตและทิศทางแรงดึงของชิ้นจมกูรุน J-1 

 
ภาพที ่57  การกําหนดเงื่อนไขขอบเขตและทิศทางแรงดงึของชิน้จมูกรุน J-10 
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ภาพที ่58   ผล FEA ของการยืดตัวของชิ้นจมูก รุน J-1 ภายใตแรงดึง 10 N 

 
 

 
 

ภาพที ่59   ผล FEA ของการยืดตัวของชิ้นจมูกรุน J-10 ภายใตแรงดึง 10 N 
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ภาพที ่60    กราฟเปรียบเทยีบระยะยืด (Displacement) จากผล FEA กับผลการทดสอบ 
      ทางกล  ของชิ้นจมูกรุน J-1 ภายใตแรงดึง 5 N ถึง 60 N 
 

 
ภาพที ่61   กราฟเปรียบเทียบระยะยืด (Displacement) จากผล FEA กับผลการทดสอบ 

     ทางกล  ของชิ้นจมูกรุน J-10 ภายใตแรงดึง 5 N ถึง 60 N 

∆EXP = 0.4261F - 1.6878 

∆FEA = 0.3164F + 0.0018 

∆FEA = 0.24F + 0.0018 

∆EXP = 0.2634F - 0.7794 
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ตารางที่ 11  คาความคลาดเคลื่อนของผล FEA เทยีบกับผลทดสอบทางกลของการยืดตัว 
             ของชิ้นจมูก ในการทดสอบการดงึ 

 
รุน J-1 รุน J-10 

ระยะยืด (∆) mm ความคลาดเคลื่อน ระยะยืด (∆) mm ความคลาดเคลื่อน แรงดึง 
(Force)  

N 
การทดสอบ 
ทางกล 
∆EXP 

FEA 
 

∆FEA 

e 
 

(mm) 

ep 

 

(%) 

การทดสอบ 
ทางกล 
∆EXP 

FEA 
 

∆FEA 

e 
 

(mm) 

ep 

 

(%) 
5 0.503 1.200 -0.697 -138.57 0.524 1.580 -1.056 -201.72 
10 1.824 2.400 -0.576 -31.546 2.543 3.160 -0.617 -24.248 
15 3.146 3.600 -0.454 -14.436 4.678 4.750 -0.072 -1.538 
20 4.467 4.800 -0.333 -7.448 6.813 6.330 0.483 7.087 
25 5.789 6.000 -0.211 -3.651 8.948 7.910 1.038 11.595 
30 7.110 7.210 -0.100 -1.405 11.082 9.490 1.592 14.368 
35 8.432 8.410 0.021 0.255 13.217 11.10 2.117 16.017 
40 9.753 9.610 0.143 1.465 15.352 12.70 2.652 17.273 
45 11.074 10.80 0.274 2.477 17.486 14.20 3.286 18.794 
50 12.396 12.00 0.396 3.193 19.621 15.80 3.821 19.475 
55 13.717 13.20 0.517 3.770 21.756 17.40 4.356 20.022 
60 15.039 14.40 0.639 4.246 23.891 19.00 4.891 20.471 

เฉลี่ย                eAVG  -0.032 -15.137 เฉลี่ย                eAVG  1.874 -6.867 
|e|AVG  0.363 17.705 |e|AVG  2.165 31.051 
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4.3   ผล FEA ของความเคนของชิ้นจมูก 
 ตัวอยางผลการวิเคราะหความเคนจาก FEA ภายใตการทดสอบการดงึของชิน้จมูกโดย
แสดงความเคนเปนระดับชัน้สีในชิน้จมกู ที่แรงดึง 10 N ไดแสดง ในภาพที่ 62 และ 63  กราฟ
ของความเคนสูงสุดจากผลการทดสอบทาง FEA ที่แรงดึง 5 N ถึง 60 N ของชิ้นจมกู รุน J-1 และ 
J-10 ไดแสดงในภาพที่ 64  บริเวณที่เกิดความเคนสูงสุดของชิ้นจมกูรุน J-1 และ J-10  จากภาพที่ 
62 และ 63 พบที่บนผวิ (Surface) ที่กําหนดโหลดบนชิน้จมูก  ดังนัน้การฉีกขาดจะเกิดขึ้น ณ 
บริเวณนี้ ซึ่งสอดคลองกับการฉีกขาดที่เกดิขึ้นจริงในการทดสอบทางกล 

 
ภาพที ่62   ความเคนจากผล FEA ที่บริเวณตางๆ ภายใตแรงดึง 10 N ของชิ้นจมูกรุน J-1 

 
ภาพที ่63   ความเคนจากผล FEA ที่บริเวณตางๆ ภายใตแรงดึง 10 N ของชิ้นจมูกรุน J-10 
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ภาพที ่64   กราฟของความเคนสูงสุดจากผล FEA ของการทดสอบการดึงของชิน้จมูก 

     ภายใตแรงดึง 5 N ถึง 60 N 
 

5.   ผลการวเิคราะหการทดสอบการอัดถวยตาโดยใช FEA 
5.1   ผลการสรางแบบจําลอง FEM ของถวยตา 
 ผลการสรางแบบจําลองโซลติโมเดล  โดยใช Pro/ENGINEER ของถวยตาของแวนตาวาย
น้ํา รุน JR-1006, 2006 และ 981 ไดแสดงเปรียบเทียบกับชิ้นงานจริง  ในภาพที่ 65, 66 และ 67 
ตามลําดับ  ภาพวาดรายละเอียดของขนาดของถวยตาทั้ง 3 แบบไดแสดงในภาพผนวกที ่4 ถึง 6 

โซลิตโมเดลที่ได  นาํมาสรางเปนแบบจําลอง FEM โดยกําหนดเอลิเมนตใหเปนแบบ 
Tetrahedral    ผลการสรางแบบจําลอง FEM ของถวยตาของแวนตาวายน้าํรุน JR-1006 ไดแสดง
ในภาพที่ 68ก ประกอบดวย 12,667 โหนด และ 6,304 ชิ้นประกอบ   รุน 2006 (ภาพที ่68ข)
ประกอบดวย 12,302 โหนด และ 6,072 ชิ้นประกอบ และ รุน 981 (ภาพที ่68ค) ประกอบดวย 
14,623 โหนด และ 7,110 ชิ้นประกอบ   

ภาพที ่69 แสดงแบบจําลอง FEM โดยไมรวมสวนที่เปนเลนส โดยภาพที ่69 ก แสดง FEM 
ของถวยตาที่ไมมีเลนสของรุน JR-1006 ซึ่งประกอบดวย 8644 โหนด และ 4329 ชิ้นประกอบ ภาพ
ที่ 69 ข  ของรุน 2006 ซึ่งประกอบดวย 12314 โหนด และ 6590 ชิ้นประกอบ และภาพที ่69 ค ของ
รุน 981 ซึ่งประกอบดวย 11406 โหนด และ 5789 ชิ้นประกอบ  คา E ของ PC ที่ใชในการวิเคราะห 
ใชผลจากตารางที่ 10 โดยใชคาเทากับ 1019 N/mm2  

σJ-1 = 0.1365F - 0.0003 

σJ-10 = 0.1606F 
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(ก) ชิ้นงานจรงิ   (ข) โซลิตโมเดล 

ภาพที ่65   ชิ้นงานจรงิ (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของเลนสรุน JR-1006 
 

  
 
(ก) ชิ้นงานจรงิ   (ข) โซลิตโมเดล 

ภาพที ่66   ชิ้นงานจรงิ (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของเลนสรุน 2006 

             
 
(ก) ชิ้นงานจรงิ   (ข) โซลิตโมเดล 

ภาพที ่67   ชิ้นงานจรงิ (ภาพ ก) และโซลิตโมเดล (ภาพ ข) ของเลนสรุน 981 
 

5.1.1   การกาํหนดเงื่อนไขการจําลอง FEM สาํหรับการทดสอบการอัดแบบ ก 
ภาพที ่70, 71 และ 72 แสดงการกาํหนดเงื่อนไขขอบเขต และทิศทางของแรงอัดแบบ ก 

ของถวยตา รุน JR-1006, 2006 และ 981 ตามลาํดับ โดยแรงอัดที่ใชกาํหนดเปนแรงกระจายที่ผิว
ของเลนสถงึขอบของกรอบลําตัว 
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    (ก) รุน JR-1006  (ข) รุน 2006            (ค) รุน 981 

ภาพที ่68   แบบจําลอง FEM ของถวยตารุน JR-1006, 2006 และ 981 

 
   (ก) รุน JR-1006         (ข) รุน 2006           (ค) รุน 981  

ภาพที ่69   แบบจําลอง FEM แบบไมมีเลนสของถวยตารุน JR-1006, 2006 และ 981 

 
         ภาพที่ 70    การกาํหนดเงื่อนไขขอบเขตและทิศทางแรงอัดสําหรับการทดสอบการอัดแบบ ก  
        ของถวยตารุน JR-1006 

Force on surface 

Fixed on node 
Top 

Front Bottom 

3D 
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          ภาพที่ 71   การกําหนดเงื่อนไขขอบเขตและทิศทางแรงอัดสําหรับการทดสอบการอัดแบบ ก  

   ของถวยตารุน 2006 

 
        ภาพที ่72    การกําหนดเงื่อนไขขอบเขตและทิศทางแรงอัดสําหรบัการทดสอบการอัดแบบ ก  
       ของถวยตารุน 981 

Force on surface 

Fixed on node 
Top 

Front Bottom 

3D 

Force on surface 

Fixed on node Top 

Front 
Bottom 

3D 



70 

 

5.1.2 การกาํหนดเงื่อนไขการจาํลอง FEM สําหรบัการทดสอบการอดัแบบ ข 
ภาพที ่73 แสดงการกาํหนดเงื่อนไขขอบเขต ทิศทางและบริเวณพื้นผวิของแรงอัดที่

กระทําบนถวยตาของการทดสอบแรงอัดแบบ ข ของถวยตา รุน JR-1006 (ภาพที่ 73 ก) รุน 
2006 (ภาพที ่73 ข) และรุน 981 (ภาพที่ 73 ค)  โดยกําหนดใหพืน้ผวิทีรั่บแรงอัดเฉพาะบริเวณ
ขอบของกรอบลําตัวดานฝงห ู โดยมีแรงอัดกระทําเปนพื้นที่ประมาณ 1/4 ของผิวเลนส 

 
5.1.3 การกาํหนดเงื่อนไขการจาํลอง FEM สําหรบัการทดสอบการอดัแบบ ค 

ภาพที ่74 แสดงการกาํหนดเงื่อนไขขอบเขต ทิศทางและบริเวณพื้นผวิของแรงอัดที่กระทํา 
บนถวยตาของการทดสอบแรงอัดแบบ ค   โดยใชแบบจําลอง FEM ที่ไมรวมเลนสของถวยตา รุน 
JR-1006 (ภาพที ่74 ก) รุน 2006 (ภาพที ่74 ข) และรุน 981 (ภาพที่ 74 ค)  โดยการกําหนด
แรงอัดใชเงื่อนไขเดียวกันกบัของเงื่อนไขการทดสอบแรงอัดแบบ ข 
 

   
(ก) ถวยตา รุน JR-1006 

    
(ข) ถวยตา รุน 2006 

   
(ค) ถวยตา รุน 981 

ภาพที ่73   เงือ่นไขขอบเขตและทิศทางแรงอัดสําหรับการทดสอบการอดัแบบ ข 
 

Force on surface 

Force on surface Fixed node on surface 

Force on surface 

Fixed node on surface 

Fixed node on surface 
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(ก) ถวยตา รุน JR-1006 

    
(ข) ถวยตา รุน 2006 

    
(ค) ถวยตา รุน 981 

ภาพที ่74   การกําหนดเงื่อนไขขอบเขตและทิศทางสาํหรับการทดสอบการอัดแบบ ค 
 

5.2   ผลการวิเคราะหการยุบตัวของถวยตาโดยใช FEA 
5.2.1   ผล FEA ของการจําลองการทดสอบการอดัแบบ ก 

ตัวอยางผลการวิเคราะห FEA ของการยุบตัว หรือการเปลี่ยนแปลงรูปทรง ของถวยตา 
แสดงเปนระดบัชั้นสี ที่เกิดจากแรงอัด 600 N ของการทดสอบการอัดแบบ ก ไดแสดงในภาพที ่75, 
76 และ 77 สําหรับถวยตา รุน JR-1006, 2006 และ 981 ตามลําดับ  ข้ันตอนการวิเคราะห ไดสรุป
ไวในภาคผนวกที่ 5 
 ผลการวิเคราะห FEA ของการยุบตัว จากแรงอัดทุกๆ 100 N   โดยเริ่มจากแรงอัดที ่200 N 
ถึง 1000 N ไดผลเชนเดียวกับภาพที่ 75 ถึง 77 โดยแสดงการยุบตัวสงูสุดเกิดขึ้นที่บริเวณกึ่งกลาง
ของเลนส  เนือ่งจากระยะยบุตัวที่วัดไดในการทดสอบทางกล เปนการวัดที่ผิวบนของกรอบลําตัว
ของถ วยตา   ดังนัน้ระยะยบุตัวทีน่ํามาเปรียบเทียบจึงใชคาเฉลี่ยของ 25 จุด ระยะหางเทาๆ กนั

Force on surface 
Fixed node on surface 

Fixed node on surface Force on surface 

Force on surface 
Fixed node on surface 
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ตามขอบนอกของกรอบลําตวัและผิวเลนส  กราฟในภาพที่ 78, 79 และ 80  เปรียบเทยีบระยะ
ยุบตัวของถวยตา ระหวาง ผลการทดสอบทางกลและผลจาก FEA ของถวยตา รุน JR-1006, 
2006 และ 981 ตามลําดับ   โดย ∆ FEA-MAX  เปนระยะยุบตัวสูงสุดทีก่ลางเลนส และ ∆ FEA-EDGE 
เปนคาเฉลีย่ของระยะยบุตัวตามขอบและผิวเลนส (25 จุด) 
 
 

 
ภาพที ่75   ผล FEA แบบ ก ของระยะยุบตัวของถวยตารุน JR-1006 ที่แรงอัด 600 N 

 

 
ภาพที ่76   ผล FEA แบบ ก ของระยะยุบตัวของถวยตา รุน 2006 ที่แรงอัด 600 N 
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ภาพที ่77   ผล FEA แบบ ก ของระยะยุบตัวของถวยตา รุน 981 ที่แรงอัด 600 N 

 
ภาพที ่78   กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ 

     ทดสอบทางกล ของการทดสอบการอดัแบบ ก ในชวง 200 N ถึง 1000 N ของ 
     ถวยตารุน JR-1006 

∆FEA-EDGE = 0.0004F - 0.0002 

∆EXP = 0.0004F - 0.0031 

∆FEA-MAX = 0.0011F - 0.0002 

588 



74 

 

 
ภาพที ่79   กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ 

     ทดสอบทางกล ของการทดสอบการอดัแบบ ก ในชวง 200 N ถึง 1000 N 
     ของถวยตารุน 2006 

 
ภาพที ่80   กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผลการ 

     ทดสอบทางกล ของการทดสอบการอดัแบบ ก ในชวง 200 N ถึง 1000 N 
     ของถวยตารุน 981 

∆EXP = 0.0004F - 0.0031 

∆FEA-EDGE = 0.0007F - 0.00005 

∆FEA-MAX = 0.0015F - 8E-05 

∆FEA-EDGE = 0.0007F - 0.0002 

∆EXP = 0.0005F + 0.0305 

∆FEA-MAX = 0.0016F - 8E-05 

588 

588 
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5.2.2   ผล FEA ของการจําลองการทดสอบการอดัแบบ ข 
 ตัวอยางผลการวิเคราะห FEA ของการยุบตัวของถวยตาแสดงเปนระดบัชั้นสีทีเ่กิดจาก
แรงอัด 600 N ของการทดสอบแรงอัดแบบ ข ไดแสดงในภาพที่ 81, 82 และ 83 สําหรับถวยตา
รุน JR-1006, 2006 และ 981 ตามลําดับ 
 ผลการวิเคราะห FEA ของการยุบตัว จากแรงอัดที่ 200 N เพิ่มทุกๆ 100 N ถึง 1000 N  
แสดงระยะยุบสูงสุดบนเลนสฝงเดียวกับแรงกระทาํ  ระยะยุบสูงสุดนี้ไมไดเกิดบนขอบของกรอบ
ลําตัว เชนเดียวกับผลที่ไดโดยการจาํลองการทดสอบการอัดแบบ ก   ดงันัน้ระยะยุบตัวที่ใช
เปรียบเทียบกบัผลการทดสอบทางกล คือ ระยะยบุตัวทีจุ่ด A ของภาพที ่81 ถึง 83 
 

 
ภาพที ่81   ผล FEA แบบ ข ของระยะยุบตัวของถวยตา รุน JR-1006 ที่แรงอัด 600 N 

 
 

 
ภาพที ่82   ผล FEA แบบ ข ของระยะยุบตัวของถวยตา รุน 2006 ที่แรงอัด 600 N 

A 

A 
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ภาพที ่83   ผล FEA แบบ ข ของระยะยุบตัวของถวยตา รุน 981 ที่แรงอัด 600 N 
 
5.2.3   ผล FEA ของการจําลองการทดสอบการอดัแบบ ค 
 ตัวอยางผลการวิเคราะห FEA ของการยุบตัวของถวยตาแสดงเปนระดบัชั้นสีทีเ่กิดจาก
แรงอัด 600 N ของการทดสอบแรงอัดแบบ ค ไดแสดงในภาพที่ 84, 85 และ 86 สําหรับถวยตารุน 
JR-1006, 2006 และ 981 ตามลําดับ 
 ผลการวิเคราะห FEA ของการยุบตัว จากแรงอัดที่ 200 N เพิ่มทุกๆ 100 N ถึง 1000 N  
แสดงตําแหนงการยุบตัวสงูสดุที่ขอบบนของกรอบลําตัวดานที่มีแรงมากระทํา (จุด A)  

 

 
ภาพที ่84   ผล FEA แบบ ค ของระยะยุบตัวของถวยตา รุน JR-1006 ที่แรงอัด 600 N 

A 

A 
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ภาพที ่85   ผล FEA แบบ ค ของระยะยุบตัวของถวยตา รุน 2006 ที่แรงอัด 600 N 
 
 

 
 

ภาพที ่86   ผล FEA แบบ ค ของระยะยุบตัวของถวยตา รุน 981 ที่แรงอัด 600 N 
 

5.2.4   การเปรียบเทยีบผล FEA ของแบบจําลองการทดสอบการอัด 
 กราฟแสดงระยะยุบตัวของการทดสอบการอัดเพิ่มจากแรงอัดที่ 200 N เพิ่มทุกๆ 100 N 
ถึง 1000 N เปรียบเทียบกบัผลการทดสอบทางกล ของผล FEA จากการทดสอบแรงอัด แบบ ก    
(∆FEA-A)  แบบ ข (∆FEA-B)  และแบบ ค (∆FEA-C)   โดยตําแหนงของระยะยุบตัวที่ใชเปรียบเทียบเปน 

A 

A 
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ตําแหนงเดียวกันของทั้ง 3 แบบ คือ จุด A (ภาพที ่84 ถึง 86) ซึ่งเปนโหนดอยูตรงกลางที่ขอบบน
ของกรอบลําตวัของถวยตา (ดานฝงหู) 
 ภาพที ่87 แสดงผลเปรียบเทียบระยะยุบตัว (∆) ของถวยตารุน JR-1006   ภาพที่ 88 
ของรุน 2006 และภาพที ่89 ของรุน 981  ตารางที่ 12, 13 และ 14 สรุปความคลาดเคลื่อนของผล 
FEA เมื่อเทียบกับผลทดสอบทางกลของระยะยุบตัว ของถวยตา รุน JR-1006  รุน 2006 และรุน 
981 ตามลาํดับ 
 ผลจากกราฟและตารางดงักลาว แสดงการจําลอง FEA ของการทดสอบแบบ ค  ในถวย
ตารุน JR-1006 รุน 2006 และ 981  ใหผลใกลเคียงกับการทดสอบทางกล โดยรุน JR-1006 มีคา
ความคลาดเคลื่อนเฉลี่ย |e|AVG = 0.903  รุน 2006 มีคาความคลาดเคลื่อนเฉลี่ย |e|AVG = 2.613 
และรุน 981 มคีาความคลาดเคลื่อนเฉลี่ย |e|AVG = 6.969 
 
 

 
 

ภาพที ่87   กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผล 
     การทดสอบทางกล ของการทดสอบการอัดในชวง 200 N ถึง 1000 N  
     ของถวยตารุน JR-1006 

 

∆FEA-C = 0.0004F - 0.0002 

∆EXP = 0.0004F - 0.0031 

∆FEA-B = 0.0003F + 6E-05 

∆FEA-A = 0.0004F - 0.0002 

588 
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ภาพที ่88   กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผล 

     การทดสอบทางกล ของการทดสอบการอัดในชวง 200 N ถึง 1000 N  
     ของถวยตารุน 2006 

 
ภาพที ่89   กราฟเปรียบเทียบระยะยุบตัว (Displacement) จากผล FEA กับผล 

     การทดสอบทางกล ของการทดสอบการอัดในชวง 200 N ถึง 1000 N  
     ของถวยตารุน 981 

∆FEA-C = 0.0006F - 0.0139 

∆EXP = 0.0005F + 0.0139 

∆FEA-B = 0.0005F + 7E-05 

∆FEA-A = 0.0007F - 5E-05 

∆FEA-C = 0.0006F + 0.0005 

∆EXP = 0.0005F + 0.0305 

∆FEA-B = 0.0005F + 0.0003 

∆FEA-A = 0.0007F + 0.0002 

588 

588 
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ตารางที่ 12  แสดงคาความคลาดเคลื่อนของผล FEA เทยีบกับผลทดสอบทางกลของระยะยุบตัว (∆) จากการทดสอบการอัดของถวยตา  รุน JR-1006

 
การทดสอบการอัดแบบ ก การทดสอบการอัดแบบ ข การทดสอบการอัดแบบ ค แรงอัด

(Force)  
N 

การทดสอบ 
ทางกล 
∆EXP 

∆FEA-A 
e 

(mm) 
eP 

(%) ∆FEA-B 
e 

(mm) 
eP 

(%) ∆FEA-C 
e 

(mm) 
eP 

(%) 
200 0.0731 0.089 -0.0155 -21.1375 0.067 0.006 8.121 0.0747 -0.002 -2.133 
300 0.1113 0.133 -0.0217 -19.5183 0.101 0.010 9.238 0.112 -0.001 -0.647 
400 0.1494 0.177 -0.0280 -18.7257 0.134 0.015 10.320 0.149 0.000 0.281 
500 0.1876 0.222 -0.0341 -18.2022 0.168 0.020 10.429 0.187 0.001 0.299 
600 0.2257 0.266 -0.0404 -17.8999 0.202 0.024 10.501 0.224 0.002 0.753 
700 0.2638 0.311 -0.0467 -17.6850 0.235 0.029 10.931 0.262 0.002 0.697 
800 0.3019 0.355 -0.0529 -17.5243 0.269 0.033 10.921 0.299 0.003 0.987 
900 0.3401 0.399 -0.0592 -17.4066 0.302 0.038 11.203 0.336 0.004 1.206 

1000 0.3783 0.444 -0.0654 -17.3003 0.336 0.042 11.172 0.374 0.004 1.126 
เฉลี่ย             eAVG -0.0404 -18.3778  0.024 10.315  0.002 0.285 

|e|AVG  0.0404 18.3778  0.0241 10.315  0.002 0.903 
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ตารางที่ 13  แสดงคาความคลาดเคลื่อนของผล FEA เทยีบกับผลทดสอบทางกลของระยะยุบตัว (∆) จากการทดสอบการอัดของถวยตา รุน 2006 

 
การทดสอบการอัดแบบ ก การทดสอบการอัดแบบ ข การทดสอบการอัดแบบ ค 

แรงอัด
(Force)  

N 

การ
ทดสอบ 
ทางกล 
∆EXP 

∆FEA-A 
e 

(mm) 
eP 

(%) ∆FEA-B 
e 

(mm) 
eP 

(%) ∆FEA-C 
e 

(mm) 
eP 

(%) 

200 0.1212 0.141 -0.0198 -16.3366 0.093 0.028 22.950 0.112 0.009 7.606 
300 0.1749 0.212 -0.0366 -20.9262 0.141 0.034 19.383 0.169 0.006 3.373 
400 0.2286 0.282 -0.0534 -23.3596 0.187 0.042 18.198 0.225 0.004 1.575 
500 0.2823 0.353 -0.0703 -24.9026 0.234 0.048 17.098 0.28 0.002 0.801 
600 0.3360 0.423 -0.0871 -25.9226 0.280 0.056 16.657 0.338 -0.002 -0.607 
700 0.3896 0.494 -0.1040 -26.6940 0.327 0.063 16.076 0.396 -0.006 -1.632 
800 0.4433 0.564 -0.1208 -27.2502 0.375 0.068 15.411 0.457 -0.014 -3.086 
900 0.4970 0.635 -0.1376 -27.6861 0.422 0.075 15.091 0.509 -0.012 -2.414 

1000 0.5507 0.705 -0.1545 -28.0552 0.467 0.084 15.193 0.564 -0.013 -2.423 
เฉลี่ย             eAVG -0.0871 -24.5704  0.055 17.339  -0.003 0.355 

|e|AVG  0.0871 24.5704  0.055 17.339  0.008 2.613 
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ตารางที่ 14  แสดงคาความคลาดเคลื่อนของผล FEA เทยีบกับผลทดสอบทางกลของระยะยุบตัว (∆) จากการทดสอบการอัดของถวยตา รุน 981 

 
การทดสอบการอัดแบบ ก การทดสอบการอัดแบบ ข การทดสอบการอัดแบบ ค 

แรงอัด
(Force)  

N 

การ
ทดสอบ 
ทางกล 
∆EXP 

∆FEA-A 
e 

(mm) 
eP 

(%) ∆FEA-B 
e 

(mm) 
eP 

(%) ∆FEA-C 
e 

(mm) 
eP 

(%) 

200 0.1299 0.150 -0.0196 -15.1240 0.102 0.028 21.454 0.117 0.013 9.903 
300 0.1795 0.224 -0.0448 -24.9443 0.153 0.027 14.773 0.175 0.005 2.518 
400 0.2292 0.299 -0.0700 -30.5410 0.204 0.025 10.995 0.233 -0.004 -1.658 
500 0.2789 0.374 -0.0951 -34.1079 0.255 0.024 8.563 0.292 -0.013 -4.705 
600 0.3285 0.449 -0.1204 -36.6431 0.306 0.023 6.855 0.35 -0.021 -6.538 
700 0.3782 0.524 -0.1456 -38.5128 0.357 0.021 5.596 0.408 -0.030 -7.891 
800 0.4278 0.599 -0.1708 -39.9187 0.408 0.020 4.633 0.467 -0.039 -9.158 
900 0.4775 0.674 -0.1960 -41.0412 0.459 0.019 3.878 0.525 -0.047 -9.943 

1000 0.5272 0.748 -0.2211 -41.9493 0.509 0.018 3.445 0.582 -0.055 -10.403 
เฉลี่ย             eAVG -0.1204 -33.6425  0.0226 8.9101  -0.021 -4.208 

|e|AVG  0.1204 33.6425  0.0226 8.9101  0.025 6.969 
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5.3   ผลการวิเคราะหความเคนของถวยตาภายใตแรงอัดโดยใช FEA 
5.3.1   ความเคนจากผล FEA ของการทดสอบการอัดแบบ ก 

ภาพที ่90, 91 และ 92 แสดงตัวอยางผลการวิเคราะหความเคนโดยใช FEA ของการ
ทดสอบการอดัแบบ ก แสดงเปนระดับชัน้สี  ภายใตแรงอัดที่ 600 N ของถวยตา รุน JR-1006, 
2006 และ 981 ตามลําดับ  ในการจาํลองการทดสอบ FEA แบบ ก นีแ้สดงความเคนสูงสุดของ
ถวยตารุน JR-1006 เกิด ณ บริเวณกึ่งกลางของเลนส เชนเดียวกับตําแหนงของการเกิดระยะยุบตัว
สูงสุดแตสําหรบัรุน 2006 และ 981 มีคาสงูสุดบริเวณกรอบลําตัวใกลแผนเลนส   ภาพที่ 93 แสดง
กราฟของความเคนสูงสุดของถวยตา  ที่แรงอัด 200 N ถึง 1000 N ของถวยตา รุน JR-1006, 
2006 และ 981 ตามลําดับ 

 
   ภาพที่ 90   ความเคนจากผล FEA ของการทดสอบการอัดแบบ ก ที่แรงอัด 600 N  

        ของถวยตารุน JR-1006 

     
ภาพที ่91   ความเคนจากผล FEA ของการทดสอบการอดัแบบ ก ที่แรงอัด 600 N  

               ของถวยตารุน 2006 
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ภาพที ่92   ความเคนจากผล FEA ของการทดสอบการอดัแบบ ก ที่แรงอัด 600 N 
     ของถวยตารุน 981 

 

 
    ภาพที ่93   กราฟของความเคนสงูสุดจากผล FEA ของการทดสอบการอัดแบบ ก  

         ในชวง 200 N ถึง 1000 N ของถวยตาทั้ง 3 รุน 
 

5.3.2   ความเคนจากผล FEA ของการทดสอบการอัดแบบ ข 

σJR-1006A = 0.0327F – 0.0006 

σ2006A = 0.0659F + 0.00007 

σ981A = 0.0049F – 0.0002 

588 
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ภาพที ่94, 95 และ 96 แสดงตัวอยางผลการวิเคราะหความเคนโดยใช FEA ของการ
ทดสอบการอดัแบบ ข แสดงเปนระดับชัน้สี  ภายใตแรงอัดที่ 600 N ของถวยตา รุน JR-1006, 
2006 และ 981 ตามลําดับ   ความเคนสงูสุดปรากฏที่กรอบลําตัวของถวยตาทัง้ 3 รุน   ภาพที ่
97 แสดงกราฟของความเคนสูงสุดของถวยตารุน JR-1006  รุน 2006 และรุน 981 ทีแ่รงอัด 200 N 
ถึง 1000 N 

 
ภาพที ่94   ความเคนจากผล FEA ของการทดสอบการอดัแบบ ข ที่แรงอัด 600 N  

     ของถวยตารุน JR-1006 
 

 
ภาพที ่95   ความเคนจากผล FEA ของการทดสอบการอดัแบบ ข ที่แรงอัด 600 N  

     ของถวยตารุน 2006 
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ภาพที ่96   ความเคนจากผล FEA ของการทดสอบการอดัแบบ ข ที่แรงอัด 600 N  
     ของถวยตารุน 981 

 

 
ภาพที ่97   กราฟของความเคนสูงสุดจากผล FEA ของการทดสอบการอัดแบบ ข  

    ในชวง 200 N ถึง 1000 N ของถวยตาทั้ง 3 รุน 

σ981B = 0.0562F - 0.0067 

σJR-1006B = 0.0304F + 0.0139 
σ2006B = 0.0359F + 0.0516 

588 
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5.3.3   ความเคนจากผล FEA ของการทดสอบการอัดแบบ ค 
ภาพที ่98, 99 และ 100 แสดงตัวอยางผลการวิเคราะหความเคนโดยใช FEA ของการ

ทดสอบการอดัแบบ ค แสดงเปนระดับชัน้สี  ภายใตแรงอัดที่ 600 N ของถวยตา รุน JR-1006, 
2006 และ 981 ตามลําดับ ความเคนสูงสดุปรากฏที่กรอบลําตัวของถวยตาทัง้ 3 รุน เชนเดียวกับ
การทดสอบแบบ ข  ภาพที่ 101 แสดงกราฟของความเคนสูงสุดของถวยตา  ที่แรงอัด 200 N ถึง 
1000 N ของถวยตา รุน JR-1006, 2006 และ 981 ตามลําดับ 
 

 
ภาพที ่98   ความเคนจากผล FEA ของการทดสอบการอดัแบบ ค ที่แรงอัด 600 N  

     ของถวยตารุน JR-1006 

 
ภาพที ่99   ความเคนจากผล FEA ของการทดสอบการอดัแบบ ค ที่แรงอัด 600 N  

     ของถวยตารุน 2006 
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ภาพที ่100   ความเคนจากผล FEA ของการทดสอบการอัดแบบ ค ที่แรงอัด 600 N  
       ของถวยตารุน 981 

 

 
ภาพที ่101   กราฟของความเคนสูงสุดจากผล FEA ของการทดสอบการอัดแบบ ค  

       ในชวง 200 N ถึง 1000 N ของถวยตาทั้ง 3 รุน 
 

σ981C = 0.077F  

σJR-1006C = 0.0672F - 0.0067 

σ2006C = 0.0391F – 0.0131 

588 
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6.   ผลการวเิคราะหการทดสอบการกระแทกเลนสถวยตาโดยใช FEA 
6.1   ผลการสรางแบบจําลอง FEM สาํหรับวเิคราะหการกระแทก 
 แบบจําลอง FEM ของถวยตาที่ใชในการวิเคราะห FEM ใชแบบจําลองเดียวกนักับ ที่ใช
ในการทดสอบการอัด (ภาพที ่68)   โดยภาพที ่102 แสดงการกาํหนดเงื่อนไขขอบเขต ตําแหนง
และทิศทาง ของแรงกระแทกที่เกิดจากการตกกระแทกของลูกบอลโลหะ บนผวิเลนสของถวยตา 
รุน JR-1006 (ภาพที ่102 ก)  รุน 2006 (ภาพที่ 102 ข) และ รุน 981(ภาพที ่102 ค) 

 

 

 
ภาพที ่102   การกําหนดเงือ่นไขขอบเขต ทิศทางและตําแหนงของแรงกระแทก 

       ของเลนสถวยตารุน JR-1006 (ก) 2006 (ข) และ 981 (ค) 

Top 3D 

Front Bottom 

Force on node 

Fixed on node 
(ก) รุน JR-1006 

(ข) รุน 2006 

(ค) รุน 981 

Force on node 

Fixed on node 

Force on node 

Fixed on node 

Top 3D 

Front 
Bottom 

Top 3D 

Front Bottom 
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6.2   การวิเคราะหแรงกระแทก 
การกําหนดแรงกระแทก มีข้ันตอนการวิเคราะหดังนี ้  ข้ันตอนแรกทาํการวิเคราะห หา

คา อิมพัลส (Impulse) และเวลาที่ลูกบอลโลหะสัมผัสกบัผิวหนาเลนส โดยใช  ซอฟแวร  
MSC.Working Model  จําลองการปลอยลูกบอลโลหะตกลงมากระแทกผิวหนาเลนสของแวนตา
วายน้ํา   ข้ันตอนที่สองคํานวณคาแรงทีก่ระแทกบนผวิหนาเลนสจาก อิมพัลส ที่เกดิขึ้นแลวจึงนํา
คาแรงกระแทกที่ไดมาทําการวิเคราะหแบบ Static  

ภาพที ่103 แสดงกราฟของอิมพัลสทีว่ิเคราะหไดจากการจําลองลูกบอลโลหะหนกั 44 
กรัม  ตกจากที่สูง 1.3 เมตร   ซึ่งไดคาอิมพัลสเทากับ 0.333 kg.m/s และเวลาที่ลูกบอลโลหะ
สัมผัสกับกับเลนส เทากับ 0.00333 วินาท ี  แรงกระแทกคํานวณไดจาก อิมพัลสหารดวยเวลาซึ่ง
ไดคาแรงเทากบั 100 N   สําหรับการปลอยลูกบอลโลหะตกจากที่สูง 0.7, 1 และ 1.6 เมตร   ขนาด
ของแรงกระแทกเทากับ  73 N, 88 N และ 111 N  ตามลําดับ  
 แรงกระแทกทีว่ิเคราะหไดจากอิมพัลสนี้  ไดนาํไปใชกําหนดเปนแรงกระทําบนโหนด ณ จุด
ที่ลูกบอลตกกระแทกผิวเลนสตามเงื่อนไข ไดแสดงไวแลว ในภาพที่ 102    ข้ันตอนการวิเคราะห
CAE  ไดสรุปไวในภาคผนวกที่ 6 
 

 
 

ภาพที ่103   กราฟของอมิพัลส ที่เกิดจากลูกบอลโลหะตกกระแทกผิวหนาเลนสถวยตา 
       จากที่สูง 1.3 เมตร 
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6.3   การวิเคราะหความเคนของการทดสอบการกระแทกโดยใช FEA 

ผลการวิเคราะห FEA แสดงความเคนที่เกดิจากการปลอยตกของลูกบอลโลหะหนกั 44 
กรัมไดแสดง ในภาพที่ 104 ถึง 106 สําหรบัถวยตารุน JR-1006, 2006 และ 981 ตามลําดับ  คา
ความเคนสูงสดุที่เกิดขึ้นที่เลนสถวยตา รุน JR-1006 มีคาเทากับ 42.4 N/mm2   รุน 2006 เทากับ 
43.04 N/mm2  และ รุน 981 เทากับ 43.42 N/mm2    ความเคนที่เกิดขึน้กับเลนสถวยตา ทั้ง 3 รุน
นี้ไมเกนิคาความเคนสงูสุดของวัสดุ (PC) ที่ใชทาํเลนสถวยตา (ภาพที่ 52) ซึ่งมีคาความเคนสงูสุด
เฉลี่ย เทากับ 53 N/mm2 (±5) และคา Yield อยูที่ 52 N/mm2 (±7) โดยความเคนที่ไดตํ่ากวาคา 
Yield แสดงวาวัสดุไมยุบตัวหรือเกิดรอยราวสอดคลองกับผลการทดสอบทางกล 
 ภาพที ่107 แสดงกราฟความสัมพนัธของคาความเคนสงูสุดจากผล FEA กับความสงู
ในชวง 0.7 ม. ถึง 1.6 ม. ของการปลอยลกูบอลโลหะตกกระแทกเลนส 

 
 

 
 

ภาพที ่104   ความเคนจากผล FEA ของการกระแทกบนเลนสถวยตารุน JR-1006  
       (ความสงู 1.3 เมตร) 
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ภาพที ่105   ความเคนจากผล FEA ของการกระแทกบนเลนสถวยตารุน 2006  
       (ความสงู 1.3 เมตร) 

 

 
ภาพที ่106   ความเคนจากผล FEA ของการกระแทกบนเลนสถวยตารุน 981  

      (ความสูง 1.3 เมตร) 
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ภาพที ่107   กราฟของความเคนสูงสุดจากผล FEA ของการกระแทกในชวงความสงู 
       0.7 ม. ถงึ 1.6 ม. ของเลนสถวยตา รุน JR-1006, 2006 และ 981 

 
 
6.4   การวิเคราะหความเครียดของการทดสอบการกระแทกโดยใช FEA 
 ผลการวิเคราะห FEA ของความเครียด (Strain)  ของการปลอยลูกบอลโลหะตกกระแทก
เลนส  เมื่อใหลูกบอลตกกระแทกเลนสจากความสงู 1.3 ม.  ไดแสดงเปนระดับชั้นสใีนภาพที่ 108 
ถึง 110 สําหรบัถวยตารุน JR-1006, 2006 และ 981 ตามลําดับ  
 ภาพที ่111 แสดงกราฟความสัมพนัธระหวางความเครียดสูงสุดจากผล FEA กับความสงู
ในชวง 0.7 ม. ถึง 1.6 ม. ของการปลอยลกูบอลโลหะตกกระแทกเลนส 
 
7.   ผลการทดสอบความสบายในการสวมใสโดยใช FEA 
7.1   ผลการสรางแบบจําลอง FEM 
 ใบหนารูปปนศีรษะตามแสดงในภาพที ่23 เปนใบหนาและศีรษะที่ใชในการจาํลอง FEM 
ของใบหนา สําหรับประเมนิความสบายในการสวมใสแวนตาวายน้าํ โดยวิเคราะหระยะที่ผิวหนงั
โดนกดลึกและความเคนทีเ่กิดจากการกดบนใบหนาของสวนฐานและปะเก็นกันน้ําของแวนตาวาย
น้ํา   
 

σJR-1006 = 17.906h + 18.404 

σ981 = 18.333h + 18.865 

σ2006 = 18.156h + 18.719 
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ภาพที ่108   ความเครียดจากผล FEA ของการกระแทกบนเลนสถวยตารุน JR-1006 

       (ความสงู 1.3 เมตร) 
 

 
ภาพที ่109   ความเครียดจากผล FEA ของการกระแทกบนเลนสถวยตารุน 2006 

       (ความสงู 1.3 เมตร) 
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ภาพที ่110   ความเครียดจากผล FEA ของการกระแทกบนเลนสถวยตารุน 981 

      (ความสูง 1.3 เมตร) 

 
ภาพที ่111   กราฟของความเครียดสูงสุดจากผล FEA ของการกระแทกในชวงความสูง  

       0.7 ม. ถงึ 1.6 ม. ของเลนสถวยตา รุน JR-1006, 2006 และ 981 

∈JR-1006 = 0.0072h + 0.0073 

∈2006 = 0.0072h + 0.0074 

∈981 = 0.0073h + 0.0075 
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แบบ CAD ของศีรษะสรางไดจากการสแกนดวยเครื่อง Optical Scanner  (ภาพที ่24)  
ภาพที ่112 ก แสดงจุดโคออดิเนต หรือ  Point Cloud  บนผิวของรูปปนศีรษะที่ไดจากการแสกน  
ภาพที ่112 ข แสดงผลการจาํลอง CAD ของใบหนาแบบพื้นผวิ (Surface model) ของศีรษะ
โดยการเชื่อมตอจุดที่ไดจากการแสกน   จากความเปนสมมาตรของศรีษะจึงแบงครึง่แบบจําลอง 
CAD ของศีรษะและนาํดานซายของศีรษะมาใชในการวิเคราะห  FEA บริเวณเบาตาบนใบหนา  
แบบจําลองครึง่ศีรษะนีย้ังคงเปนแบบพืน้ผวิ   จึงไดแปลงใหเปนแบบจาํลองโซลิตโมเดล แลว
จําลองสวนฐานและปะเกน็กนัน้าํของแวนตาบนใบหนา   ภาพที ่112ค  แสดงการจําลอง FEM 
ของใบหนาครึ่งซายพรอมสวนฐานเปนขอบของฐานถวยตาที่แนบติดบนใบหนา  แบบจําลอง FEM 
สําหรับถวยตารุน 2006 ประกอบดวย  28,598 โหนด และ18,066 เอลิเมนต  และของถวยตารุน 
1006 ประกอบดวย  11,054 โหนด และ 6,609 เอลิเมนต  ภาพที่ 113 แสดงการกาํหนดเงื่อนไข
ขอบเขตและทิศทางของแรง 

 
 

 
 

ภาพที ่112   แบบจําลอง CAD และ FEM ของใบหนา 

(ก) Point cloud (ข) Surface 

(ค) FEM (ง) FEA 
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ภาพที ่113   การกําหนดเงือ่นไขขอบเขตและทิศทางของแรงสําหรับวิเคราะห 
       ความสบายในการสวมใส 

 
7.2   ผลการวิเคราะหระยะยุบบนใบหนาโดยใช FEA 
 ตัวอยางผลการวิเคราะห การยุบที่เกิดบนใบหนาตามขอบของแวนตาวายน้าํที่แรงเทากับ 
5 N ของแวนตาวายน้าํรุน 2006 และรุน 1006 ไดแสดงเปนระดับชั้นสใีนภาพที่ 114 และ 115 
ตามลําดับ   โดยกําหนดคา E ของผิวหนังเทากับ 13.7 N/mm2  ภาพที่ 116 และ 117 แสดงกราฟ
ของระยะยุบทีผิ่วหนัง 4 ตําแหนง (a, b, c และ d) ตามขอบแวนที่แนบบนใบหนาเมื่อเทียบกบัแรง
ที่ 3, 5, 7 และ 9 N ของแวนตาวายน้าํรุน 2006 และรุน 1006 ตามลําดับ  
 
7.3   ผลการวิเคราะหความเคนบนใบหนาโดยใช FEA 

ภาพตัวอยางแสดงระดับชั้นสีของความเคนจากผล FEA จากแรงกดบนขอบของถวยตา
เทากับ 5 N ของแวนตาวายน้ํารุน 2006 และรุน 1006 ไดแสดงในภาพที ่118 และ 119 ตามลาํดับ   
ภาพที ่120 และ 121 แสดงกราฟของความเคนที ่4 ตําแหนง บนฐานของแวนตาวายน้ํารุน 2006 
และ 1006 ตามลําดับ เมื่อเทียบกับแรงที ่3, 5, 7 และ 9 N  จุดที่มีความเคนมากสุดไดแกจุด C 

Force on surface 
Fixed on node 
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จากการประเมินจากแบบสอบถามจากผูทดสอบการสวมใสจํานวน 50 คน พบความ
เจ็บปวดอยูทีตํ่าแหนง ระหวาง C กับ D มากที่สุด (70%) ซึ่งเปนผลที่สอดคลองกบัผลที่ไดโดย 
FEA  
 

 
 

ภาพที ่114   ผล FEA ของระยะที่ผิวหนงับนใบหนายุบเมื่อมีแรงเทากบั 5 N  
       ของถวยตารุน 2006 
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ภาพที ่115   ผล FEA ของระยะที่ผิวหนงับนใบหนายุบเมื่อมีแรงเทากบั 5 N  

       ของถวยตารุน 1006 

ภาพที ่116   กราฟของระยะยุบ 4 บริเวณบนผิวหนงัจากผล FEA ของแรง 
       ในชวง 3 N ถึง 9 N ของการสวมใสถวยตารุน 2006 
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ภาพที ่117   กราฟของระยะยุบ 4 บริเวณบนผิวหนงัจากผล FEA ของแรง 

      ในชวง 3 N ถึง 9 N ของการสวมใสถวยตารุน 1006 

 
 

ภาพที ่118  ความเคนบนใบหนาจากผล FEA ที่แรงเทากบั 5 N ของถวยตารุน 2006 
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ภาพที ่119  ความเคนบนใบหนาจากผล FEA ที่แรงเทากบั 5 N ของถวยตารุน 1006 
 

 
ภาพที ่120   กราฟของความเคน 4 บริเวณบนใบหนาจากผล FEA ของแรง 

       ในชวง 3 N ถึง 9 N ของการสวมใสถวยตารุน 2006 
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ภาพที ่121   กราฟของความเคน 4 บริเวณบนใบหนาจากผล FEA ของแรง 

       ในชวง 3 N ถึง 9 N ของการสวมใสถวยตารุน 1006 
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สรุป 
 

งานวิจยันี้ไดทาํการศึกษากระบวนการออกแบบแวนตาวายน้าํ  แลวไดพัฒนาวธิีการ
ออกแบบแวนตาวายน้าํโดยใชเทคโนโลยคีอมพิวเตอรชวยการออกแบบ (CAD) และได
ทําการศึกษาและทดสอบชิน้สวนตางๆ ของแวนตาวายน้ํา ตามมาตรฐานการทดสอบผลิตภัณฑ
แวนตาวายน้ําของ BS5883:1996  โดยใชเทคโนโลยีคอมพิวเตอรชวยงานวิศวกรรม (CAE) แลว
นําผลที่ไดไปเปรียบเทียบกบัการทดสอบจริง (หรือการทดสอบทางกล)  โดยผลที่ไดบรรลุตาม
วัตถุประสงค  ในการพัฒนาการออกแบบแวนตาวายน้ําโดยใชคอมพิวเตอรชวยการออกแบบทําให
สามารถออกแบบรูปทรงตางๆ ของแวนตาวายน้ําไดสดวกรวดเร็วและสามารถวิเคราะหความ
แข็งแรงของชิ้นสวนแวนตาวายน้ําไดกอนทําการผลิตและการทดสอบจริง  นอกจากนี้กรรมวิธีและ
อุปกรณสําหรบัการทดสอบทางกลตามมาตรฐาน BS5883:1996  อันไดแก  การทดสอบการดึง  
การทดสอบการอัด และการกระแทกของเลนสถวยตา  ไดพัฒนาใหสามารถทาํการทดสอบ
เบื้องตนไดภายในประเทศ 

 
ผลจากงานวิจยันี้สามารถสรปุไดดังนี ้
 
1.   การพัฒนากรรมวิธกีารออกแบบแวนตาวายน้าํ    ชิ้นสวนของแวนตาวายน้ําทีสํ่าคัญ

และซับซอนมากที่สุดคือถวยตา  ในงานวจิัยนี้ไดแยกสวนประกอบของถวยตา  เปนรูปทรงเฉพาะ
แบบหรือฟเจอรไดเปน 6 กลุม ไดแก สวนฐาน  กรอบลาํตัว  เลนส  ตัวหู และอืน่ๆ  จากการ
รวบรวมถวยตาจํานวน 31 รุน  สามารถสรางและรวบรวมจํานวนฟเจอรไดตามสรุปในตารางที ่15 
โดยแตละฟเจอรที่สรางขึ้นมาเหลานี้สามารถดัดแปลงและแกไขได  เพื่อใหสามารถนํามาประกอบ
เปนรุนใหมๆ ไดงายและสดวกขึ้น   ในงานวิจัยนี้ไดมีการทดสอบนาํฟเจอรตางๆ มาประกอบเปน
ถวยแวนตารุนใหมเปนตัวอยางจาํนวน 4 แบบ   นอกจากนี้ลําดับข้ันตอนและวิธกีารสรางแตละ
ฟเจอร  สามารถนํามาใชศึกษาการออกแบบที่ซับซอนได   สําหรับชิน้สวนอืน่ๆ ไมสามารถจัดแยก
เปนกลุมฟเจอรไดและเปนชิ้นสวนทีม่ีรูปทรงที่ไมซับซอนมาก    ดังนัน้การออกแบบชิ้นสวนแวนตา
อ่ืนๆ  จะงายและสดวกกวาโดยการขึ้นรูปโดยตรง 
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ตารางที่ 15   สรุปฟเจอรตางๆ ของถวยตาจํานวน 31 รุน 
 

ชิ้นสวน จํานวนฟเจอร ชิ้นสวน จํานวนฟเจอร 
สวนฐาน 9 ชินห ู 3 
กรอบลําตัว 11 ชิ้นจมกู 5 
เลนส 6 อ่ืนๆ 3 

 
 2.   การทดสอบทางกลของการดึงชิ้นจมูก   ไดทดสอบตามมาตรฐาน BS5883:1996  
โดยมีความคลาดเคลื่อนของชุดทดสอบการดึงและการอัดของแรง 0.5%  และระยะทาง 0.01 mm  
จํานวนชิน้จมกูที่ใชในการทดสอบมี 2 รุน  คือ รุน J-1 และ J-10 จํานวนรุนละ 5 ชิน้   การทดสอบ
เร่ิมที่แรงดึง 5 N จนชิน้ทดสอบขาด    ผลการทดสอบของชิ้นจมูกทั้งสอง แสดงความสัมพันธของ
ระยะยืดและแรงดึงเปนความสัมพนัธแบบเชิงเสนในชวงบันทกึผลตั้งแต 5 N ถึง 60 N    โดยมี
ความเบีย่งเบนของระยะยืดต่ําที่แรงดึงต่าํและเพิ่มข้ึนเมือ่แรงดึงเพิ่ม    การฉีกขาดเกดิขึ้นที่จุดจับ
ยึดชิ้นจมกู 
 

3.   การทดสอบทางกลของการอัดถวยตา   ไดทดสอบถวยตารูปทรงตางๆ จํานวน 3 รุน 
จํานวนรุนละ 5 ชิ้น แลวบันทึกคาระยะยบุตัวและแรงอัด ที่แรงอัดตั้งแต  0 N ถึง 1000 N    
ผลทดสอบนี้ไดแสดงความสัมพันธระหวางระยะยุบตัวกับแรงอัดเปนแบบเชิงเสน   ถวยตารุน JR-
1006  มีคาเบี่ยงเบนของระยะยุบตัวอยูในชวง 0.016 ถึง 0.035 mm  รุน 2006 มีคาเบี่ยงเบนอยู
ในชวง 0.018 ถึง 0.053 mm และ รุน 981 มีคาเบี่ยงเบนอยูในชวง 0.025 ถึง 0.053 mm   โดยใน
แตละรุนจะมคีาเบี่ยงเบนเพิ่มข้ึนเมื่อแรงอัดเพิ่มข้ึน     ที่แรงกดทดสอบสูงสุด (1000 N) ไมปรากฏ
ความเสยีหายหรือการเปลี่ยนแปลงรูปทรง (บุบยุบ) อยางถาวร 

 
4.   การทดสอบทางกลของการกระแทกเลนสถวยตา    ไดทดสอบดวยลูกบอลโลหะหนกั 

44 กรัม ปลอยตกที่ความสงู 0.7 เมตร ถงึ 1.6 เมตร   ทีค่วามสงูทดสอบสูงสุดที่ 1.6 เมตร   พบวา
ถวยตาของแวนตาวายน้ํา ทัง้ 3 รุน ไมปรากฏความเสยีหาย   การบุบยบุอยางถาวรและไมพบรอย
ราวบนผวิเลนส  
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5.   การสรางแบบจําลอง FEM ของชิ้นจมกูและถวยตาแวนตาวายน้าํ    แบบจําลอง 
Finite Element Model (FEM) ของชิน้จมกูและถวยตาเพื่อใชวิเคราะหหาระยะยืดหรือระยะยุบตัว
และความเคน    เนื่องดวยรายละเอยีดของรูปแบบของชิน้จมูกและถวยตามีความซบัซอนสูงและ
ความหนาไมคงที่จงึตองใชเอลิเมนตรูปทรงโซลิต 3 มิติ แบบ Tetrahedral  รายละเอียดที่สูงและ
ซับซอนจงึทาํใหการกาํหนดขนาดของเอลเิมนตเล็กลง จงึทาํใหมจํีานวนโหนดและเอลิเมนตจํานวน
มาก วัสดุของเอลิเมนต (PVC และ PC) ใชเปน Isotropic  
 

6.   ผลการวิเคราะห FEA ของการทดสอบการดึงชิน้จมูก   ของชิน้จมูกทัง้สองรุนได
ความสัมพันธของระยะยืดและแรงดึงเปนแบบเสนตรงเชนเดียวกับผลการทดสอบทางกล  แต
ความชนัของเสนนอยกวา   คาความคลาดเคลื่อนเฉลี่ย (eAVG) ของทั้งสองรุน เทากบั 11.00% 
 

7.   ผลการวิเคราะห FEA ของการทดสอบการอัดถวยตาแวนตาวายน้ํา   ของถวยตาทั้ง 3 
รุน พบแบบจาํลอง FEM แบบ ค (ไมมีเลนส และใชแรงกดเปนบริเวณ 1/4 ตามขอบบนของกรอบ
ลําตัว) ใหคาความคลาดเคลื่อนต่ําสุด โดยมี eAVG อยูในชวง –4.208% ถึง 0.285% 
 
 8.   เมื่อพิจารณาจากการทดสอบทางกลพบวาทัง้การทดสอบการดึงและการทดสอบการ
อัด   ความสัมพันธของระยะยืดและระยะบบุกับแรง   เปนความสัมพนัธแบบเชิงเสน   คาทดสอบ
สูงสุดเปน 6 เทา สําหรับการทดสอบการดึง และ 1.7 เทาสาํหรับการอัด  จากคามาตรฐานทดสอบ
ของ BSI   ดังนั้นการกาํหนดคาคุณสมบัติของวัสดุสามารถกาํหนดเปนแบบเชิงเสนได   ซึ่งทําให
งายตอการวิเคราะห  FEA 
 

9.   ผลการวเิคราะห FEA ของการทดสอบการกระแทกเลนสแวนตาวายน้าํ   ไดวิเคราะห 
จากอิมพัลสแลวแปลงเปนแรงสถิตย  ผลจาก FEA ที่ความสูง 1.6 ม. หรือ 1.23 เทาของความสงูที่
ทดสอบตาม BSI แสดงคาความเคนสูงสดุ  คาเทากับ 47.045 N/mm2  สําหรับเลนสถวยตารุน   
JR-1006   คาความเคนเทากับ 47.775 N/mm2  สําหรับ รุน 2006 และ 48.197 N/mm2 สําหรับรุน 
981    ความเคนที่เกิดขึน้กบัเลนสถวยตา ทัง้ 3 รุน    ตํ่ากวาคาเฉลีย่ของความเคนสูงสุดของ      
โพลีคาบอเนต ที่ไดจากการทดสอบตามภาพที่ 52 (53 N/mm2)  ซึ่งเปนวัสดุที่ใชทาํเลนสถวยตา  
และผล FEA ของคาความเครียด (0.0192) ตํ่ากวาคาความเครียดที่คาความเคนสงูสุด (0.103)   
ผลที่ไดแสดงใหเหน็วาเลนสไมเกิดการบุบยุบถาวร สอดคลองกับการทดสอบจริง 
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10.   ผลการวเิคราะห FEA ของความสบายในการสวมใส    ไดวิเคราะหโดยใชแรงกดบนขอบของ
กรอบถวยตาจาํนวน 2 รุน รอบดวงตาขนาด 3, 5, 7 และ 9 N   ผลจาก FEA ที่ไดพบวาบริเวณหาง
ตาจะเกิดความเคนและระยะยุบมากที่สุด   ซึง่เปนผลที่สอดคลองจากการประเมนิโดยใชผูทดสอบ
สวมใสจริง  ผลที่ไดนี้ยงัไมสามารถระบเุปนระดับความสบายของการสวมใสไดเนื่องจากยังไมมี
ขอมูลของคาความเคนบนใบหนาทีจ่ะระบุความเจ็บปวด   หลักการเบื้องตนจากงานวิจยันี้สามารถ
ใชเปนขอมูลพืน้ฐานเพื่อใหทางคณะผูวจิัยดําเนนิการตอในอนาคตไดภายหลงัสิน้สุดโครงการวิจยั
นี ้
 
11.   ตัวแปรความคลาดเคลื่อนของการทดสอบ และผล FEA มีปจจัยตางๆ ดังนี ้

- ความคลาดเคลื่อนของเครื่องมือวัด  วธิีทดสอบหาคุณสมบัติทางกล  วัสดุทีน่ํามาใช
ทดสอบซึ่งไมสามารถควบคุมกรรมวิธีการผลิตใหใกลเคียงได 

- ความคลาดเคลื่อนจากการจาํลอง FEM เชนการกาํหนดขอบเขตและโหลด   เปน
ตําแหนงตายตัว  แตในขณะทดสอบจะเกดิการเคลื่อนตวัของชิ้นงานและ Fixture ที่ใช
รองช้ินงาน 

- ความคลาดเคลื่อนของแบบที่ใชจําลอง FEA เชนความหนาของชิน้งาน  ไมสามารถ
วัดไดแมนยํา  เนื่องจากชิน้งานมีขนาดเล็ก และโปรงใส 

 
12.   ผลจากการวิจัยนี้สามารถทําใหบริษัทประหยัดคาใชจายและเวลาลงไดโดย 

- ประหยัดเวลาในกระบวนการสรางแบบแวนตาวายน้ํารุนใหม ต้ังแตเร่ิม ออกแบบโดย
ใช CAD จนถงึขั้นตอนการสรางแมพมิพเพือ่การผลิต ลงได 50% 

- ประหยดัเวลาในออกแบบแวนตาวายน้าํรุนใหม ได 80% หากเปนการนําแบบแวนตา
วายน้ํารุนเกามาแกไขใหเปนแบบใหม  โดยระยะเวลาในการออกแบบขึ้นอยูกับความ
ชํานาญและประสบการณของผูออกแบบซึ่งจําเปนตองเปนผูทีม่ีหนาทีใ่นการ
ออกแบบและใชซอฟตแวรเปนหนาที่ประจํา 

- ชวยเพิ่มผลผลิตเนื่องจากการลดขนาดของชิ้นสวนแวนตาวายน้าํ ทําใหใชวัตถุดิบ
ลดลงเปนผลใหใชเวลาในการฉีดตอชิ้นลดลงดวย และลดพลังงานที่ใชในการผลิต 

- ชวยประหยัดคาใชจายและเวลาในการแกไขแมพิมพ หากแวนตาวายน้ํารุนนัน้ไมผาน
การทดสอบคณุสมบัติทางกล จาก BSI  
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ภาคผนวก 1 
คุณลักษณะเฉพาะของชุดทดสอบการดึงและการอัด 
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ภาพผนวกที่ 1   คุณลักษณะเฉพาะของชุดทดสอบการดงึและการอัด 



                                                                                    HOUNSFIELD TEST EQUIPMENT
LTD.

H50K-S MATERIALS TESTING MACHINE

The H50K-S materials testing machine is designed to test a wide range
of materials including: Plastic, Rubber, Metals, Timber, Packaging
materials, Textiles, Leather, Chains, Wires, Medical products and
components etc. in Tension, Compression, Shear, Tear, Flexural and
Peel.
Through advanced technology and quality engineering Hounsfield has
produced this machine which is accurate and easy to use. Powerful as a
stand-alone unit, the machine capability is enhanced by the functionality
of connecting it direct to a standard printer and obtain a comprehensive
test report by pressing a single key.
The Hounsfield H50K-S machine can be used in laboratory and factory
environments. It is designed to work with the full range of contacting
and non-contacting Hounsfield extensometers.
By connecting the H50K-S to a PC and operating under Hounsfield
QMAT Software, the most complex tests are made simple to create or
run. The Software does also include statistical data analysis and
storage.
Hounsfield guarantees the resolution and accuracy of the machine by
providing a traceable calibration certificate free of charge.

• Double column load frame with 50kN capacity
• Speed range 0.001 to 500 mm/min
• Set speed resolution 0.001 mm/min
• Speed accuracy 0.005%
• Extension resolution 0.001 mm
• Extension accuracy 0.01 mm
• Force measurement conform to EN10002-2,

ASTM E4, DIN 51221
• Accuracy 0.5% of applied force
• Available, load cells:

5,10,25,50,100,250,500N
• 1kN,2.5kN,5kN,10kN,25kN,50kN
• Automatic identification of load cell
• Large backlit graphical display
• Storage and retrieval of 5 Test profiles
• Alpha numeric keypad
• Multi unit
• Multi language
• High resolution graphical output direct to

standard printer
• Programmable Limits, Force, Extension,

Auxiliary and Jog
• Automatic auxiliary equipment recognition
• PC Control Mode for use with HOUNSFIELD

QMAT-Software (Win 95,98,NT)
• Height 1620mm, Width 720mm,

Depth 500mm, Weight 180kg
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ภาคผนวก 2 
การสรางโซลิตโมเดลของชิ้นสวนของแวนตาวายน้ํา 
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การจําลองแบบโดยใช CAD 
  

ชิ้นสวนตางๆ ของแวนตาวายน้ํา ประกอบดวยชิ้นสวนตางๆ ดังนี ้Lens และ Eye Cup, 
Lipseal,  Joint, Buckle และสายรัด ซึง่แตละชิ้นสวนนั้นมวีิธกีารสรางใหเปนโซลติโมเดล ที่ตางกัน
ออกไป โดยสามารถสรุปวิธกีารสรางสวนตางๆ ของชิ้นสวนของแวนตาวายน้าํไดดังนี ้
 
1.   การสราง Joint 
 

โซลิตโมเดล รูปทรงเฉพาะแบบ (Feature) คําสั่ง 

1.  

Create : Solid 
↓ 

Protrusion 
↓ 

Extrude 

2.  

Create : Solid  
↓ 

Protrusion 
↓ 

Extrude 
 

3.  

Create : Solid  
↓ 

Cut 
↓ 

Extrude 
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2.   การสราง โซลิตโมเดล ของ Lens และ Eye cup 
 

โซลิตโมเดล รูปทรงเฉพาะแบบ (Feature) คําสั่ง 

1.  

Create : Surface 
↓ 

Flat 
↓ 

Extrude 

2.  

Create  
↓ 

Datum 
↓ 

Curve 

3.  

Create : Surface 
↓ 

Advance 
↓ 

Boundaries 

4.  

Create : Solid 
↓ 

Protrusion 
↓ 

Extrude 

5.  

Create : Solid 
↓ 

Protrusion 
↓ 

Use Quilt 

 
 

6.  

Create : Solid 
↓ 

Cut 
↓ 

Extrude 
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โซลิตโมเดล รูปทรงเฉพาะแบบ (Feature) คําสั่ง 

7.  

Create : Solid 
↓ 

Cut 
↓ 

Extrude 

8.  

Create : Solid 
↓ 

Shell 

9.  

Create : Solid 
↓ 

Protrusion 
↓ 

Extrude 

10.  

Create : Solid 
↓ 

Cut 
↓ 

Extrude 

11.  

Create : Solid 
↓ 

Protrusion 
↓ 

Extrude 

 
 

12.  

Create : Solid 
↓ 

Cut 
↓ 

Extrude 
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โซลิตโมเดล รูปทรงเฉพาะแบบ (Feature) คําสั่ง 

13.  

Create : Solid 
↓ 

Protrusion 
↓ 

Extrude 

 

14.  

Create : Solid 
↓ 

Protrusion 
↓ 

Extrude 
 
 
3.   การสราง Lip seal 

 
โซลิตโมเดล รูปทรงเฉพาะแบบ (Feature) คําสั่ง 

 1.  

Create : Solid 
↓ 

Protrusion 
↓ 

Revolve : Thin 
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ภาคผนวก 3 
ภาพวาดรายละเอยีดของชิ้นสวนของแวนตาวายน้ํา 
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ภาพผนวกที่ 2   ภาพวาดรายละเอียดของขนาดของชิน้จมูกรุน J-1 
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ภาพผนวกที่ 3   ภาพวาดรายละเอียดของขนาดของชิน้จมูกรุน J-10 
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ภาพผนวกที่ 4   ภาพวาดรายละเอียดของขนาดของถวยตารุน JR-1006 
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ภาพผนวกที่ 5   ภาพวาดรายละเอียดของขนาดของถวยตารุน 2006 
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ภาพผนวกที่ 6   ภาพวาดรายละเอียดของขนาดของถวยตารุน 981 
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ภาคผนวกที่ 4 
 

ข้ันตอนการวิเคราะห CAE ของการดึงชิ้นจมูก 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



122 

1.   ขั้นตอน Pre-Processing   

1.1 เปดโปรแกรม MSC/NASTRAN for Windows โดย กดสองครั้ง ที่ไอคอน  
1.2 กดที่ New Model 

 

 
 

1.3 กดที่ File → Import → Geometry 
1.4 เลือกไฟล ของแบบที่จะทําการวิเคราะห (เชน joint_j10.iges) จากโฟลเดอร ที่เก็บ

ไฟลนี้ แลวกดที่ปุม Open 
 

 
 

1.5 กดที่ปุม OK 
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1.6 กดที่ Geometry → Solid → Stitch 
  กด Select All → OK → OK 

 

 
 

1.7 กดที่ Mesh → Geometry → Solids 
  กด Select All → OK  
 

 
 

  พิมพ 1 ในชอง Element Size และ Max Size of Small Feature แลวกด OK 
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1.8 ในชอง Title,  Youngs Modulus, E,  Poisson’s Ratio, nu และ Mass Density 
พิมพ PVC, 14, 0.35 และ 1.3E-9 ตามลาํดับ แลวกด OK 

 

 
 

  กด OK 
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1.9 กดที่ Model → Constraint → Nodal 
พิมพ Fixed ในชอง Title แลวกด OK 

 

 
 

 กด Method^  → on Surface 
 

 
 

 เลือก ผิวที่จะทําการกําหนดเงื่อนไขขอบเขต (เชน 82) แลวกด OK 
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 กด Fixed → OK → Cancel 
 

 
 

1.10 กด Model → Constraint → Set 
พิมพ 2 ในชอง ID และ X TRANSLATION ในชอง Title แลวกด OK 

 

 
 

กดที่ Model → Constraint → Nodal 
กด Method^  → on Surface → เลือกเลือกผิวที่ตองการ (เชน 82) → OK 
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  กด Fixed →TX → OK → Cancel 
 

 
 

1.11 กดที่ Model → Constraint → Combine 
 

 
 

  กด More, เลือก 1..FIXED ในชอง From Set แลวกด Last One 
 

 
 

1.12 กดที่ Model → Load → On Surface 
1.12.1 พิมพ 5N ในชอง Title แลวกด OK 
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1.12.2 เลือก Surface 54 แลวกด OK 
 

 
 

1.12.3 พิมพ 5N ในชอง FX → OK → Cancel 
 

 
 

1.13 กดที่ Model → Load → Set 
1.13.1 พิมพ 2 ในชอง ID และ 10N ในชอง Title แลวกด OK 
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1.13.2 ทําตามขั้นตอนที ่1.12.2 ถึง 1.12.3  โดยเปลี่ยนคาในชอง FX เปน 10 
1.14 ทําตามขั้นตอนที ่13 โดยเพิม่คาโหลดในชอง FX ข้ึน คร้ังละ 5 จนถึง 30 

 

 
 
2.   ขั้นตอน Processing   

1.1 กดที่ File → Analyze  
กด ในชอง Load เพื่อเลือก Load Set 5N  

 

 
 

กด OK 
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กด Yes แลวตั้งชื่อ File และเลือก Folder สําหรับเก็บไฟลขอมูล → Save 
 

 
 

1.1 โปรแกรมจะทาํการคํานวณคาตางๆ ใชเวลาประมาณ 2 นาท ี
  กด Continue 

 

 
 

1.1 ทําตามขั้นตอนที ่1 และ 2 โดยเปลี่ยน Load Set ไปเร่ือยๆจนครบทุก Set 
 

3.   ขั้นตอน Post Processing   
3.1 กด View → Select  → Deformed and Contour Data 
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3.2 เลือก 1..MSC/NASTRAN Case 1 ในชอง Output Set (ผลลัพธ ของ Load set 1) 
3.3 เลือก 2..T1 Translation ในชอง Deformation (ดูผลการเคลื่อนตัวในแนวแกน X) 
3.4 เลือก 2..T1 Translation ในชอง Contour (ดูผลการกระจายการเคลื่อนตัวใน

แนวแกน X) 

  
 

3.5 กด OK → OK 
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ภาคผนวก 5 
 

ข้ันตอนการวิเคราะห CAE การกดของเลนส  
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1.   ขั้นตอน Pre-Processing   

1.1 เปดโปรแกรม MSC/NASTRAN for Windows โดย กดสองครั้ง ที่ไอคอน  
1.2 กดที่ New Model 

 

 
 

1.3 กดที่ File → Import → Geometry 
1.4 เลือกไฟล ของแบบที่จะทําการวิเคราะห (เชน lens2006_4.iges) จากโฟลเดอร ที่

เก็บไฟลนี ้แลวกด Open 
 

 
 

กด OK 
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1.5 กดที่ Geometry → Solid → Stitch 
  กด Select All → OK → OK 

 

 
 

1.6 กดที่ Mesh → Mesh Control → Size Along Curve 
  เลือก Curve 1 → OK 

 

 

 
 

  พิมพ 3 ในชอง Number of Element, กด Equal, กด Length → OK 
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  เลือก Curve 4 และ 6 → OK 
 

 
 

  พิมพ 30 ในชอง Number of Element, กด Equal, กด Length → OK 
 

 
 

  กด Cancel 
 

1.7 กดที่ Mesh → Geometry → Solids 
  กด Select All → OK  
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  พิมพ 2.2 ในชอง Element Size และ Max Size of Small Feature แลวกด OK 
 

 
 

1.8 ในชอง Title,  Youngs Modulus, E,  Poisson’s Ratio, nu และ Mass Density 
พิมพ PC, 2300, 0.37 และ 1.2E-9 ตามลําดับ แลวกด OK 

 

 
 

  กด OK 
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1.9 กดปุม Ctrl + Q ที่คียบอรด 

กดที่ Node → Done 
 

 
 

 
1.10   กดที่ Model → Constraint → Nodal 

พิมพ Fixed ในชอง Title แลวกด OK 
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 กด Method^  → on Surface 
 เลือก Surface 68, 69, 70, 71, 72 และ 73 แลวกด OK 

 

 
 

 กด Fixed → OK → Cancel 
 

 
 

1.11   กดที่ Model → Load → On Surface 
1.11.1 พิมพ 200N ในชอง Title แลวกด OK 
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1.11.2 เลือก Surface 93 แลวกด OK 
 

 
 

1.11.3 พิมพ 200 ในชอง FZ → OK → Cancel 
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1.12   กดที่ Model → Load → Set 
1.12.1 พิมพ 2 ในชอง ID และ 300N ในชอง Title แลวกด OK 

 

 
 

1.12.2 ทําตามขั้นตอนที ่1.11.2 ถึง 1.11.3 โดยเปลี่ยนคาในชอง FZ เปน 300 
1.13   ทําตามขั้นตอนที ่12 โดยเพิ่มคาโหลดในชอง FZ ข้ึน คร้ังละ 100 จนถึง 1000 

 

 
 
 

2.   ขั้นตอน Processing   
1.1 กดที่ File → Analyze  

กด ในชอง Load เพื่อเลือก Load Set 200N → กด OK 
 

 
 

กด Yes แลวตั้งชื่อ File และเลือก Folder สําหรับเก็บไฟลขอมูล → Save 
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1.1 โปรแกรมจะทาํการคํานวณคาตางๆ ใชเวลาประมาณ 5 นาท ี
  กด Continue 

 

 
 

1.1 ทําตามขั้นตอนที ่1 และ 2 โดยเปลี่ยน Load Set ไปเร่ือยๆจนครบทุก Set 
 

3.   ขั้นตอน Post Processing   
1.1 กด View → Select 

กด Deformed and Contour Data 
 

 
 

3.1.1 เลือก 1..MSC/NASTRAN Case 1 ในชอง Output Set (ผลลัพธ ของ 
Load set 1) 

3.1.2 เลือก 4..T3 Translation ในชอง Deformation (ดูผลการเคลื่อนตัวใน
แนวแกน Z) 
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3.1.3 เลือก 4..T3 Translation ในชอง Contour (ดูผลการกระจายการเคลื่อน
ตัวในแนวแกน Z) 

 
 

  กด OK → OK 
3.2 กรณีตองการดูการกระจายของความเคน  

กด View → Select 
กด Deformed and Contour Data 

 

 
 

3.2.1 เลือก 1..MSC/NASTRAN Case 1 ในชอง Output Set (ผลลัพธ ของ 
Load set 1) 

3.2.2 เลือก 60031..Solid Von mises Stress ในชอง Deformation 
3.2.3 เลือก 60031.. Solid Von mises Stress ในชอง Contour  
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กด OK → OK 
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ภาคผนวก 6 
 

ข้ันตอนการวิเคราะห CAE ของการกระแทกของเลนส 
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1.   ขั้นตอน Pre-Processing   

1.1 เปดโปรแกรม MSC/NASTRAN for Windows โดย กดสองครั้ง ที่ไอคอน  
1.2 กดที่ New Model 

 

 
 

1.3 กดที่ File → Import → Geometry 
1.4 เลือกไฟล ของแบบที่จะทําการวิเคราะห (เชน lens2006_4.iges) จากโฟลเดอร ที่

เก็บไฟลนี ้แลวกด Open 
 

 
 

กด OK 
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1.5 กดที่ Geometry → Solid → Stitch 
  กด Select All → OK → OK 

 

 
 

1.6 กดที่ Mesh → Mesh Control → Size Along Curve 
  เลือก Curve 1 → OK 
 

 

 
 

  พิมพ 3 ในชอง Number of Element, กด Equal, กด Length → OK 
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  เลือก Curve 4 และ 6 → OK 
 

 
 

  พิมพ 30 ในชอง Number of Element, กด Equal, กด Length → OK 
 

 
 

  กด Cancel 
 

1.7 กดที่ Mesh → Geometry → Solids 
  กด Select All → OK  
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  พิมพ 2.2 ในชอง Element Size และ Max Size of Small Feature แลวกด OK 
 

 
 

1.8 ในชอง Title,  Youngs Modulus, E,  Poisson’s Ratio, nu และ Mass Density 
พิมพ PC, 2300, 0.37 และ 1.2E-9 ตามลําดับ แลวกด OK 

 

 
 

  กด OK 
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1.9 กดปุม Ctrl + Q ที่คียบอรด 
กดที่ Node → Done 

 

 
 

 
1.10   กดที่ Model → Constraint → Nodal 

พิมพ Fixed ในชอง Title แลวกด OK 
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 กด Method^  → on Surface 
 เลือก Surface 68, 69, 70, 71, 72 และ 73 แลวกด OK 
 

 
 

 กด Fixed → OK → Cancel 
 

 
 

1.11   กดที่ Model → Load → Nodal 
1.11.1 พิมพ 200N ในชอง Title แลวกด OK 
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1.11.2 เลือก Node 1834 แลวกด OK 
 

 
 

1.11.3 พิมพ 200 ในชอง FZ → OK → Cancel 
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2.   ขั้นตอน Processing   
2.1 กดที่ File → Analyze  

กด OK 
 

 
 

กด Yes แลวตั้งชื่อ File และเลือก Folder สําหรับเก็บไฟลขอมูล → Save 
 

 
 

2.2 โปรแกรมจะทาํการคํานวณคาตางๆ ใชเวลาประมาณ 5 นาท ี
  กด Continue 

 
 

2.3 ทําตามขั้นตอนที ่1 และ 2 โดยเปลี่ยน Load Set ไปเร่ือยๆจนครบทุก Set 
 
3.   ขั้นตอน Post Processing   

2.1 กด View → Select 
กด Deformed and Contour Data 
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3.1.1 เลือก 1..MSC/NASTRAN Case 1 ในชอง Output Set (ผลลัพธ ของ 
Load set 1) 

3.1.2 เลือก 4..T3 Translation ในชอง Deformation (ดูผลการเคลื่อนตัวใน
แนวแกน Z) 

3.1.3 เลือก 4..T3 Translation ในชอง Contour (ดูผลการกระจายการเคลื่อน
ตัวในแนวแกน Z) 

 

 
 

  กด OK → OK 
3.2 กรณีตองการดูการกระจายของความเคน  

กด View → Select 
กด Deformed and Contour Data 
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3.2.1 เลือก 1..MSC/NASTRAN Case 1 ในชอง Output Set (ผลลัพธ ของ 
Load set 1) 

3.2.2 เลือก 60031..Solid Von mises Stress ในชอง Deformation 
3.2.3 เลือก 60031.. Solid Von mises Stress ในชอง Contour  

 

 
   

กด OK → OK 
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